
Xerox CX Print Server, Powered by Creo for the
Xerox DocuColor 7000AP/8000AP Digital Presses

731-01191A-EN User Guide
English





Copyright
© Creo, 2007. All rights reserved.

This document is also distributed in Adobe Systems Incorporated's PDF (Portable Document Format). You may 
reproduce the document from the PDF file for internal use. Copies produced from the PDF file must be reproduced in 
whole.

Trademarks
Creo is a trademark of Creo.

Adobe, Acrobat, Adobe Illustrator, Distiller, Photoshop, PostScript, and PageMaker are registered trademarks of Adobe 
Systems Incorporated. 

Apple, AppleShare, AppleTalk, iMac, ImageWriter, LaserWriter, Mac OS, Power Macintosh, and TrueType are registered 
trademarks of Apple Computer, Inc. Macintosh is a trademark of Apple Computer, Inc., registered in the U.S.A. and other 
countries.

Kodak, Brisque, and InSite are trademarks of Kodak.

PANTONE, Hexachrome, PANTONE Hexachrome, and PANTONE MATCHING SYSTEM are the property of Pantone, Inc.

PEARL, PEARLsetter, PEARLhdp, PEARLdry, and PEARLgold are registered trademarks of Presstek, Inc.

XEROX is a trademark of XEROX CORPORATION.

FCC Compliance
Any Creo equipment referred to in this document complies with the requirements in part 15 of the FCC Rules for a Class 
A digital device. Operation of the Creo equipment in a residential area may cause unacceptable interference to radio and 
TV reception, requiring the operator to take whatever steps are necessary to correct the interference.

Product Recycling and Disposal
If you are managing the disposal of your Xerox product, please note that the product contains perchlorate, lead, mercury, 
and other materials whose disposal may be regulated due to environmental considerations in certain countries or states.  
The presence of perchlorate, lead and mercury is fully consistent with global regulations applicable at the time that the 
product was placed on the market.

Application of this symbol on your equipment is confirmation that you must dispose of this equipment with agreed 
national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be 
managed within agreed procedures.

Xerox operates a worldwide equipment take back and reuse/recycle program. Contact your Xerox sales representataive 
(1-800-ASK-XEROX) to determine whether this Xerox product is part of the program. For more information about Xerox 
invironmental programs visit http://www.xerox.com/environment.

For perchlorate disposal information, contact your local authorities. In the United States, you may also refer to the 
California Department of Toxic Substances Control (DTSC) or see 
http://www.dtsc.ca.gov/hazardouswaste/perchlorate.

This electronic information product complies with Standard SJ/T 11363 - 2006 of the Electronics Industry of the People's 
Republic of China.

Limitation of Liability
The product, software or services are being provided on an "as is" and "as available" basis. Except as may be stated 
specifically in your contract, Creo and its parents, subsidiaries, and affiliates expressly disclaim all warranties of any kind, 
whether express or implied, including, but not limited to, any implied warranties of merchantability, fitness for a 
particular purpose and non-infringement.

You understand and agree that, except as may be stated specifically in your contract, Creo and its parents, subsidiaries, 
and affiliates shall not be liable for any direct, indirect, incidental, special, consequential or exemplary damages, including 
but not limited to, damages for loss of profits, goodwill, use, data or other intangible losses (even if Creo has been 
advised of the possibility of such damages), resulting from: (i) the use or the inability to use the product or software; (ii) 
the cost of procurement of substitute goods and services resulting from any products, goods, data, software, information 

http://www.xerox.com/environment
http://www.xerox.com/environment


 

or services purchased; (iii) unauthorized access to or alteration of your products, software or data; (iv) statements or 
conduct of any third party; (v) any other matter relating to the product, software, or services. 

The text and drawings herein are for illustration and reference only. The specifications on which they are based are 
subject to change. Creo may, at any time and without notice, make changes to this document. Creo, for itself and on 
behalf of its parents, subsidiaries, and affiliates, assumes no liability for technical or editorial errors or omissions made 
herein, and shall not be liable for incidental, consequential, indirect, or special damages, including, without limitation, 
loss of use, loss or alteration of data, delays, or lost profits or savings arising from the use of this document.

www.pod-wf..com

Internal 731-01191A-EN Rev A

Revised August 2007

http://www.printondemandsolutions.com


1 Welcome 1
Welcome to the CX Print Server User Guide...........................................................................................................................................2
Overview of CX Print Server.........................................................................................................................................................................2
Hardware and Software Components .......................................................................................................................................................3
Supported Formats .........................................................................................................................................................................................4
Workflow...........................................................................................................................................................................................................4

2 Getting Started 5
Turning On the CX Print Server ...................................................................................................................................................................6
The Workspace................................................................................................................................................................................................7

Customizing the Workspace View.....................................................................................................................................................8
The Server and Printer Monitors ........................................................................................................................................................8

The Job Queues ...............................................................................................................................................................................................9
The Queues Window............................................................................................................................................................................ 11
Status Information................................................................................................................................................................................ 13

The Storage Window.................................................................................................................................................................................... 14
The Settings Window................................................................................................................................................................................... 16
The Resource Center .................................................................................................................................................................................... 17
The Job Parameters Window..................................................................................................................................................................... 17
The Help Menu .............................................................................................................................................................................................. 19
Turning Off the CX Print Server................................................................................................................................................................ 20

3 Basic Workflows 21
Importing and Printing Jobs....................................................................................................................................................................... 22

Importing Jobs ...................................................................................................................................................................................... 22
Processing.............................................................................................................................................................................................. 23
Printing Jobs .......................................................................................................................................................................................... 24

Reprinting Jobs.............................................................................................................................................................................................. 24
Managing Job Queues................................................................................................................................................................................. 24

Batching Jobs ........................................................................................................................................................................................ 24
Changing the Order of Jobs in the Queues ................................................................................................................................... 25
Suspending and Resuming Queues................................................................................................................................................. 26
Aborting a Running Job ...................................................................................................................................................................... 26
Moving a Job to the Storage Window............................................................................................................................................ 27
Viewing and Editing Job Parameters .............................................................................................................................................. 28
Running a Rush Job.............................................................................................................................................................................. 28
Deleting a Job ....................................................................................................................................................................................... 29

Managing the Storage Window................................................................................................................................................................ 30
Submitting Jobs.................................................................................................................................................................................... 30
Duplicating Jobs................................................................................................................................................................................... 30
Discarding RTP Information.............................................................................................................................................................. 30
Archiving and Retrieving Jobs .......................................................................................................................................................... 30
Viewing a Job’s History...................................................................................................................................................................... 32
Job Ticket Report ................................................................................................................................................................................. 32

Editing Jobs .....................................................................................................................................................................................................33
Editing an Unprocessed Job .............................................................................................................................................................. 34

Editing Processed Jobs................................................................................................................................................................................ 34
Navigation Buttons.............................................................................................................................................................................. 34
Previewing the Job............................................................................................................................................................................... 35
Viewing Pages in the Job Editor ....................................................................................................................................................... 35

Contents



iv CX Print Server User Guide

Editing an RTP Job................................................................................................................................................................................38
Managing Virtual Printers ...........................................................................................................................................................................41
Managing Paper Sets .................................................................................................................................................................................. 44

4 Working at a Client Workstation 47
Overview .........................................................................................................................................................................................................48
Working From Windows Client Workstations .....................................................................................................................................48

Defining a Printer - Windows XP .....................................................................................................................................................48
Copying the Printer Driver from Windows....................................................................................................................................49
Printing From Windows......................................................................................................................................................................49

Working From Macintosh Client Workstations ...................................................................................................................................50
Copying the CX Print Server PPD File for Mac OS X (10.4).......................................................................................................51
Printing from a Macintosh .................................................................................................................................................................55

Spire Web Center ......................................................................................................................................................................................... 57
The Web Viewer ..................................................................................................................................................................................58

Using Hot Folders .........................................................................................................................................................................................59
Hot Folder File Formats ..................................................................................................................................................................... 60
Hot Folders and Brisque or Prinergy jobs (GAP Formats)........................................................................................................ 60
Using Hot Folders from Client Workstations .............................................................................................................................. 60

CX Print Server Print Driver Software .....................................................................................................................................................62
Using the Print Driver Software........................................................................................................................................................63
Working Offline ....................................................................................................................................................................................69
Uninstalling the Print Driver Software ............................................................................................................................................69

5 Production Printing 71
Imposition Workflow ...................................................................................................................................................................................72

Creating, Viewing and Modifiying Imposition Templates ......................................................................................................... 72
Managing Templates ..........................................................................................................................................................................78

High-Resolution Workflow........................................................................................................................................................................ 80
Creo APR .................................................................................................................................................................................................81
OPI.............................................................................................................................................................................................................81
Creo APR and OPI File Formats........................................................................................................................................................82
Preparing to Print Using Creo APR or OPI .....................................................................................................................................82
Printing with Creo APR or OPI ..........................................................................................................................................................83

PDF Workflow................................................................................................................................................................................................84
Export as PDF2Go ................................................................................................................................................................................86

Page Exceptions ............................................................................................................................................................................................88
Setting Exceptions for Imposed Jobs ..............................................................................................................................................88
Printing on Tabs Using Exceptions ..................................................................................................................................................88
Printing on Tabs Using the CX Print Server Tabs Plug-In for Acrobat ...................................................................................95

Dynamic Page Exceptions ..........................................................................................................................................................................99
Setting the CX Print Server for Dynamic Page Exceptions......................................................................................................100
Tips and Limitations ..........................................................................................................................................................................100

Fonts................................................................................................................................................................................................................101
Managing Fonts ...................................................................................................................................................................................101
Downloading Fonts Onto Your CX Print Server ..........................................................................................................................101

Graphic Arts Workflow ............................................................................................................................................................................. 102
Importing GAP Files........................................................................................................................................................................... 102
Supporting GAP Files ........................................................................................................................................................................ 102
GAP File Structure.............................................................................................................................................................................. 103
Preflight................................................................................................................................................................................................. 103

6 Color Workflow 109
Calibration .....................................................................................................................................................................................................110

Guidelines for Successful Calibration ............................................................................................................................................110



Contents v

The Calibration Process ..................................................................................................................................................................... 111
Preparing the Calibration Device for Calibrating Your Printer................................................................................................. 111
Calibrating the CX Print Server ........................................................................................................................................................112
Reading Color Density Data..............................................................................................................................................................121
Printing the Job with the Calibration Table..................................................................................................................................122

Default Color Flow ......................................................................................................................................................................................123
Color Tools....................................................................................................................................................................................................124

Profile Manager...................................................................................................................................................................................124
Spot Color Editor.................................................................................................................................................................................127
Gradation Tool.....................................................................................................................................................................................132

7 VI Workflow 139
VI Overview ................................................................................................................................................................................................. 140
VI Document Formats................................................................................................................................................................................ 141

Creo Variable Print Specification.................................................................................................................................................... 141
VIPP........................................................................................................................................................................................................142
VIPP 2001 and PPML.........................................................................................................................................................................143
PostScript Files ................................................................................................................................................................................... 144

Using Creo Variable Print Specification to Print a VI Job ................................................................................................................ 144
Useful VI Print Options .....................................................................................................................................................................145

Managing VI Elements.............................................................................................................................................................................. 146
Deleting VI Elements ........................................................................................................................................................................ 146
Archiving VI Elements .......................................................................................................................................................................147
Retrieving VI Elements ..................................................................................................................................................................... 148

8 System Administration 149
Setting Up and Configuring the CX Print Server ................................................................................................................................ 150

Server Setup ........................................................................................................................................................................................ 150
Network Setup..................................................................................................................................................................................... 153
Remote Tools Setup ...........................................................................................................................................................................155
Security..................................................................................................................................................................................................158
System Disks....................................................................................................................................................................................... 160
Backing up the Configuration ......................................................................................................................................................... 160
Localization...........................................................................................................................................................................................163
Pre-RIP Preview...................................................................................................................................................................................165
General Defaults .................................................................................................................................................................................166
Print Queue Manager ........................................................................................................................................................................167
Color.......................................................................................................................................................................................................168
Messages ............................................................................................................................................................................................. 170
JDF Outputs ..........................................................................................................................................................................................171
View Configuration ............................................................................................................................................................................172
Storage Management ........................................................................................................................................................................173

System Messages........................................................................................................................................................................................174
The Job Alert Window.......................................................................................................................................................................174
Job History............................................................................................................................................................................................174
The Message Viewer .........................................................................................................................................................................175

Job Accounting.............................................................................................................................................................................................177
Viewing the Accounting Information ............................................................................................................................................177
Setting the Accounting/Message Viewer....................................................................................................................................179
Printing and Exporting the Accounting Log ................................................................................................................................ 180

9 Setting Parameters 183
Setting Parameters in the Job Parameters Window ......................................................................................................................... 184

The Print Settings Tab ...................................................................................................................................................................... 184
The Paper Stock Tab ......................................................................................................................................................................... 188



vi CX Print Server User Guide

The Print Quality Tab ........................................................................................................................................................................190
The Color Tab...................................................................................................................................................................................... 192
The Imposition Tab............................................................................................................................................................................ 197
The Services Tab ............................................................................................................................................................................... 203
The Finishing Tab .............................................................................................................................................................................. 208
The Exceptions Tab ............................................................................................................................................................................ 211

Setting PPD File Parameters .................................................................................................................................................................... 213
Viewing the PPD File ......................................................................................................................................................................... 213

Glossary 217

Index 225



Welcome

Welcome to the CX Print Server User Guide ....................................................2

Overview of CX Print Server ..................................................................................2

Hardware and Software Components.................................................................3

Supported Formats ................................................................................................. 4

Workflow ................................................................................................................... 4



2 Chapter 1 —Welcome

 

Welcome to the CX Print Server User Guide
Welcome to your Xerox CX Print Server, Powered by Creo for Xerox DocuColor 
7000/8000AP Digital Presses User Guide. This user guide is applicable to both the 
Xerox DocuColor 8000AP digital press and the Xerox DocuColor 7000AP digital 
press. Please note that although all printer references throughout this guide specify 
the DocuColor 8000AP, the information therein applies to both digital presses. We 
look forward to supporting you all the way from prepress to print.

The CX Print Server is a powerful, comprehensive color server that provides high 
throughput and print predictability to digital workflows. In combination with the 
DocuColor 8000AP, the CX Print Server effectively addresses the growth of on-
demand printing needs and delivers the best output quality available. 

This user guide will help you operate the CX Print Server. It can also be used as a 
reference guide for questions or procedures. Study this user guide to take full 
advantage of the many unique and advanced features of the CX Print Server.

This user guide is for CX Print Server operators and system administrators. This 
guide explains how you can quickly and easily print from the CX Print Server or from 
a client workstation. Step-by-step procedures are included for new and occasional 
CX Print Server users. Detailed information is provided for users who require in-
depth knowledge of the CX Print Server.

Overview of CX Print Server
The CX Print Server is an on-demand pre-press system that uses advanced pre-
press technologies, to drive a DocuColor 8000AP.

As an optimal digital color solution for printers, the CX Print Server enables you to 
print from Microsoft® Windows®, Macintosh®, and UNIX® client workstations. The 
CX Print Server processes image files in page-description language (PDL) formats—
for example, Adobe PostScript®, PDF, and Variable Information—using RIP (Raster 
Image Processor) technology. The system converts image files into a suitable RTP 
(Ready-To-Print) format for direct, high-quality digital printing. The CX Print Server 
also streamlines the printing process by allowing printing with preset workflows.

In combination with the DocuColor 8000AP, the CX Print Server enables you to 
efficiently print flyers, brochures, pamphlets, dummy catalogs, short-run trials, and 
print-on-demand publications. When installed as a fast, network printer with the CX 
Print Server, the DocuColor 8000AP prints at the full-rated speed of 80 full-color 
A4 (210mm x 297mm) or Letter (8.5 inches x 11inches) pages per minute, on any 
media type and weight.

The CX Print Server combines RIP functionalities, automation, control tools and 
special hardware development capabilities with PC architecture.
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Figure 1: CX Print Server for the DocuColor 8000AP

Hardware and Software Components
The CX Print Server is a dedicated Creo platform running in a Windows XP 
environment. 

The CX Print Server includes:

• Creo hardware, including the interface board

• Software, including:

Creo software

Windows XP Professional Operating System

Adobe® Acrobat® version 7.0

WARNING:  A shielded ethernet cable must be used from the Token Ring board 
to the Token Ring Hub to maintain compliance with Council Directive 89/336/
EEC.
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Supported Formats
The CX Print Server supports the following file formats:

• PostScript (composite or pre-separated files)

• PDF

• EPS

• Creo VPS (Variable Print Specification)

• VIPP (Variable Data Intelligent PostScript Params)

• PPML (Personalized Print Markup Language)

• GAP (Graphic Art Port) files (file formats from various prepress systems, for 
example Brisque job and TIFF / IT)

• Creo CT & LW

• JPG, TIFF

• Pre-separated formats

Workflow
The CX Print Server receives and processes files from the following client 
workstations: 

• Macintosh – running Mac OS X (10.1 and later)

• Windows – running Windows 2000 and XP

• UNIX Workstations and Servers

The CX Print Server basic workflow is as follows:
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Turning On the CX Print Server
1. Turn on the monitor.

2. Press the power button located behind the front panel of the CX Print Server.

The power indicator on the front panel lights up. The Windows operating 
system starts, and the CX Print Server splash screen appears.

 

Notes:

• If the CX Print Server workspace is already turned on, open the 
workspace from the Start menu.

• By default, the Auto Log On check box is selected under Tools > 
Settings > Administration > Security. This option enables you to 
open the workspace without having to go through the logon process 
each time. If you want to designate different access levels for each 
user, you need to set security settings in the Settings window. For 
more information about designating access levels, see Security on 
page 158. 
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The Workspace
After you turn on the CX Print Server, the workspace automatically appears.

1

2

3

4

5

6

7

8

Table 1: CX Print Server workspace

Item Name Description

1 Menu Bar Consists of the Job, Selection, Tools, Control, View, and Help menus. 
Click a menu name to open the corresponding menu.

2 Status Panel Contains the logo Pane, Processing status area, Printing status area, 
server icon, and printer icon.

For more information on the server and printer icons, see The Server and 
Printer Monitors on page 8.

3 Toolbar Consists of shortcut buttons for the Import window, Resource Center, 
Message Viewer, and Calibration window.

4 Queues Consists of the Process Queue, which lists the files to be processed. 
After a file has been processed successfully, it moves either to the Print 
Queue (the upper area) or to the Storage window.

For more information on queues, see The Job Queues on page 9.

5 Job Alert Displays the last detailed error that is related to a selected job.

For more information on the Job Alert window, see The Job Alert Window 
on page 174.

6 Thumbnail Displays a thumbnail view of a specific page in an RTP job that has 
finished processing.
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Customizing the Workspace View

The View menu enables you to customize the workspace. From this menu, you can 
open and close the Queues window. The menu also provides the following view 
options:

• Spire Classic View: Displays the status panel, toolbar, Storage window, Queues 
window, Thumbnail window, and Job Alert window

• Spire Classic Plus View: Displays the status panel, toolbar, Paper Stocks 
window, Storage window, Queues window, Thumbnail window, and Job Alert 
window

• Queues View: Displays only the Print Queue and Process Queue

• Refresh View: Reverts to the factory default view for the view that is currently 
displayed

The Server and Printer Monitors
The server and printer icons are on the right end of the status panel and indicate 
(through animation) whether processing and printing are taking place. If a finishing 
device is connected to the printer, the finishing device also appears in the printer 
icon. You can click the printer or server icon to display status information. You also 
view messages regarding the printer operation mode and status next to the printer 
icon. The calibration reminder indicator reminds you to calibrate the printer. You 
can set the reminder in the Settings window.

7 Storage The Storage window contains files that:

• were successfully printed

• were held, were aborted, or failed during processing or printing

• were sent directly from the client workstation to the Storage window 
or were imported to the Storage window.

8 Paper Stocks Displays information about the paper in each tray and also shows 
whether the trays are ready for printing.

NOTE: This window is only included in Classic Plus view. For more 
information, see Customizing the Workspace View on page 8.

Table 1: CX Print Server workspace

Item Name Description

Tip:  By default, the windows in the workspace are all docked-that is, attached 
to the workspace. You can detach, or undock, a window from the workspace by 
right-clicking the window’s title bar and selecting Undock Window.
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For more information about setting the calibration reminder, see Color on page 168.

The DFE Monitor 
Click the server icon to open the DFE Monitor window. 

The DFE Monitor window displays the following information:

The Printer Monitor
Click the printer icon to open the Printer Monitor window.

The Printer Monitor window displays the following information:

The Job Queues
After entering the CX Print Server, a job resides either in the Queues window or in 
the Storage window, depending on the job flow. 

Table 2: Description of DFE Monitor window

This tab Shows you

Disk Usage How much space is available on the user disk and 
printer disk

Network Information about the network

 Virtual Printers Lists the virtual printers that you have defined

Table 3: Description of Printer Monitor window

This tab Shows you

Paper Stock Information about the paper in each tray and also 
shows whether the trays are ready for printing

 Finisher Information about finishing devices that are connected 
to the DocuColor 8000AP

 Toner Whether there is enough toner

 Consumables Status of other refillables

Calibration
reminder
indicator

Server icon Printer icon
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The Queues window consists of two areas, the Process Queue and Print 
Queue.

• The Process Queue lists the job that is currently being processed and 
the jobs that are waiting to be processed. 

• The Print Queue lists the currently printing job and the jobs that were 
processed successfully and are waiting to be printed. The Print Queue 
also lists frozen jobs (jobs for which the specified option is not 
available—for example, paper stock or finisher).

Each queue holds jobs in the order in which they enter it (unless a rush job 
“interrupts” the submission order).

For more information about managing jobs, see Managing Job Queues on 
page 24.

At any time, you can view information regarding the number and status of 
the jobs in the queues. You can also change the order of the jobs and 
suspend or resume the queue.

After you start the CX Print Server, the Queues window is displayed. The 
Queues window consists of the Print Queue and the Process Queue.

Each queue holds jobs in the order in which they enter it. The top job in the 
queue is currently running, while all others are waiting to run. 

If necessary, you can change the order the jobs that are waiting in the 
queues. You can also view and edit the jobs’ parameters.

Note:  If there are very short jobs in the Print Queue, several jobs may be 
running at the same time. The jobs marked as running are listed first and 
printed in the order they are listed.
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The Queues Window
After you submit PDL jobs (or resubmit PDL jobs), the Process Queue lists the files 
to be processed. 

Once a file has been processed successfully, it moves to the Print Queue and waits 
to be printed or to the Storage window (depending on the current job flow or virtual 
printer).

For more information about operations on the jobs residing in the Queue Manager, 
see Aborting a Running Job on page 26.

The Queues window lists informations about the jobs that are being processed. 
Status indicators indicate the status of each job. Table 4 describes the status 
indicators used in both the Process Queue and Print Queue.

Table 4: Process Queue and Print Queue status indicators

For more information about rush jobs, see Running a Rush Job on page 28.

This Status 
Indicator

Indicates This:

The job is running.

The job is frozen and held in the Print Queue. If a job is 
frozen, it indicates that the specified option is not available—
for example, paper stock or finisher

The job is waiting.

The job is a rush job.

The rush job is frozen.

The rush job is waiting.
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Right-click the column heading row to select the columns that you want to 
view.

Table 5: Process Queue and Print Queue column descriptions

This Column Indicates This Information:

Job Type File format of the PDL job—for example, PS 
(.ps), PDF(.pdf), VPS(.vps)

Title Name of the file to be printed. If you submit a 
file whose name already exists in the CX Print 
Server, a number is automatically added to the 
file name—for example, if you submit a file 
called lobster and this file name already exists, 
the newer file is renamed lobster1.

Sender User name of the person who submitted the 
job when the CX Print Server is logged on to a 
domain controller. If the CX Print Server is not 
logged on to a domain controller, “guest” will 
be displayed in the Sender column.

Submitted Date and time this job was first submitted to 
the CX Print Server

Pages Number of pages to be processed in a PDF job. 
If the DTP software supported it, the number of 
pages is indicated for other PDL jobs.

Sets Number of copies to be printed

Paper Set/Stock 
Name

Paper set name or stock name

Paper Size Paper size

Weight Paper weight

Type Paper type

Coating Paper coating

File Size File size of the job
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Status Information

The Processing and Printing status areas contain the following:

• The suspend and resume buttons (for more information see Suspending and 
Resuming Queues on page 26)

• The queue name.

• The number of jobs in the queue—for example, 2.

• If a job is currently being processed or printed, the name of the job and a process 
indicator are displayed.

 

Account Account name taken from the Job Info 
parameter

Job Info Job info type taken from the Job Info parameter

Imposition Type of imposition used

Page Exception Whether or not the job has page exceptions

Server Name of the server being used

Virtual Printer 
Names

Name of virtual printer being used

This Column Indicates This Information:

Note: For PDF jobs, the Processing status area indicates the total number 
of pages. For other PDL jobs, the number of pages is indicated only if the 
desktop publishing software in which they were created supports this 
feature.
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The Storage Window
The Storage window is displayed by default. If you close the Storage window, you 
can reopen it by selecting Storage from the View menu.

The Storage window is the main repository for jobs. It can contain:

• Printed (completed) jobs

• Jobs that you manually moved to the Storage window or aborted during 
processing or printing

• Jobs that failed during processing or printing

• Retrieved jobs

• Jobs that were imported directly to the Storage window from the client 
workstation (by selecting the Spool & Store option for the job flow)

In the Storage window, you can see the number of jobs that are in storage and their 
status.

Each job in the Storage window is assigned a status as shown in Table 6:

Table 6: Storage window status buttons

Icon Status Indicates This

Completed The job has finished printing.

Held You moved the job from the Queues window to 
the Storage window; or the current job flow or 
virtual printer moved the job to the Storage 
window automatically.

Failed The job failed during processing or printing.

Aborted You aborted the job in the Queues window while 
the job was running.
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By default, the Storage window shows all the jobs, whatever their status. All the 
status buttons are selected—that is, they appear pushed in. If you click a status 
button now—for example, the Completed Jobs button—the button is released and 
the list hides all the completed jobs:

If you click the Completed Jobs button again, the button is pushed in and the list 
shows the completed jobs.

In the Storage window you can perform the following actions:

• Submit a job. See Importing and Printing Jobs on page 22.

• Run a rush job before other jobs. See Running a Rush Job on page 28.

• Preview and edit a job, using PitStop Edit for unprocessed jobs, or the Job 
Preview & Editor window for processed jobs. See Editing Jobs on page 33.

• View and edit the parameters of a job. See Viewing and Editing Job Parameters on 
page 28.

• Archive a job. See Archiving and Retrieving Jobs on page 30.

• Duplicate a job. See Duplicating Jobs on page 30.

• Delete a job. See Deleting a Job on page 29.

• View a job’s history (in the Job History window). See Viewing a Job’s History on 
page 32.

• Export a job as a PDF file. See Export as PDF2Go on page 86.

• View the job ticket report for a job. See Job Ticket Report on page 32.

• View the preflight report for a job. See Preflight Report on page 106.

• Use the PDF analyzer to detect problems in imported PDF files that may affect 
processing. See Analyzing a PDF Job on page 103

Note:  When all the status buttons are in the released (unselected) position, the 
Storage window shows no jobs.

Note:  You can only view a Preflight report for a job if you enable the 
Preflight parameter before processing the job. For more information, see 
Preflight on page 103.
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The Settings Window

You can set all system preferences in the Settings window.  

To open the Settings window:

From the Tools menu, select Settings. 

The window is divided into two areas: 

• Administration: Contains system administration settings.

• Preferences: Contains system preferences.  

For more information about setting system preferences, see Setting Up and 
Configuring the CX Print Server on page 150.

Note:  If you log on to the CX Print Server as a guest, the Settings window is 
unavailable.

Note:  All users can view the Administration and Preferences settings, but 
only an administrator can configure these settings.
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The Resource Center

The Resource Center enables you to add, remove, and manage external resources 
for the CX Print Server.

To open the Resource Center:

From the toolbar, click Resource Center .

The Resource Center provides access to the following resources:

• Virtual Printers, see Managing Virtual Printers on page 41

• Fonts, see Managing Fonts on page 101

• Imposition Templates, see Creating, Viewing and Modifiying Imposition Templates 
on page 72 

• Cached VI Elements, see Managing VI Elements on page 146 

• Paper Sets, see Managing Paper Sets on page 44 

• Profile Manager, see Profile Manager on page 125

The Job Parameters Window
The CX Print Server enables you to edit PDL files and change the job settings—for 
example, paper size, imposition, and color settings—in the Job Parameters window.

To open the Job Parameters window:

Double-click a job in the Storage or Queues window.
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The Job Parameters window title bar displays the following information:

• The name of the job

• The name of the virtual printer

• The time of submission

Each tab has a set of related parameters and values that you can select.

Table 7: Description of tabs in the Jobs Parameters window

This tab Enables you to

Print Settings Set print related job parameters—for example, 
Print range and Print method. See The Print 
Settings Tab on page 184.

Paper Stock Set job parameters related to paper stock—for 
example, Paper size and Paper set name. See The 
Paper Stock Tab on page 188.

Print Quality Set job parameters related to print quality—for 
example, Trapping and Image quality—and 
improve the quality of printed jobs. See The Print 
Quality Tab on page 190.

Color Apply last minute color corrections, or set the 
output job to match other output devices. See The 
Color Tab on page 192.

Imposition Set job parameters related to positioning, folding, 
trimming, and binding of pages—for example, 
Margins and Template. See The Imposition Tab on 
page 197. 
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The Help Menu
The Help menu provides information about the version of software that is installed 
on your CX Print Server and enables you to access the online help, which is based on 
this user guide.

To open the About window:

From the Help menu, select About.

The About window displays the following information:

• CX Print Server software version number

• Date the version was installed

• Any updates that were installed on top of the version 

Services Set job parameters that will assist your job 
workflow—for example, APR path and Preflight. 
See The Services Tab on page 203.

Finishing Select from various options to finalize your printed 
document—for example, define settings for the 
front and back cover. See The Finishing Tab on 
page 208.

Exceptions Define paper sets to include special exceptions in 
a job, and add inserts or interleaves. See The 
Exceptions Tab on page 211.

Table 7: Description of tabs in the Jobs Parameters window

This tab Enables you to
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To open the online help:

From the Help menu, select Topics.

Turning Off the CX Print Server
1. In the CX Print Server workspace, from the Job menu, select Exit.

The CX Print Server workspace closes, and you return to the Windows desktop.

2. Verify that the CX Print Server icon has disappeared from your taskbar.

3. From the Windows desktop, select Start > Shut Down. 

4. In the shutdown dialog box, select Shut down.

5. When the Windows shutdown is complete, turn off the monitor.

6. On the CX Print Server, click the power button behind the front door. 

The power LED on the front panel turns off. 

Note:  If there are jobs that are being processed or printed, a message is 
displayed.

Taskbar with CX Print Server icon Taskbar without CX Print Server icon

Note:  Some situations may require the power button to be depressed for 
more than 4 seconds.
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Importing and Printing Jobs
The basic workflow for printing a job in the CX Print Server consists of three main 
stages:

1. Importing the file.

2. Processing the job.

3. Printing the job.

After the job is printed, it is stored in the Storage window and can be resubmitted for 
printing, see Reprinting Jobs on page 24.

Importing Jobs
The Import Job feature may be used to submit jobs in the following situations:

• When a page-description language (PDL) file is created on a client workstation 
that is not connected to the CX Print Server

• When a PDL file is located on an external medium, such as a CD-ROM

• When the desired file resides locally on the CX Print Server

To import a job to the CX Print Server:

1. From the Job menu select Import Job. 

The Import window appears. 

2. To access the desired files, click the up one level button , or double-click on 
the file folders to go down the file tree.



Importing and Printing Jobs 23

3. In the upper list in the Import window, select the desired file(s) and click the 

add button .

The file(s) appears in the lower list.

4. Select a printer from the Virtual Printer list. 

5. Click Import.

All files currently listed on the lower list are sent to the CX Print Server to be 
processed and printed as defined in the selected virtual printer.

To check the status of imported jobs:

1. Click the Server icon arrow.

The Importing/Retrieving window appears.

The Importing/Retrieving window indicates the name of the file being 
imported, its location and the job size. It also indicates the percentage of the job 
already transferred, both numerically and graphically.

2. Select one of the following options:

• Click Skip This Job to stop importing the current file and import the next job 
in the import queue.

• Click Abort All Jobs to stop importing all the files.

• Click Close to close the Importing/Retrieving window.

Processing 
After a job enters the CX Print Server, it goes into the Process Queue or the Storage 
window, depending on the job flow. Once the job is in the Process Queue, the job 
begins processing.

For more information on the Queues window, see Managing Job Queues on page 24.

Note:  Use SHIFT or CTRL to select several files or CTRL+A to select all the files. 
If desired, add the same file more than once.

Note:  To remove a file, select the desired file in the lower list in the Import 

Job window and click the remove button .
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Printing Jobs
Once your job has been successfully processed, it becomes ready to print (RTP). 
Depending on the designated job flow, the job either moves to the Print Queue or to 
the Storage window. 

If your job is moved to the Storage window, submit the job for printing.

The job is moved to the Print Queue.

For more information, see Managing the Storage Window on page 30.

The Print Queue lists the job that is currently printing, and all the jobs that were 
processed successfully and are waiting to be printed.

For more information on the Queues window, see Managing Job Queues on page 24.

Once the job is printed it moves to the Storage window.

Reprinting Jobs

Submitting an RTP Job Requiring no Changes
Select the job in the Storage window and from the Job menu select Submit.

The job(s) are placed in the Print Queue.

Submitting a Job that Requires Re-RIPing
1. Double-click the job to open the Job Parameters window. 

2. Change the desired parameter and click Submit.

The CX Print Server automatically determines if your job needs to be re-RIPed 
and places it in the appropriate queue.

Managing Job Queues

Batching Jobs
The job-batching workflow combines jobs with similar attributes into a single batch 
to enable the printer to print the jobs continuously without pausing. This feature 
saves printing time, especially for a large number of small jobs. Jobs that use paper 
of the same size and weight are suitable for batching. 

Note:  Use SHIFT or CTRL to select several jobs.
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When a job enters the Print Queue, the CX Print Server checks whether the job is 
suitable for batching with the previous one: 

• A job that can be batched appears with the running status indicator . The 
printer prints both jobs without pausing between them. 

• A job that cannot be batched with the previous one waits in the queue and 

appears with the waiting status indicator . It is printed only when the printer 
finishes the previous job and comes to a stop. 

The following types of jobs cannot be combined into one batch:

• Collated jobs and uncollated jobs

• Jobs that use different output trays

• Jobs with different staple positions

To deactivate job batching:

In the Settings window, select Preferences > Print Queue Manager > Disable 
Job Batching.

For more information about job batching, see Print Queue Manager on page 167.

Changing the Order of Jobs in the Queues 
You can rearrange the jobs in a queue to change the order in which they will be 
processed or printed. For example, this feature is useful when you have an urgent job 
that takes priority.

To move a job up in the queue:

Right-click the job and select one of the following options:

Promote: to move the job up one step

Promote to top: to move the job to the top of the queue

To move a job down in the queue:

Right-click the job and select one of the following options:

Demote: to move the job down one step

Demote to bottom: to move the job to the bottom of the queue.

Note:  The CX Print Server batches suitable jobs only if they are consecutive in 
the queue. Two jobs are not batched if a job that is not suitable comes between 
them in the queue.

Note:  The job batching option is active by default.

Note:  You can only move one job at a time.

Note:  The job is placed below the Running job.
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Suspending and Resuming Queues
If necessary, you can stop a queue temporarily and then later continue its operation 
afterwards. To do this, use the suspend and resume buttons.

To suspend a queue:

Click the suspend button .

The button turns red (suspend mode), and the processing/printing stops after 
the current job has finished running.

To resume a queue:

Click the resume button .

The button turns green (resume mode), and the top job in the queue starts 
processing/printing.

Aborting a Running Job

To stop processing or printing a running job:

Right-click the running job in the Queues window, and from the menu, select 
Abort.

The job moves from the queue to the Storage window, and the Job Alert 
window is updated.

The Aborted status  is assigned to the job, and the next job in the queue 
starts running.
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To return a job to the Process Queue or Print Queue:

Right-click the job in the Storage window and select Submit.

Moving a Job to the Storage Window
To postpone processing or printing of one or more jobs, use the Move to storage 
option.

To move a job to storage:

1. Select the job in the Queues window.

2. Right-click the job, and select Move to storage.

The job moves from the queue to the Storage window, and appears with the 
held job indicator . 

Note:  To return a job to the proper queue, right-click the job(s) in the Storage 
window and select Submit.

Note:  If the job is running, this option is not available.
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To return a held job from the Storage window to its original queue:

Right-click the job, and from menu select Submit.

The job moves from the Storage window to the queue.

Viewing and Editing Job Parameters 

In the Queues or Storage window, double-click the job whose parameters you 
want to view.

The Job Parameters window appears.

For more information on the Job Parameters window, see Setting Parameters in 
the Job Parameters Window on page 184.

Running a Rush Job
When you have a job that’s urgent, you can submit it for processing or printing and 
run it before other jobs. If you submit a job for processing while another job is being 
processed, the latter job pauses temporarily but retains its running status. When the 
rush job finishes processing and moved to the Print Queue, the processing of the 
paused job continues.

Notes:

• In the Queues window, you can edit the parameters of jobs that have 
not begun to run. If you want to edit the parameters of a running job, 
you must first suspend the queue (click the suspend button).

• If you edit the parameters in of a job in the Print Queue and the 
changes require re-RIPing of the job, it automatically moves to the 
Process Queue.
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If you submit a rush job for printing while another job is being printed, the latter job 
pauses temporarily after the current page (both sides) or set is printed but retains 
its running status. When the rush job finishes printing, the printing of the paused job 
continues.

To submit a rush job:

In the Queues or Storage window, right-click the job, and select Run 
Immediately.

The job appears with the rush status indicator  at the top of the appropriate 
queue and runs immediately.

Deleting a Job
Deleting a job from the Process Queue, Print Queue, or Storage window, 
permanently removes the job from the CX Print Server. Thereafter, to print the job, 
you must resubmit it to the CX Print Server for processing. To temporarily remove a 
job from a queue, use the Move to storage option (see Moving a Job to the Storage 
Window on page 27).

To delete a job:

1. Right-click the desired job in the queue or Storage window, and select Delete.

The following message appears.

2. Click Yes.

The selected job(s) is deleted.

Note:  Only one job can be processed or printed at a time. Therefore, if you 
select several jobs (one after the other) as rush jobs, they will be processed/
printed in the order of their selection.

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is active, this option is not available.

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is running, this option is not available.

Note:  You can delete more than one job at a time: Select the jobs, and from 
the Job menu, select Delete.
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Managing the Storage Window

Submitting Jobs

To submit a job in the Storage window:

In the Storage window, right-click the job, and select Submit.

RTP jobs are submitted to the Print Queue; all other jobs are submitted to the 
Process Queue.

Duplicating Jobs

To duplicate a job:

In the Storage window, right-click the job and select Duplicate.

The selected file is duplicated and is given the name of the original job followed 
by the suffix _dup. 

Discarding RTP Information
The RTP information can be discarded if desired. Under some circumstances, it is 
necessary to discard RTP data—for example when you want to re-RIP a file, archive 
a job without the RTP information, or edit tabs.

To discard RTP information from a job:

In the Storage window, right-click the relevant job and select Revert to source.

The RTP data is discarded and the file returns to its original format—for example, 
PostScript.

Archiving and Retrieving Jobs
To keep enough disk space free, we recommend that you back up jobs and their 
related files to an external server and then delete them from the Storage window.

This backup process is called archiving. You can retrieve archived jobs and related 
files later for further use.

You can set a default archiving path that will automatically be displayed in the Open 
dialog box when you select Archive from the Job menu. Set this path in the Settings 
window under Preferences > General Defaults.

If a job includes VI elements, you need to archive or retrieve the VI elements before 
archiving or retrieving the job. For more information on archiving or retrieving VI 
elements, see Managing VI Elements on page 146.

Note:  Duplicating an RTP job creates a PDL version of the job.



Managing the Storage Window 31

To archive a job on an external server:

1. In the Storage window, right-click the job you want to archive and select 
Archive.

The Archive dialog box appears.

2. Locate the desired folder, and then click Archive.

A cabinet file (a compressed file) that contains all the files related to the 
archived job is created at the selected location. 

3. In the Job Alert window, verify that archiving has been completed.

4. Delete the job from the Storage window.

Notes:

• The archived job retains its current status (that is, completed, failed, 
held, or aborted) and is archived with the information in its Job 
Parameters and Job History windows. 

• When retrieved, the archived job retains the original job name, not the 
name assigned when archived.
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To retrieve an archived job:

1. From the Job menu, select Retrieve from Archive.

The Retrieve dialog box appears.

2. Locate the archived job under its archive name, select the related cabinet file, 
and click Retrieve. 

The selected job appears at the top of the list in the Storage window. It is 
assigned the status indicator (completed, held, failed, or aborted) that is had 
before archival. 

3. In the Job Alert window, verify that the file has been successfully retrieved.

Viewing a Job’s History
In the Queues or Storage window, right-click the job and select Job History.

The Job History window appears.

For more information about the Job History window, see Job History on page 174.

Job Ticket Report
The Job Ticket report contains all information from the Job Parameters window 
(including Job Parameters window title bar data). The Job Ticket report presents the 
job parameters on a single sheet and may be exported or printed as a hard copy.

Notes:

• You can retrieve more than one job at a time.

• The files related to the job (for example, PDL) are also retrieved.

• The job is retrieved with the information in its Job Parameters and Job 
History windows.

• The cabinet file is not deleted.
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This feature is useful for:

• Making the job information available to the Hot-Line service in case of customer 
query.

• Saving the job parameters for future use.

• Providing the client or customer a tool for following up printed jobs.

To display the job ticket report:

1. Right-click a job in the Storage window, and from the menu select Job Ticket 
Report.

The Job Ticket Report window appears.

2. You can export or print the report by clicking Print or Export.

3. The Job Ticket Report is exported as a text file.

Editing Jobs
There are two ways to preview and edit jobs from the CX Print Server:

• Before processing, use the Enfocus PitStop Edit software for Acrobat. See Editing 
an Unprocessed Job on page 34.

• After processing, use the CX Print Server Job Editor. See Editing Processed Jobs on 
page 34.
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Editing an Unprocessed Job
The PitStop Edit software enables you to:

• View and change an object’s properties—for example, color properties

• Create action lists, which you can use to automate repetitive tasks

To edit your job using PitStop Edit:

1. Right-click the job, and select Job Preview&Editor.

Your file opens in Acrobat.

2. Use the PitStop Edit software to edit your job, as desired.

Editing Processed Jobs
The Job Editor tool enables you to preview and edit RTP jobs before printing. You can 
use the Job Editor to delete, move or insert pages. While you navigate to the various 
pages of a job, you can view thumbnails of the job. For an imposed job, you can view 
the imposed sheets, including the layout of the pages on each sheet. You can also 
view the pages’ orientation, crop marks, and fold marks.

To open the job editor:

In the Storage window, right-click an RTP job that you want to preview, and 
select Job Preview&Editor.

The Job Editor window appears, displaying the first page of the selected job. 

Navigation Buttons

The navigation buttons enable you to select a specific booklet or page to view, and 
to browse the pages of the current job.  

Note:  The job must be a PDF or PostScript file. For information on editing 
processed jobs, see Editing Processed Jobs on page 34.

Tip:  Refer to the PitStop Edit documentation (C:\Program 
Files\Adobe\Acrobat\plug-ins\Enfocus\Documentation\PitStop 
Manual.pdf) to familiarize yourself with the software functions.

Note:  When the first page of a booklet is in view, the Previous Page navigation 
button takes you to the previous booklet. When the last page of a booklet is in 
view, the Next Page button takes you to the next booklet.
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Previewing the Job
The preview buttons enable you to switch the display mode of the page.

Table 8: Preview Buttons

Viewing Pages in the Job Editor
The Job Editor window has three tabs—Booklets, Thumbnails, and Imposed 
Sheets—which enable you to switch between views.

This button: Enables you to:

Pan

View a different area of the image.

Eye Dropper

Find out the CMYK values of a specific area on 
the page. To find the values, first click the Eye 
dropper button. Then move the pointer to the 
point on the page where you want to measure 
the color values, and click. The CMYK values 
appear as a tool tip.

Zoom In

Magnify the selected area of the page.

Zoom Out

Reduce the size of the selected area by 50%.

One to One Zoom

View the actual size of the page one to one (1:1).

Fit to Screen

Scale the page to fit the available screen space.

View the image at different preset levels of 
magnification by selecting a percentage in the 
list.

Rotate View

Rotate the page by 90°, 180° and 270°.

Show/Hide Separation

Turn on or off one or more separations.
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The Booklets tab
The Booklets tab displays the booklets included in the selected job and the names 
and numbers of the pages in each booklet. The Booklets tab opens by default when 
you are previewing a non-imposed RTP job.

To view a page on the booklets tab: 

In the left pane of the Booklets tab, double-click the name of the page that you 
want to view.

The page is displayed in the right pane.

 

The Thumbnails Tab 
The Thumbnails tab displays miniature views (thumbnails) of each page in the 
selected booklet. These thumbnails enable you to find a specific page more easily.

To view a page on the Thumbnails tab:

1. Click the Thumbnails tab.

Miniature versions of the pages appear on the left side of the tab, in the 
thumbnail pane.

2. Use the scroll bar, as desired, to view all of the pages.
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3. To view the thumbnails side by side, resize the thumbnail pane by dragging the 
bar that divides the panes in the tab.

4. Double-click the thumbnail of the page that you want to view. 

The page is displayed in the right pane.

The Imposed Sheets Tab
The Imposed Sheets tab is available only for imposed RTP jobs. This tab enables you 
to view the imposed sheets and check your imposition parameters. You cannot edit 
the job on this tab.

To display a page of an Imposed job:

1. Click the Thumbnails or Booklets tab.

2. Select the desired thumbnail or page.

3. Click the Imposed sheets tab.

The selected page of the imposed job appears.

Notes:

• In VI jobs, the booklet number appears in instead of the sheet number—for 
example, Booklet 1, Page 15.

• In duplex jobs, each sheet is displayed twice, once for side A, and once for 
side B. For example, Sheet 1, Side A.
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4. To edit the job, click the Booklets or Thumbnails tab. 

Editing an RTP Job
You can edit an RTP job in the following ways:

• Move pages within the job 

• Delete pages from the job 

• Insert pages from another job

To move a page in a job:

1. Click the Thumbnails tab.

2. In the thumbnail pane, click the page that you want to move.

3. Drag the page to the target location.

Note:  If you edit an imposed RTP job and then return to the Imposed sheet 
view, the view will be updated according to the applied changes.

Note:  Jobs that you can edit in the Job Editor cannot be re-RIPed. Once a job 
has been saved in the Job Editor, it is a new RTP file without an associated PDL 
file. You cannot apply parameters that require re-RIPing to such jobs.

Note:  The red marker indicates where the page will be inserted.
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The page moves to the selected location, and the page numbers are updated 
accordingly.

4. Click Save As to save the changes in the job.

To delete a page from a job

1. In the Job Editor window, click the page that you want to delete, and click 
Delete.

The page is deleted and the page numbers are updated accordingly.

2. Click Save As to save the changes.

Copying Pages Into a Job
You can copy one page or all pages from one job to another.

To copy a page into a job:

1. In the Job Editor window, click Select Job.

The RTP Jobs window appears.
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2. Select the job with the page you want to copy and click OK. 

In the Thumbnails tab, the left pane splits into two. The thumbnails of the 
second job appear below those of the job you are editing.

3. In the lower set of thumbnails, locate the page that you want to copy.

4. Drag the page to the upper set of thumbnails, to the desired location in the job 
that you are editing.

The copied page is inserted in the desired location, and the page numbers are 
updated accordingly.

5. Click Save As to save the changes.

Note:  The red marker indicates where the page will be inserted.
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To copy all the pages of a job into another job:

1. Follow steps 1-4 in the procedure for copying a page into a job (see page 39).

2. Click the Merge Jobs button.

All the pages of the second job that you opened are inserted at the end of the job 
that you are editing.

3. Click Save As to save the changes.

Managing Virtual Printers
The CX Print Server provides three default network printers, also known as virtual 
printers. Virtual printers are a function used for automating workflows, which then 
define job streaming. They contain preset workflows that are automatically applied 
to all print jobs processed with that virtual printer. There is no need to reset job 
settings for each job, thus increasing printing efficiency.

A virtual printer is a printer published on the network with specific parameters set 
for processing and printing on the CX Print Server. The CX Print Server contains a 
mechanism that automatically installs the published virtual printers on your client 
workstation with the PPD and suitable printer driver.

The CX Print Server is predefined with three virtual printers:

• ProcessPrint 
Files sent to this printer are automatically processed and immediately sent to 
print from the DocuColor 8000AP.

• ProcessStore 
Files sent to this printer are automatically processed and stored in RTP format in 
the Storage window. Later, you can submit the job to print, or change the 
parameters of the job and resubmit it for processing or printing.

• SpoolStore
Files sent to this printer are automatically stored in the Storage window until you 
submit them for processing and printing. You can only import PDL files (such as: 
PS, PDF, VIPP, VPS) to the spool store, not RIPed, RTP files.

The Printer Default options defined in the PPD use the default parameters set for 
the chosen virtual printer.

Adding a new printer
When adding a new virtual printer you can specify if it is published on the network 
and if the virtual printer parameters will override the PPD parameters.

In addition, based on predefined paper sets, you can specify that a virtual printer 
supports dynamic page exceptions and select the desired paper sets (up to four 
paper sets for each virtual printer). A job that has embedded dynamic page 
exceptions commands, and is submitted for print using a dynamic page exceptions 
virtual printer, is printed using the defined paper sets.

Note:  The print-related job parameters that are set in the job from the driver or 
PPD override the parameters set in the virtual printer. 
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To add a new printer:

1. From the Tools menu, select Resource Center.

The Resource Center window opens.

2. From the Resource list, select Virtual Printers.

3. Click the Add button .

The Add New Virtual Printer dialog box appears.

4. In the Name box, type a name for the new printer you want to add.

5. From the Based on list, select an existing printer with similar settings.

6. In the Comments box, type any comment regarding the virtual printer 
parameters (optional).

7. The Publish the printer on the network check box is selected by default. Clear 
the check box if you do not want to publish the printer on the network.

8. Select the Override PPD parameters check box if you would like the Virtual 
Printer settings to override the PPD parameter selection.
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9. If you would like this printer to support dynamic page exceptions, select the 
Support dynamic page exceptions check box.

For more information about dynamic page exceptions, see Dynamic Page 
Exceptions on page 99.

10. Edit the job parameters of your new virtual printer (see Editing an Existing 
Printer). 

11. Click OK in the Add New Virtual Printer dialog box. 

The new printer appears in the Printer list.

Editing an Existing Printer

To edit an existing printer:

1. In the Virtual Printers area, select a printer from the list and click the Edit button 

.

The Edit Virtual Printer dialog box appears.

2. Click Edit.

The Job Parameters window appears.

3. Select the desired parameters and change their settings according to your 
requirements.

4. Click OK to return to the Edit Virtual Printer dialog box.

5. Click Save to save the new settings.

Note:  If you don't edit the Job Parameters, the settings of the new virtual 
printer are taken from the printer on which it was based.
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Deleting an Existing Printer
1. In the Virtual Printers window, select a printer from the list and click the Delete 

button .

2. In the message that appears, click Yes to delete the designated printer.

Managing Paper Sets
The CX Print Server is provided with predefined paper sets for your convenience. 
These paper sets cannot be removed but they can be modified. In addition, you can 
add, modify or remove custom paper sets according to your requirements.

To add a new paper set:

1. From the Tools menu, select Resource Center.

The Resource Center window opens.

2. From the Resource list, select Paper Sets.

3. Click the Add button .

The Paper Set Properties window appears.
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4. Enter the following parameters:

Name: enter the new paper set name. It is recommended that the name is as 
descriptive as possible—for example, Letter90gsmuncoat.

From the Size, Color, Weight, Coat and Type lists, select the desired 
properties for the new paper set.

If you have enabled the custom paper function, map the paper set to a 
Custom Profile.

For information on enabling the custom paper function, see General Defaults 
on page 166.

5. Click OK.

To modify a paper set:

1. In the Paper Set window, select the paper set you would like to modify.

2. Click the Edit icon .

The Paper Set Properties window appears. 

3. Modify the desired properties of the paper set.

4. Click OK.

To delete a paper set:

1. In the Resource Center window, with the Paper Sets option selected, select the 
paper set you would like to delete.

2. Click the Remove icon .

The Paper Set is deleted.

Note:  You can set up to ten custom profiles.

Note:  The system predefined paper sets can’t be deleted.



46 Chapter 3—Basic Workflows

 



Working at a Client 
Workstation

Overview..................................................................................................................48

Working From Windows Client Workstations ...............................................48

Working From Macintosh Client Workstations.............................................50

Spire Web Center .................................................................................................. 57

Using Hot Folders .................................................................................................. 59

CX Print Server Print Driver Software ..............................................................62



48 Chapter 4—Working at a Client Workstation

 

Overview
To print a job from a client workstation, select one of the following methods:

• Print the job via one of the CX Print Server network (virtual) printers—for 
example, ProcessPrint.
The job is spooled and then processed or printed (according to the selected job 
flow of the virtual printer). If you use this method, you can print from any 
software—for example, Microsoft Word— and use any file format from any 
client workstation (Windows, Macintosh, or UNIX).

• Drag the job to a hot folder.
The job is spooled and processed or printed (according to the selected job flow 
of the corresponding virtual printer). 
If you use the hot folder method, you can print most PDL files on the CX Print 
Server— for example, PostScript, PDF, EPS, Variable Print Specification, and 
VIPP files.

For more information about hot folders, see Using Hot Folders on page 59.

Working From Windows Client Workstations
The CX Print Server can receive print jobs from a Windows client workstation that 
has one of the following operating systems:

• Windows 2000 and Windows XP

As an example, the following section describes how to define a CX Print Server 
network printer for a client workstation with a Windows XP Professional operating 
system.

Defining a Printer - Windows XP
Use the Windows Add Printer wizard to define the CX Print Server network printers.

Note:  PDL jobs that are spooled to the CX Print Server must have the 
appropriate file name extensions—for example, *.ps or *.pdf.

Note:  When you add a new CX Print Server network printer to a client 
workstation, there is no need to install the CX Print Server PPD file and Adobe 
PostScript printer driver separately. They are installed automatically in the 
Windows Add Printer wizard.
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To define a network printer in Windows XP using the network neighborhood:

1. On the desktop, double click My Network Places and browse to the desired 
network printer.

2. Double-click on the network printer icon.

The network printer is defined on your Windows client workstation.

Copying the Printer Driver from Windows
Perform this procedure if you need to create PostScript files from workstations that 
are not on the same network as the CX Print Server—for example, at customer sites.

1. On the CX Print Server D:\ drive, double-click the Utilities folder.

2. Click PC Utilities, and then Printer Driver.

3. Find the directory of the driver relevant to your version of Windows.

4. Using a compression utility, such as WinZip, compress the directory, and either 
copy it to a disk or send it by email to the customer.

Printing From Windows
1. Open the file you would like to print in the corresponding software—for 

example, open a PDF file in Acrobat.

2. From the File menu, select Print. 

The Print window appears.

3. From the Name list, select the desired CX Print Server network printer—for 
example, Spire_ProcessPrint.

For more information about installing CX Print Server network printers on client 
workstations, see Working From Windows Client Workstations on page 48.
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4. If desired, click the Properties button and modify the job parameters.

5. Click OK.

6. Click OK in the Print window.

The file is sent to the CX Print Server. 

Working From Macintosh Client Workstations
The CX Print Server can receive jobs printed from Macintosh client workstations 
running Mac OS X (10.x).

As an example, the following section describes how to define a CX Print Server 
network printer for a Macintosh client workstation running Mac OS X.

You can also submit jobs using the CX Print Server virtual printers over a TCP/IP 
protocol. This connection enables a significantly higher spooling speed.

Notes:

• Unless the Override PPD Parameters option was selected in the 
virtual printer, any changes to the printer parameters override the 
parameters of the selected virtual printer. 

• Printer's Default indicates that the value is taken from the settings of 
the selected virtual printer on the CX Print Server.



Working From Macintosh Client Workstations 51

Copying the CX Print Server PPD File for Mac OS X (10.4)
Before you define a network printer you need to install the CX Print Server PPD file 
on your Macintosh client workstation.

1. From the Go menu, select Connect to Server.

The Connect to Server window appears.

2. Click Browse to locate the desired CX Print Server, and then click Connect.

The Connect to Server window appears.
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3. Select Guest, and then click Connect.

4. Select the server Utilities folder, and then click OK.

The CX8000AP_Utilities folder is mounted on your desktop.

5. Double-click the CX8000AP_Utilities folder on your desktop.

6. Double-click the PPD folder, and then double-click the folder for the desired 
language.

7. Copy the PPD file from the CX Print Server to your Macintosh hard disk.
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Adding a Network Printer for Mac OS X (10.4)
1. Copy the CX Print Server PPD file to the Library > Printers > PPDs > Contents > 

Resources > en.Iproj folder on your client workstation.

For more information about copying the PPD file, see Copying the CX Print Server 
PPD File for Mac OS X (10.4) on page 51.

2. From the Go menu, select Applications.

3. Open the Utilities folder and double-click the Printer Setup Utility icon.

Tip:  It is recommended that you copy the PPD file by dragging it from the CX 
Print Server to the Library > Printers > PPDs > Contents > Resources > 
en.Iproj folder on your Macintosh.

Note:  If you have Mac OS X (10.2), double-click the Print Center icon in the 
Utilities folder.
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4. Click Add.

5. Select the CX Print Server.

6. In the Print Using list, select Other.

A browser window appears.

7. Locate the folder to which you have copied the PPD file, and then select the 
PPD file.
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8. Click Open to assign the PPD file to the selected CX Print Server network 
printer.

9. Click Add to add the new printer to the printer list.

Printing from a Macintosh
1. Open the file you would like to print in the corresponding application—for 

example, open a Quark file.

2. From the File menu, select Print.
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3. From the Printer list, select the desired printer.

4. In the Copies & Pages list, select Printer Features.

5. Adjust the printer options as desired.

6. After modifying the job settings, click Print.

The file is sent to the CX Print Server. 

Notes:

• The Printer's Default option indicates that the value is taken from the 
published printer that is currently selected.

• The PPD parameters are divided into five Printer Specific Options in 
the list.
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Spire Web Center
The Spire Web Center is an internet site that provides CX Print Server information 
and can be accessed from client workstations. 

The Spire Web Center enables you to:

• View the status of jobs in the CX Print Server queues, the Job Alert window in its 
current state, and the printer system information

• Download remote client tools, utility software, color profiles, and print drivers

• View CX Print Server-related documentation, such as release notes, CX Print 
Server guides, frequently asked questions and answers, and other 
troubleshooting information

• Find links to related vendors or products

To connect to the web center from a client workstation:

For more information about setting up the web connect service, see Remote Tools 
Setup on page 155.

1. On your desktop, click the Internet Explorer icon.

2. When the Internet Explorer starts, in the address field type: 
http://<CX Print Server name>—for example, if the station name is FALCON_E, 
type http://FALCON_E.

Important:  To connect to the Spire Web Center from a client workstation, you 
must first enable the web connect service on the CX Print Server. To enable 
this service, select the Settings window > Administration > Remote Tools 
Setup.

Note:  You can also use the CX Print Server IP address—for example, 
http://192.168.92.0.

Important:  If you would like to connect to the CX Print Server from a 
Macintosh client workstation, contact your system administrator to add 
the Spire name to the DNS. This is required since Windows name 
resolution protocols are not supported in Macintosh. The DNS addition is 
required when clients go through a main server on the network.
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The CX Print Server Web Center appears. 

The Web Viewer
The Web Viewer page enables you to view the printer configuration and system 
information, the jobs that currently reside in the CX Print Server Queues window 
and Storage window, and to view the alerts that currently appear in the Job Alert 
window. This information is important when you print from a client workstation 
because it enables you to monitor your jobs in the queues and then make any 
necessary changes. 

In addition, if you have a system that uses XML protocol, you can retrieve 
information about the job list and printer status.
 

Table 9: Description of tabs in the Web Viewer

This tab Enables you to view

Queues Jobs that are currently running in the CX Print Server Print 
Queue and Process Queue

 Storage CX Print Server Storage window and the jobs that reside in 
this window
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Downloads
The Downloads page enables you to access the CX Print Server Utilities folder and 
download available tools and files for Windows and Macintosh client 
workstations—for example, the CX Print Server PPD file.

Links
The Links page enables you to link to related vendors or products.

Using Hot Folders
For every published CX Print Server network printer that you define on a client 
workstation, a corresponding hot folder is automatically created in the CX Print 
Server D:\Hot Folders folder. The CX Print Server has three default hot folders, 
HF_ProcessPrint, HF_ProcessStore, and HF_SpoolStore. These hot folders 
correspond to the three default printers.

Each hot folder carries the virtual printer's name HF_printer’s name.

When you connect from a client workstation to the CX Print Server over the 
network, you can use the hot folder to submit PDL jobs to the CX Print Server. When 
you establish a connection, drag your jobs onto the desired hot folder (according to 
the selected workflow).

Jobs that reside in the hot folder will automatically be submitted to the CX Print 
Server through the corresponding virtual printer. Consequently, all of the virtual 
printer job parameters, inclusive of the workflow, will be applied to the job.

As soon as the job has been spooled to the CX Print Server, it disappears from the 
hot folder and enters the CX Print Server Process Queue or Storage window, 
according to the selected workflow.

 Alerts The CX Print Server Job Alert window messages. For 
example, if a job that you sent to print from your client 
workstation has failed—you can view the message in the 
Job Alert window, edit the job parameters (PPD file), and 
then resend it for processing and printing on the CX Print 
Server.

 Printer CX Print Server system information

Table 9: Description of tabs in the Web Viewer

This tab Enables you to view

Tip:  You can also drag the hot folder icon to your desktop to create a short cut 
to the folder for future usage.

Note:  If you send files for printing through a hot folder while the CX Print Server 
software is down, when the software restarts, the files that reside in hot folders 
will immediately be imported to the system.
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Hot Folder File Formats
Hot folders can contain all PDL formats that are supported by the CX Print Server, 
PS, PDF, EPS, PRN, VPS, VIPP, PPML, TIF, JPG and GAP. 

Files of unsupported formats that are moved to a hot folder are not imported to the 
CX Print Server and remain in the hot folder.

Hot Folders and Brisque or Prinergy jobs (GAP Formats)
When you use hot folders to print GAP jobs, the process is automated and the job is 
converted to a PDF, which is displayed in the CX Print Server queues. The PDF files 
can then be programmed and printed as any other PDF file.

Using Hot Folders from Client Workstations
You can use hot folders to process and print files from any client workstation. The 
following procedures explain how to print using hot folders from Windows and 
Mac OS X.

To print a job using a hot folder from Windows:

1. On your Windows desktop, double-click the Network Neighborhood icon. 

2. Locate your CX Print Server.

3. Double-click the CX Print Server. 

A list of all the shared folders, hot folders, and virtual printers appears.

4. Double-click the desired hot folder—for example, HF_ProcessPrint.

You can now drag the desired files to the hot folder. All the files are processed 
and printed automatically to the printer, according to the hot folder workflow.

Tip:  You can also drag the hot folder icon to your desktop to create and 
use a shortcut to the folder in the future.
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To print a job using a hot folder from a Mac OS X:

1. From the Finder menu bar, select Go > Connect to Server.

The Connect to Server window appears.

2. Locate your CX Print Server on the network, and click Connect.

3. Select Guest, and then click Connect.
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4. From the list, select the desired hot folder—for example, HF_ProcessPrint 

—and then click OK.

The hot folder icon appears on your desktop. You can now drag the desired files 
to the hot folder icon. All the files are processed and printed automatically to 
the printer, according to the hot folder workflow.

CX Print Server Print Driver Software

About the Print Driver
The CX Print Server Print Driver software enables you to set job parameters for jobs 
that you send to the DocuColor 8000AP from any application on your client 
workstation. The Print Driver software also enables you to see the DocuColor 
8000AP configuration, monitor’s the printer status, and save a set of print 
parameters for reuse.

Installing the Print Driver
The Print Driver software is automatically installed on the client workstation when 
you set up a network printer. Once the printer is defined, you must activate the print 
driver’s enhanced user interface.

Defining a Printer in Windows
To define a printer in Windows, refer to Working From Windows Client Workstations 
on page 48.

Activating the Print Driver

To activate the print driver’s enhanced user interface:

1. On the desktop, select Start > Settings > Printers and Faxes.

2. Right-click the printer icon, and select Properties.

3. Click the Print Driver tab.
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4. In the Enable enhanced user interface list, select on.

5. Click Apply.

6. Click OK to close the dialog box.

Using the Print Driver Software
1. Open the file that you want to print—for example, a PDF file.

2. From the File menu, select Print.

3. In the Print dialog box, click Properties.

If this is the first time that you are using the Print Driver software, a message 
tells you that the software is loading. Then a dialog box appears with the print 
settings.

Note:  The loading process might take a few minutes. Afterwards, 
accessing the Print Driver software takes less time.
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In the Print Driver software window, you can perform the following actions:

• Define job parameters

• Change parameters and save the settings as a profile

• Load a saved profile

• Check the status of the DocuColor 8000AP

• Define PostScript settings for the job

Setting Job Parameters in the Print Driver
1. Under Spire Settings, click the tab on which you want to change parameters:

• Print Settings

• Paper Stock

• Print Quality

• Color

• Services

• Finishing

For more information on setting the job parameters, see Setting Parameters in 
the Job Parameters Window on page 184.

2. Click OK.
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Using Profiles
Once you have selected the parameters for a job, you can save this set of parameters 
for future use. Sets are useful when you want to print different jobs with the same 
parameters, or if you want to reprint a job.

To create a set:

1. Select all of the desired parameters for the job, and click Save Set.

2. Locate the folder in which you want to save the settings.

3. In the File name box, type the desired file name.

4. Click Save.

The parameters are saved as a set.

To retrieve a set:

1. Under Spire Settings, click Load Set.

2. Locate and select the profile, and click Open.

The set of paramters are applied to the job. 

Tip:  You can modify any of the parameters as desired.
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Viewing the Printer’s Status
1. Click the Printer tab.

2. Click the Paper Stock tab to view information on the paper stock in the trays.
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3. Click the Finisher tab to view information on the finishing options.

 

4. Click the Toner tab to view information on the toners.
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5. Click the Consumables tab to view information on consumables such as bottles 
and fuser oil.

6. Click Update if you want the software to dynamically update the information 
that it displays.

Notes:

• When you access the Print Driver software, the resource 
information is only refreshed after you click Update.

• Clicking Update updates the gradation tables.
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PostScript Settings
1. Click the PostScript tab and adjust the settings as desired.

2. Click OK to save the settings.

Working Offline
The printer is offline under the following circumstances:

• Your workstation is not connected to the CX Print Server.

• The DocuColor 8000AP and the CX Print Server are not communicating.

• You are working in a non-TCP/IP environment such as a Novell environment.

• The selected virtual printer is not currently published on the CX Print Server.

When the DocuColor 8000AP is offline, you can select and save settings in the Print 
Driver software for the selected virtual printer. However, you cannot update the 
display of information about the printer resources—for example, paper or toner.

Uninstalling the Print Driver Software
1. On the desktop, select Start > Settings > Printers and Faxes.

2. Right-click the CX Print Server network printer, and select Delete.

The printer is deleted from your client workstation.

3. In the Printers and Faxes window, from the File menu, select Server Properties.
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4. In the Print Server Properties dialog box, click the Print Driver tab, select the 
Xerox printer driver—for example, AdobePS CX8KAP01—and click Remove.

The Xerox driver is removed.

5. Select Start > Run.

6. Locate the CX Print Server.

7. Navigate to \Utilities\PC Utilities\Driver Extension.

8. Double-click Creo_Driver_Uninstall.exe.

The Print Driver software is uninstalled.
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Imposition Workflow
Imposition is the process of arranging pages of a job on a press sheet in a particular 
order so that they will be in the proper sequence after printing, folding, and cutting. 
Finding the best imposition layout helps create more organized output and saves 
paper. Imposition does not affect the content of the pages. It affects only the 
placement of the pages on the press sheet.

The arrangement of the pages on the press sheet depends on many factors, 
including the size of the pages, the size of the press sheet, and the binding 
requirements of the finished job. You can also add various marks to the sheets to 
aid the production process. These marks show where the paper should be folded or 
trimmed.

Whenever possible, you should define imposition settings before RIPing a job. 
Changing key imposition settings—for example, template settings—post RIP may 
result in inefficient re-RIPing of your job.

In the CX Print Server, you can define imposition settings in three different ways, 
depending on your needs.

• Use the Imposition tab to define imposition settings for a one-time job or to 
make changes on the fly.

For more information about the Imposition tab, see The Imposition Tab on 
page 197.

• Use the Imposition Template Builder to create and save reusable templates.

• Use a CX Print Server virtual printer to predefine imposition settings for repeat 
jobs or jobs that have the same imposition settings.

When you create a new virtual printer or edit an existing one, define the 
imposition settings for that particular printer. These settings become the 
printer's default options and are applied to all jobs that use that printer.

For more information about virtual printers, see Managing Virtual Printers on 
page 41.

You can also set page exceptions for imposed jobs on the Exceptions tab.

For more information about the Exceptions tab, see Setting Exceptions for Imposed 
Jobs on page 88.

Creating, Viewing and Modifiying Imposition Templates
In the CX Print Server, you can use the Imposition Template Builder to create 
templates for similar types of jobs that have the following imposition settings in 
common:

• Imposition method

• Columns and rows

• Simplex/duplex

• Binding
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For example, if you want to create an imposition template for A4-sized 
brochures printed on A3 paper, you could create a template, called 
“A4Brochure”, and select the following settings:

• Imposition method: Saddle Stitch

• Columns: 1

• Rows: 2

• Type: Duplex (selected by default)

• Binding: Left 

You would define all the other imposition settings—for example, Trim Size, 
Bleed, Margin, Gutters, and Paper Size—on the Imposition tab.

To Open the Imposition Template Builder

From the Tools menu, select Imposition Template Builder.

The Imposition Template Builder window appears.

To Create a Template
1. From the Method list, select an imposition method.

2. Click New .

3. Type the name of the new template, and press ENTER.
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4. In the Layout area, type the number of columns and number of rows that you 
need.

The imposition method that you select determines the number of columns and 
rows that you can enter. For Saddle Stitch and Perfect Bound, you can place up 
to 64 pages on one sheet (8 × 8). For Step & Repeat and Step & Continue, you 
can place up to 625 pages on one sheet (25 × 25).

For more information about imposition methods, see Imposition Method on 
page 197.

5. Under Type, select Simplex or Duplex.

6. Under Orientation, select Portrait or Landscape.

7. From the Binding list, select the appropriate binding method.

8. Click Save.

All saved templates appear on the Imposition tab. After you select an imposition 
method, the related templates appear in the Template parameters, in the Layout list. 
See Table 10. For example, if you created a Step & Continue template, the template 
appears in the Layout list only when you select the Step & Continue imposition 
method. 

Some templates appear under more than one imposition method.

Table 10: Saved imposition templates in Layout list according to imposition method

Viewing Templates
As you create or modify a template, you can see your template in the template 
viewer. As you select parameters, the template viewer dynamically changes to 
reflect your selections.

Note:  The Orientation setting in the Imposition Template Builder is for 
display purposes only. This parameter is not saved in the template. (You set 
job orientation on the Imposition tab, under Sizes.)

Note:  Binding is available only when Saddle Stitch and Perfect Bound 
imposition methods are selected.

Method selected on Imposition 
tab:

Template layout type in the layout 
list:

Step & Repeat Step & Repeat, Cut & Stack

Step & Continue Step & Continue

Saddle Stitch Saddle Stitch, Perfect Bound

Perfect Bound Saddle Stitch, Perfect Bound
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In the template viewer, you can view an imposition template in three ways:

• Click Front  to view the front pages.

• Click Back  to view the back pages.

• Click Both  to view both the front and back pages simultaneously.

Modifiying Templates
The template viewer enables you to rotate one or more pages and change the 
location of pages on the sheet.

The gray arrow on each page indicates the top of the page. The page number is 
indicated by the number that appears on each page.

To rotate a page 180 degrees:

1. Make sure the Apply changes to front and back check box is clear.

2. Select the desired page.

3. Click Rotate 180 .

To rotate both the front and back sides of a page 180 degrees:

1. Select the desired page.

2. Select the Apply changes to front and back check box.

3. Click Rotate 180 .

You can change the location of a page on a sheet as needed. Changing the location 
of a page is often necessary when the Step & Continue imposition method is 
selected.

Notes:

• When Simplex is selected, only the Front view is available.

• Sheet size is set on the Imposition tab. The sheet size that appears in the 
template viewer is dynamic. It changes to accomodate the parameters that 
you choose.

Tip:  To select multiple consecutive pages, click the first page, press and hold 
SHIFT, and then click the last page. Select multiple non-consecutive pages by 
pressing and holding CTRL as you click each page.
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To change the position of a specific page on a press sheet:

1. Click the target location that you want to move the page to—for example, click 
page 1 if you want to place a different page in that location.

The target location turns blue when selected.

2. Click the Page Number box, and type the number of the page that you want to 
move to the target location. For example, you would type 5 to place page 5 in 
the location of page 1.

3. Press ENTER.

The page moves to its new location.

Important:  The page number that was previously in the target location is 
not automatically moved to another location. To retain this page, manually 
move this page to a new location.
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If you have a duplex job and the Apply changes to front and back check box is 
selected, the page number for the back side of the page also changes. Using the 
example above, page 6 would be on the back side of page 5.

Simulating Jobs With Your Template
You can simulate how jobs from the Storage window will look if you apply an 
imposition template to them.

To simulate a job with a specific imposition template:

1. In the Imposition Template Builder window, click the Simulate button.

2. Click Browse.

The Storage window appears.

3. Select a job, and then click Select.

The parameters of the job (Sheet Size, Trim Size, Trim Orientation, Sets per 
sheet, Bleed Size, Rotate 90, Crop Marks, and Fold Marks) appear with their 
values in the Simulate Imposition window.

4. Change the parameters as desired.

Note:  The impostion template parameters are not actually applied to the job—
you are viewing only a simulation of how the job would look if this template 
were selected on the Imposition tab.

Note:  Both RTP and non-RTP jobs are available for simulation.
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5. Click View Simulated Job.

The Preview window appears. A simulation of the job is displayed with the 
current imposition template applied.

For more information about the Preview window, see The Preview Window on 
page 202.

Managing Templates
The Imposition Template Builder enables you to:

• Import templates that reside on other CX Print Servers connected to your 
network

• Export your templates from the CX Print Server on which you are working to 
other servers connected to your network

• Duplicate templates

• Rename templates

• Edit templates

• Delete templates

To import a template:

1. In the Imposition Template Builder, click Import .

2. In the Look in list, locate the server and folder where the template resides.
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3. Choose the template file, and click Select.

To export a template:

1. In the Imposition Template Builder, from the Method list, select the imposition 
method, and then select the template that you want to export.

2. Click Export .

3. In the Save in list, locate the server and folder that you want to copy the 
template to.

4. Click Save.

To duplicate a template:

1. In the Imposition Template Builder, from the Method list, select the imposition 
method, and then select the template that you want to duplicate.

2. Click Duplicate .

A copy of the template is created, with the word, “Copy” at the end of the file 
name.

Note:  Templates created in Ultimate software cannot be imported or used 
in the CX Print Server. They must be created using the Imposition Template 
Builder.
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3. To change the file name of the copy, use the Rename command. (See the 
following procedure.)

To rename a template:

1. In the Imposition Template Builder, from the Method list, select the imposition 
method, and then select the template that you want to rename.

2. Click Rename .

3. Delete the old name.

4. Type the new name, and press ENTER.

To edit template settings:

1. In the Imposition Template Builder, from the Method list, select the imposition 
method, and then select the template that you want to edit.

2. Change the desired settings.

3. Click Save.

To delete a template:

1. In the Imposition Template Builder, from the Method list, select the imposition 
method, and then select the template that you want to delete.

2. Click Delete .

3. Confirm that you want to delete the selected template.

High-Resolution Workflow
Working with high-resolution files during the design and page layout process can 
often times be long and inefficient. Processing and manipulating large files and 
graphics can be very time consuming. To speed up production, it is common to work 
with low-resolution files until the RIPing stage.

The CX Print Server provides Creo APR (Automatic Picture Replacement) and 
supports Open Prepress Interface (OPI) image replacement workflows for replacing 
low-resolution files with high-resolution files during the RIP. 
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Creo APR
Creo APR is an image replacement method for PostScript files. Creo APR is a 
standardized set of file instructions that specify how an external high-resolution 
image is placed in a PostScript file as it goes to RIP. The instructions specify the type, 
size, position, rotation, cropping and location of the high-resolution images 
themselves. 

When you send your PostScript file to be processed, the CX Print Server checks it for 
Creo APR instructions. It then searches for the external high-resolution file, 
performs the specified image replacement and RIPs the PostScript file.

For more information on setting the APR settings, see The Services Tab on page 203.

OPI
Like Creo APR, OPI is a standardized set of file instructions that specify how an 
external high-resolution image is placed in a PostScript file as it goes to RIP. The 
instructions specify the type, size, position, rotation, cropping and location of the 
high-resolution images themselves. 

When you send your PostScript file to be processed, the CX Print Server checks it for 
OPI instructions. It then searches for the external high-resolution file, performs the 
specified image replacement, and RIPs the PostScript file.

Many OPI systems use remote storage of high-resolution files. The CX Print Server 
supports the storage and replacement of high-resolution OPI files internally. 

High-Resolution Image File, 5.23 MB Low-Resolution Image File, 306 KB

Note:  PDL files from some DTP software (such as QuarkXPress) may contain 
these instructions (“comments”) by default, even though the high-resolution 
files are unavailable because they have been embedded in the job. In this case, 
the job is not processed and an error message appears. To ensure continuous 
printing, the CX Print Server OPI image replacement is then unavailable by 
default.
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To select OPI support:

1. From the Tools menu, select Settings.

The Settings window appears.

2. Under Preferences, select General Defaults.

3. In the OPI area, select Enable OPI Spire Support.

Creo APR and OPI File Formats
Creo APR and OPI function identically on the CX Print Server. Creo APR low-
resolution files have an *.eps extension in Windows and an *.e extension on the 
Macintosh, while OPI low-resolution files have a *.lay extension. The Creo APR and 
OPI workflows support Creo Continuous Tone, EPSF, Jpeg, PDF, DCS1, DCS2 and 
TIFF high-resolution file formats. You can use either the Creo APR or OPI workflow, 
depending on your high-resolution file type.

Preparing to Print Using Creo APR or OPI
1. Create low-resolution files from high-resolution files.

Note:  When the Enable OPI Spire Support option is selected, the 
Support Helios Server check box is automatically selected by default. If 
you do not want Helios server support, clear this check box.

Note:  You can use the PS Image Exporter Plug-In in Adobe Photoshop® to 
create Photoshop Image (APR low-resolution) files. You can install the PS 
Image Exporter Plug-In from the CX Print Server Documentation and Utilities 
CD-ROM.
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2. Export each image file as a low-resolution *.e file—for example, a file called 
duck is exported as duck.e.

OPI images can be created in other software or can be provided by a print 
service bureau. Make sure that you have created or obtained the desired image 
files.

3. When you design the document in DTP software, use low-resolution files.

4. Perform detailed graphic work on the original high-resolution file. Only use the 
low-resolution file for positioning, rotating, scaling and cropping. 

5. Place the high-resolution files in a defined path on the CX Print Server. The CX 
Print Server looks for this path when it RIPs your jobs. Define the high-
resolution path through the Job Parameters window for each job.

Printing with Creo APR or OPI
If your high-resolution files are located in the CX Print Server default folder 
(D:\Shared\HighRes), you can print APR or OPI jobs without adjusting APR 
settings. 

Perform the following steps:

1. Print, download, or import the job from the client workstation to the CX Print 
Server Storage window.

The job is processed according to the settings of the selected virtual printer 
using APR or OPI high-resolution files.

2. Double-click the job in the CX Print Server workspace.

Notes:

• A PostScript image (*.e) file is a low-resolution preview of the original 
high-resolution file. It contains preview information saved at 72dpi in 
black and white or color. Also, it contains pointers to the location of the 
high-resolution Image.

• APR low-resolution files have a. “*.e” extension on the Macintosh and 
an “*.eps” extension in Windows. OPI low-resolution files have a 
“*.lay” extension. 

Note:  Once you create the low-resolution file, do not change the name of 
the high-resolution file. This is the file name for which the CX Print Server 
searches.

Notes:

• The CX Print Server default HiRes folder used for APR and 
OPI is D:\Shared\HiRes.

• Paths other than the default path are defined on a per-job basis. You 
can define the APR path to any connected server or disk.

Important:  OPI support is unavailable by default. If you would like to select 
the Spire OPI support, see To select OPI support: on page 82.

Note:  If your high-resolution files are not located in the CX Print Server 
default folder, specify the APR path(s), see Setting a High-Resolution Path on 
page 205.
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3. Select the Print Quality tab in the Job Parameters window.

4. Adjust the job parameters.

5. Set other high-resolution job parameters as desired. 

6. Click Submit. 

The job is processed on the CX Print Server and sent to the DocuColor 8000AP 
for printing.

PDF Workflow
When you print PDF jobs with repeated elements, you can decrease processing time 
significantly if you apply the PDF workflow.

The PDF workflow caches the repeated elements in the PDF once, and reuses them 
as many times as needed without repeated processing.

For more information on PDF optimization, see The Services Tab on page 203.

To distill a PostScript file on the CX Print Server:

1. In your client workstation, copy the desired PostScript file.

2. Locate the CX Print Server on the network, and paste the file to D:\Shared.

3. On the CX Print Server station, click the Start button and select Programs > 
Acrobat Distiller.

4. From the File menu, select Preferences.

Note:  If the masking data in the PS Image file defines a completely different 
part of an image than the masking data in the high-resolution file, no 
masking data is used. 
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5. In the Output Options area, verify that Ask for PDF file destination is selected, 
and click Cancel. If this check box is not selected, select it and click OK.

6. From the Settings menu, select Edit Adobe PDF Settings.

7. In the General folder (the default view), verify that Optimize for fast web view 
is selected, and click Cancel. If this check box is not selected, select it and click 
OK.

8. From the File menu, select Open.

The Acrobat Distiller - Open PostScript File dialog box appears.

9. Locate the desired PostScript file, and then click Open.

The Acrobat Distiller - Specify PDF File Name dialog box appears. The default 
file name for the PDF file is the PostScript file name.

10. If desired, change the file name in the File name box.

11. Verify that the file is saved in D:\Shared.
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12. Click Save.

Your file is distilled, and a PDF file is created.

13. In the CX Print Server software, from the Job menu, select Import.

You can import the PDF file for printing.

Export as PDF2Go
PDF2Go is a port through which you can export RTP files, and convert them to a PDF 
file during export.

The CX Print Server is capable of exporting jobs that are standard PDF files after 
processing. For an exported RTP job, the PDF file includes the rasterized data of the 
job.

The operation converts the RTP information to raster files that can be encapsulated 
in a PDF format. This process ensures that the file can be processed and printed on 
any PDF printer. 

While exporting as PDF2Go, a running bullet starts to move from right to left in the 
bottom arrow adjacent to the server-printer animation.

To export as PDF2Go:

1. Right-click a file in the Storage window, and from the menu select Export as 
PDF2Go.

2. Select the Print Optimized option to generate a high-resolution PDF file in 
300dpi. 

The Screen Optimized option (default) generates a low-resolution PDF file in 72 
dpi. 

Tip:  You can create a shortcut to the Acrobat Distiller on the CX Print Server 
desktop. This shortcut can be used to drag files onto the Distiller software for 
quick distilling. To create a shortcut, click the Start button on your Windows 
desktop, and follow the path Programs > Acrobat Distiller. Right-click 
Acrobat Distiller and follow the path Send To > Desktop (create shortcut).

Note:  Except for RTP jobs that were originally VI jobs, you can export every 
type of file.

Tip:  Use the Screen Optimized option when you want to generate a light PDF 
file—for example, a file that you can send as a proof by e-mail.
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3. Click OK.

4. Locate the folder in which to save the file, and then click Export.

The file is saved as a PDF file under the job's name in the selected location.

Note:  When you export PDL files as PDF, the file is converted to PDF using 
the Distiller software. 
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Page Exceptions
A page exception is a paper set that differs from the rest of the paper in a job. For 
example, you can assign a different paper stock for each chapter in a book.

For information about setting page exceptions, see The Exceptions Tab on page 211.

Inserts are blank pages of a selected paper stock that are assigned to a job after a 
specified number of pages. For example, you can choose to add blank pages 
between sections within a brochure.

For more information about paper sets, see Managing Paper Sets on page 44.

Setting Exceptions for Imposed Jobs
You can set different paper sets for special exceptions within a job and also add 
inserts (interleaves) in imposed jobs. You set these exceptions and inserts in the 
Exceptions tab.

If the selected imposition method is Saddle Stitch or Perfect Bound, the exceptions 
are handled at the imposed sheet level (and not on a page level).

You cannot set exceptions or inserts if the selected imposition method is Cut & 
Stack.

Printing on Tabs Using Exceptions
The CX Print Server supports the option to print tabs for both regular page 
exceptions and dynamic page exceptions workflows. This section contains a 
description of the setup steps you need to perform to print on tabbed stock using 
the regular page exceptions workflow.

For information about dynamic page exceptions, see Dynamic Page Exceptions on 
page 99.

File Preparation
This example describes how to print a document using Xerox 5 TAB (multipurpose) 
stock. The tabs are printed on both sides (duplex). The text pages were designed in 
QuarkXPress and the tabs were designed in Word software. 

Notes:

• For the Step & Repeat imposition method, exceptions are handled on a 
page level (same as for non-imposed jobs).

• An imposed sheet contains the multiple images that are all printed on the 
same physical sheet.

Note:  The DocuColor 8000AP also supports the option to print tabs for both 
regular page exceptions and dynamic page exceptions workflows.

Note:  You can modify this procedure to fit your specific tab requirements.
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DocuColor 8000AP Setup
In this example, you can print the PDF file on the following types of stock:

• Text pages on US Letter (8.5 × 11 inches)

• Tabs on tab stock (9 × 11 inches)

Color Calibration
Use the US Letter paper stock to perform calibration, and then you can use this 
paper stock for the entire job.

Loading the Paper Stock
Follow these steps when you load the paper stock: 

• Load the paper as Short Edge Feed for all stocks because the tabbed stock is 
printed on both sides (duplex), and requires straight edges on both right and left 
sides. Load the stock with the tabs pointing to the rear end of the tray.

• Although the Text and Tab media can be different weights, you should set the 
tray controls to 106 - 135 gsm for all media weight. Using the same media 
weight avoids the automatic image quality adjustment that occurs when you 
print on different weight ranges of paper stock.

To load the paper stock:

1. Load the letter paper stock in Tray 1.

Note:  Alternatively, you can use the following paper stock, and adjust the 
settings accordingly:

• Text pages on A4 (210mm × 297mm)

• Tabs on tab stock (223mm × 297mm)
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2. Load the tabbed stock:

a. Place the tabs in Tray 2 in forward collated order—for example, Tab 1 is the 
top tab when the tab sheets are loaded into the printer.

b. Make sure that the stock is loaded as SEF.

c. Select Non-Standard on the left hand side of the tray controls.. 

Notes:

• Load the tab stock in Tray 2. This allows for a straight path from this 
tray onto the imaging belt. You can load other types of stock in any 
other tray without affecting print production.

• Tabs that are duplex printed require that the tab stock be positioned 
so that both the left and right sides of the media are straight sides 
going into the engine.

Note:  Tabs that are simplex printed can be loaded either portrait (LEF) or 
landscape (SEF).

The tab on the
left hand side
is the top tab.

Custom
button
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Access Panel
You program the custom size for any job through the DocuColor 8000AP Access 
Panel.

1. On the Access Panel, press the Access button and enter the password 11111.

2. Navigate to Tools Pathway > Non-Standard Paper Size.

3. Select Tray #2, X=11, Y=9.

4. Exit all the windows and return to the main menu.

Creating Paper Sets
On the CX Print Server, in the Printer Monitor window, you can view the paper types 
that are loaded in the paper tray.

For more information about the Printer Monitor window, see The Printer Monitor on 
page 9.

Access button
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To create paper sets:

1. On the toolbar, click the Resource Center button . 

2. In the Resource list, select Paper Sets.

3. Click Add.

The Paper Set Properties dialog box appears.

4. Set the parameters for the Text stock. 

5. Click OK.

6. Click Add and set the parameters for the Tab stock. 

7. Click OK. 
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Icons in the Paper Sets area provide information about the defined media that is 
available and the print direction of the media.

Printing the Job
The regular (manual) page exception workflow is good for single jobs.

To set the job parameters for a job with two media trays:

1. In the Job Parameters window, click the Print Settings tab and set the following 
parameters:

• Print Method—Duplex head to head

• Delivery—Face Up

• Rotate 180—Yes

2. On the Paper Stock tab do one of the following:

• Set the Paper set name to Text

• Set the following parameters:

• Paper set name—Undefined

• Paper size—SEF Letter

• Weight—106-135 gsm

3. On the Exceptions tab, click the Add button , and use Table 11 to add page 
exceptions:

Note:  If the icon for the Tab and Text media does not reflect the print 
direction you set, you need to review your paper set definitions.

Important:  Before you start this workflow, open the PDF file and note which 
pages are the tab pages.

Table 11: Sample Page Exceptions

Pages Use Paper Set Tray

5 -6 Tab Auto
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4. Set any other job parameters as desired, and then click Submit.

Further Information
The following list provides useful Web sites about printing tabs and templates:

• Templates: Download the Xerox templates from the following Web site:

http://www.xerox.com/go/xrx/template/
Promotions.jsp?view=MP6&active=active&promoID=Laser_Printer_Template
_tabs&Xcntry=USA&Xlang=en_US

• Design Hints: Some good design hints for printing tabs are available on the 
following Web site:

http://www.xerox.com/go/xrx/template/
Promotions.jsp?view=MP6&active=Active&promoID=Printer_Template_Using
_Graphics&Xcntry=USA&Xlang=en_US

• The Speciality Media Guide can be downloaded from the following Web site: 
http://www.xerox.com/

19-20 Tab Auto

31-32 Tab Auto

59-60 Tab Auto

103-104 Tab Auto

Table 11: Sample Page Exceptions

Note:  The tabs are printed on both sides.

http://www.xerox.com/go/xrx/template/Promotions.jsp?view=MP6&active=Active&promoID=Printer_Template_Using_Graphics&Xcntry=USA&Xlang=en_US
http://www.xerox.com/go/xrx/template/Promotions.jsp?view=MP6&active=active&promoID=Laser_Printer_Template_tabs&Xcntry=USA&Xlang=en_US
http://www.xerox-techsupport.com/dc2000/DC6060/DC6060_home.htm
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Printing on Tabs Using the CX Print Server Tabs Plug-In for Acrobat
The CX Print Server Tabs plug-in for Acrobat (version 7.0 or later) enables you to 
create and place tabs in your unprocessed (PDF or PostScript) jobs, manage the tab 
and text attributes, and save a set of attributes for future use.

When using the CX Print Server Tabs plug-in to create tabs, it is not necessary to 
define exceptions on the Exceptions tab.

To create tabs with the Tabs plug-in:

1. In the Storage window, right-click your unprocessed job and select 
Job Preview&Editor.

The job opens in Acrobat software.

2. From the Plug-Ins menu, select Spire Tabs Printing.

The Tabs Printing window opens, displaying the Text Attributes tab.

3. In the Tabs area, set the tab attributes:

a. By default, the tab size for letter jobs is set at 9x11, and for A4 jobs, A4+. To 
change the tab size, select a tab size from the Size list.

b. In the Type list, select the number and type of tabs.

Important:  If you add tabs to your job, you need to select the Mixed paper size 
document check box (in the Job Parameters window, on the Paper Stock tab, 
under Mixed paper size).

Note:  The job must be a PDF or PostScript file.

Tip:  If you want your tabs to be reversed—that is, for the lowest tab to 
be the first one—select one of the reverse tab options.
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c. Select the appropriate orientation of the tab.

d. In the Top Offset box, type a value for the distance between the upper edge 
of the paper and the upper edge of the uppermost tab.

e. In the Bottom Offset box, type a value for the distance between the lower 
edge of the paper and the lower edge of the lowest tab.

f. In the Length box, type the length of the tab.

g. In the Width box, type the width of the tab.

4. In the Text area, set the attributes of the text on the tabs:

a. (Optional) In the Font list, select a font for the text on the tab.

b. (Optional) In the Size list, select a font size for the text on the tab.

c. (Optional) Click the Color button  to change the font color for the text on 
the tab.

d. (Optional) Click Bold  to make the text on the tab bold.

e. (Optional) Click Italic  to make the text on the tab italic.

f. (Optional) Click Underline  to underline the text on the tab.

g. Click the appropriate alignment button as shown in Table 12.

Table 12: Tab alignment buttons

h. (Optional) Under Offset, type offset values in the x and y boxes to adjust 
the offset of text on the tab. The x value moves the text horizontally 
according to the alignment; the y value moves the text vertically.

i. (Optional) Select Wrap text to automatically run the text onto the following 
line when the entire text does not fit on one line.

j. (Optional) Select Text on both sides to have the same text appear on both 
sides of the tab.

k. In the Direction area, select the appropriate direction for the text:

Note:  The units in the Tabs plug-in are set in the Acrobat Preferences 
dialog box.

Portrait Landscape

Align Left

Align Center

Align Right

Note:  The Direction options are available only for portrait jobs.
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5. Click the Content tab.

6. In the Before Page column, click the first cell and type the number of the page 
that you want the tab to precede.

7. In the Text column, type the text for the tab.

The tab appears in the thumbnail area.

8. To add more tabs, repeat steps 6 and 7.
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9. Click Apply to apply the tab settings to your document.

The Tabs Printing window closes, and the tabs that you added become part of 
the document.

10. From the Acrobat File menu, select Save.

11. In the CX Print Server, select the Mixed paper size document check box on the 
Paper Stock tab, under Mixed paper size parameters.

12. Process and print the job.

Managing Tabs in the Tab Printing Window

To change the location of a tab:

In the thumbnail area, click the tab that you want to move, and drag it to the 
desired location.

The tab moves to the selected location, and the tab numbers are updated 
accordingly.

To replace a page with a tab:

1. In the thumbnail area, right-click the page and select Replace with tab page.

The page is deleted from the document and replaced by a new tab.

2. In the table, type the tab text.

To insert a tab before or after a specific page:

In the thumbnail area, right-click the page and select Insert tab before page or 
Insert tab after page.



Dynamic Page Exceptions 99

To remove a page or tab from the document:

In the thumbnail area, right-click the page or tab and select Remove.

Once you have set the tab parameters for a job, you can save the settings. Saved 
settings are useful when you want to print different jobs with the same tab settings.

To save tab settings:

1. In the upper part of the Tabs Printing window, click Save.

2. Type a name for the tab settings.

3. To save the locations and text of the tabs that you created, select the Include 
Tab location and Caption check box.

4. Click Save.

To apply saved settings to a job:

In the Tabs Printing window, select the settings from the Saved Settings list.

The saved settings are applied to the job.

To delete saved settings:

1. In the Tabs Printing window, select the saved settings from the Saved Settings 
list.

2. Click Delete.

The saved settings are deleted.

Dynamic Page Exceptions
Dynamic page exceptions are page exceptions or inserts that you want to include 
within a file, mainly VI jobs or a very large PostScript file.

Standard PostScript setpagedevice commands that specify different paper types are 
embedded into the incoming files and enable you to print complex jobs of varying 
paper size, stocks, and paperweight. These commands indicate that the printer 
must switch media during the printing of a job. When a job is RIPed, the CX Print 
Server identifies the dynamic page exception commands and maps them to the 
selected paper sets. The printer then uses the desired paper sets for the job.

Note:  If you do not select this check box, only the text attribute settings are 
saved.

Tip:  You can modify any of the settings as desired.
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The CX Print Server supports dynamic page exceptions for the following file formats:

• PostScript

• Variable Print Specification

• VIPP

• PDF

Setting the CX Print Server for Dynamic Page Exceptions
To set up the job flow for dynamic page exceptions you need to:

1. Create a file with embedded setpagedevice commands on your client 
workstation.

2. Select Resource Center > Paper Sets and create the paper sets that you need 
to print your file.

3. Create a dedicated virtual printer that supports dynamic page exception 
commands, and then map specific paper sets in the Exceptions tab.

For information about adding a new virtual printer and mapping specific paper 
sets, see Managing Virtual Printers on page 41.

4. Import the file into the CX Print Server via the dedicated virtual printer, and 
submit the job for printing.

When the job is RIPed, the dynamic page exception commands are identified 
and mapped to the selected paper sets. The desired paper sets are used when 
the job is printed.

Tips and Limitations
The following list describes the current limitations for the dynamic page exceptions 
workflow:

• Define all pages in the original file using the dynamic page exceptions 
commands.

• To add inserts, use a dynamic page exceptions command in the file that requires 
a paper stock but will not print anything on it. If a job is duplex, make sure that 
you use the command twice.

• Virtual printers that support dynamic page exceptions should not be used for 
other jobs. 

• Virtual printers that support dynamic page exceptions do not support regular 
page exceptions and imposition. In addition, the paper stock selection is limited 
to the assigned stocks and not the entire database.

Notes:

• If a job is printed using a dynamic page exceptions virtual printer, the 
Imposition tab in the Job Parameters window is unavailable.

• Once you import your file via the dedicated virtual printer (if the virtual 
printer is either a ProcessStore or SpoolStore virtual printer), you can 
perform a preflight check before the job is sent to print. For more 
information, see Preflight on page 103.
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For information about defining the paper feed direction, see The Paper Stock Tab on 
page 188.

Fonts
This section explains how to work in the Fonts area of the Resource Center. 

In addition, this section explains how to download fonts onto your Windows PC or 
Macintosh client workstation.

Managing Fonts

1. On the toolbar, click the Resource Center button . 

2. In the Resource list, select Fonts.

3. Choose a Font Library option. The default option is Latin.

4. To set the default font, select a font from the list, and click Set as Default.

5. To delete a font, select the font, and click Delete font.

To add fonts to the CX Print Server:

Copy the new fonts to the C:\CX8000AP\General\RIP\Font folder.

Downloading Fonts Onto Your CX Print Server

Windows PC Client
Drag the new fonts to the HF_Fontdownloader Hot Folder.

The hot folder is located with the other hot folders on your client workstation.

Note:  You can substitute fonts. For more information, see Substituting Fonts 
on page 204.
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For more information about hot folders, see Using Hot Folders on page 59.

Macintosh
Drag the new fonts to the HF_Fontdownloader Hot Folder.

Graphic Arts Workflow
This section describes the workflow for printing Graphic Art Port (GAP) files.

The GAP is a port through which you can import various file formats used in the 
graphic arts industry. GAP files are already rasterized. The CX Print Server only 
needs to prepare the files for printing, which means adjusting the file resolution and 
rotation. 

Importing GAP Files
To print a specific page, import the assigned file for the specific page. To print a 
specific job, import the assigned file for the specific job. 

Supporting GAP Files
The CX Print Server can import and convert the following file types:

• Brisque jobs

• TIFF

• TIFF/IT

• CT / LW

Note:  When the assigned job file is imported, it is converted to a PDF file and 
appears in the CX Print Server queues. The PDF file can be configured and 
printed as any other PDF file. 

Note:  The CX Print Server supports the following GAP file formats: pre-
separated and composite.
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The system converts these file types to pre-rasterized PDF files. GAP PDF files 
behave the same as any other PDF file and have the same job parameters.

GAP File Structure

TIFF/IT
A TIFF/IT file has three components:

• CT.TIF

• LW.TIF

• FP (final page) file, which combines CT.TIF and LW.TIF

To import a TIFF/IT file to the CX Print Server, first import the FP file. During import, 
the file is converted to a PDF file, and appears in the CX Print Server queues. The 
PDF file can be configured and printed as any other PDF file.

CT, LW, TIFF
Brisque jobs and TIFF/IT files include CT, LW and TIFF files that can be imported and 
printed separately to the CX Print Server.

Rasterized Brisque Jobs
All rasterized Brisque jobs share a common structure. Each job contains an assigned 
file with one or more pages (in case of a multiple job). Also, every page contains its 
own assigned file, which combines LW and CT.

• To import a Brisque job to the CX Print Server, import the assigned file of the job.

• To print a specific page, import the assigned file of the specific page.

Preflight
The following preflight features are available:

• PDF analyzer

• Preflight check

• Preflight report

Analyzing a PDF Job
You can use the PDF analyzer to check imported PDF files for problems that may 
affect processing. The PDF analyzer checks the following elements:

Note:  Make sure that in the CX Print Server Import window, Gap files is 
selected in the Files of type box.

Note:  You cannot use the PDF analyzer or perform a Preflight check on PDF 
files that are locked or protected. If you do, a message will appear stating that 
the file is encrypted.
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• Document: identifies incompatibilities of Acrobat software with compression, 
encryption, security, and other properties

• Pages: detects empty pages and identifies the page size, annotations, and other 
properties

• Fonts: determines whether specific fonts are in the PDF file and whether they 
are embedded

• Colors: detects color space information, spot colors, rendering information, and 
color management settings

• Images: identifies image resolution, whether images are skewed or flipped, and 
whether images are compressed

• OPI: detects whether OPI is used. If so, the PDF analyzer detects the OPI version 
and determines whether any high-resolution images in the OPI path are missing

• Text and line art: identifies the size of text, the width of the lines, white text, and 
objects and flatness tolerance

• PDF/X: determines whether the file conforms to PDF/X-1a or to PDF/X-3 and 
whether the file contains PostScript fragments

To run the PDF analyzer:

1. In the Storage folder, right-click the PDF file, and select PDF analyzer.

2. In the PDF PreFlight Settings area, do one of the following actions:

• To check the entire PDF file, select Complete Document.

• To check specific pages, select Pages and enter the desired page range.

3. If you do not want the report to automatically open when it is generated, clear 
Display report automatically.

4. If desired, change the report file name. By default, the report file name consists 
of the original file name and the suffix _rep—for example, if the file to be 
checked is sample.pdf, the report file is named sample_rep.pdf.

5. If you want to save the report to a specific location, click Browse and navigate 
to the desired location.

6. Click Run.

The PDF report is generated and opens automatically.
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Preflight Check

The Preflight parameter enables you to check the status of key job components 
before the job is sent for printing. 

During the preflight check, your job is RIPed and the missing components are 
identified. The preflight check detects the status of the following key job 
components:

• High-resolution images or the wrong links to the high-resolution images folder

• Missing fonts

• Spot colors that are not defined in the CX Print Server spot color dictionary

• Dynamic exception commands for a file that was submitted via a dynamic page 
exceptions virtual printer

The results of the preflight check are displayed in a Preflight Report. By default, a 
preflight report is not issued for each job. To issue this report, you must run a 
preflight check for the job using the Preflight job parameter.

To run a preflight check:

In the Preflight options area, select Run Preflight check.

All four check boxes of the key job components are active, but you can clear any 
check box that you don’t want to include in the preflight check. 

Note:  You must select the preflight options before the job is processed, but you 
can only view the preflight report after the job is processed.

Note:   If a job component is missing, the job fails before it is RIPed (an alert 
message appears) and information about missing components appears in the 
Job History window.

Note:  If one of the selected elements in the list is missing, the job status at 
the end of the preflight check is failed and the job is transferred to the 
Storage window.
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Preflight Report
The preflight report is a job-related report that provides information about the 
status (missing or found) of key job components prior to printing and enables you to 
correct your files accordingly.

It is especially useful to run the preflight check before you print a complex job with 
a large quantity of pages or copies. The preflight check detects the missing job 
components and displays them in the Preflight Report dialog box. You can review the 
report and resolve the missing components and thus save processing time without 
error or failed messages constantly appearing.

If you run a preflight check and all key components are found, the job is processed 
and printed according to the job flow that you selected. If the test fails (missing key 
elements are detected), the job is returned to the Storage window with the preflight 
report available for inspection.

The preflight report always reflects the last preflight run. If more than one preflight 
check is run on a job, the latest preflight report overrides the previous. When a 
preflight report is produced, the date and time of the preflight check are indicated in 
the Jobs History window.

To view the preflight report:

1. Right-click the job in the Storage window, and from the menu select Preflight 
Report.

The Preflight Report dialog box appears. If you selected the HiRes files option in 
the Preflight Options area, the HiRes Report appears first.

If there are key components in the job not found, this will be indicated by the 
missing indicator  next to the HiRes, Spot Colors, and Fonts report options.

Note:  Since the Preflight Report dialog box lists all key job components 
(missing and found), you can use this report to view the existing (found) key job 
components—for example, the list of the existing fonts in a job, and their 
corresponding paths.
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If you did not select a preflight option for the preflight check, the not preflighted 

indicator  appears next to the report option. 

If all of the files are found for a preflight option, the found indicator  appears 
next to the report option.

2. From the Show list, select one of the following options:

• To display all files, select All.

• To display only files that were found, select Found Only.

• To display only the missing files, select All Missing.

3. Select the Spot Colors report option.

The Spot Colors Report area displays the missing spot color names (spot colors 
which were not found in the spot color dictionary) and the found spot color 
names (spot colors which were found in the spot color dictionary). The C,M,Y,K 
columns display the spot color CMYK equivalences:

• If the status is missing, the CX Print Server uses the original CMYK values 
that are embedded in the PS file to emulate the desired spot color.

• If the status is found, the CX Print Server uses the CMYK values that are in 
the spot color dictionary.

4. Click the Fonts report option.
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The Font Report area displays the name of the missing fonts that are not 
embedded in the file and that do not exist in the Font Library, as well as the 
found fonts.

The Source column indicates whether the font is embedded in the file or was 
found in the Font Library.

5. Click the Exceptions report option.

The SPD (dynamic exceptions) area displays the dynamic page exception 
commands found in the file.

For more information about dynamic page exceptions, see Dynamic Page Exceptions 
on page 99.

6. To save the preflight report, click Save and browse to the desired location.

7. To print the report, click Print.

Tip:  If more than one preflight check is run on a job, the latest preflight 
report overrides the previous. You can save the report for future use.
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Calibration
One of the most important issues in obtaining satisfactory print quality is steady 
toner density. Toner density is affected by many factors such as heat, humidity and 
service settings. You should perform a daily calibration to compensate for these 
factors. 

The calibration process corrects the printer colors by measuring their density and 
creating calibration look-up tables. The CX Print Server uses the data in these tables 
to compensate for the differences between the actual, measured density level and 
the target level, the target density.

You should perform calibration in the following instances:

• When you use a new paper stock

• When you use a different screening method

• At least once during every eight-hour shift for every combination of paper stock 
and screening method used

• When prints show color casts

• After machine maintenance or hardware changes—for example, replacing a 
charge coroton

• When drastic ambient changes (temperature and humidity) occur

The GretagMacbeth® Eye-One® Spectrophotometer calibration device is used to 
calibrate the DocuColor 8000AP.

Guidelines for Successful Calibration
To make your calibration as accurate as possible, follow these guidelines before you 
calibrate:

1. Ensure that your calibration device is connected properly.

2. Ensure that your calibration device is calibrated. You should calibrate the device 
at least once a week or whenever the power to the device is interrupted.

3. To warm up the printer, use any media to print at least 25 duplex sheets of any 
four-color test job.

4. Set the CX Print Server emulation method to the method that you will use to 
print the customer job (CSA or DeviceLink).

5. Print a reference job, and use the same media and screen type on which you will 
print the final job. 

Important:  Perform a different calibration for every combination of media and 
screen type that you are going to use for printing. When calibrating, always use 
the same media that you intend to use for printing.

Tip:  You can set a reminder to remind you to calibrate the DocuColor 8000AP. 
For more information, see Calibration Reminder on page 169.
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6. Prepare the calibration pad to measure the calibration charts. If a calibration 
pad is not available, set a white media, at least 200 gsm, or two sheets of 
lighter paper, on the surface. Read the calibration chart on this surface.

The Calibration Process
The calibration process consists of the following steps (explained in detail in the 
next few sections):

1. Calibrate the calibration device.

2. Set the calibration method.

3. Load the paper set that you are going to use for printing in the DocuColor 
8000AP.

4. In the CX Print Server, from the Tools menu, select Calibration.

5. Click Calibrate to run the Color Calibration Wizard, and to create a calibration 
table.

6. Follow the Color Calibration Wizard steps.

7. Measure the calibration chart.

8. When the calibration is complete, print the job using the calibration table.

Preparing the Calibration Device for Calibrating Your Printer
The Eye-One spectrophotometer is a high-speed color measurement instrument 
that reports densitometer and dot data.

Perform the following steps before using your calibration device for the first time:

1. Familiarize yourself with the Operator’s Manual. 

2. Connect the device.

3. Calibrate the device.

Connecting the Eye-One Spectrophotometer to the CX Print 
Server
1. Connect one end of the Eye-One spectrophotometer cable to the CX Print 

Server USB 2 (USB port). 

2. Connect the other end of the spectrophotometer cable to the 
spectrophotometer.

Note:  Make sure that you set the screen type to the one that you are going to 
use to print the job—for example, 200 dot.

Tip:  Including the specific paper name and screen method in the calibration 
table file name helps you identify the appropriate calibration table in the job 
setup.

You can also use the Device Tutorial to learn how to use the device 
correctly. To access the tutorial, select Tools > Calibration, and then click 
Calibrate. In Step 1 of the Color Calibration wizard, click Device Tutorial - 
Click & Learn.
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Calibration Procedure
To calibrate the Eye-One spectrophotometer, place the spectrophotometer on 
the plate.

Calibrating the CX Print Server

Setting the Color Calibration Method
The CX Print Server provides you with two color calibration methods:

• Target Calibration

This calibration method enables you to calibrate the DocuColor 8000AP 
according to the following fixed, predefined density values

Table 13: Fixed density values for uncoated paper

Table 14: Fixed density values for coated paper

The target calibration method ensures that the density values of the printed 
output do not exceed the predefined density values. The purpose of this color 
calibration method is to ensure consistency over time. 

• Auto Adjusted Calibration

This calibration method enables you to calibrate the DocuColor 8000AP 
according to the printer’s performance capabilities.

With this method, you can set the maximum density of the printed output by 
selecting the desired percentage level. The higher the percentage, the greater the 
density of the printed color.
The purpose of this method is to achieve optimal color intensity for a specific 
printer at a certain point in time.

The default setting for the color calibration method of the CX Print Server is target 
calibration. You can change the setting, if necessary, before calibrating the CX Print 
Server.

Toner Density value

Cyan 1.75

Magenta 1.34

Yellow 0.868

Black 1.65

Toner Density value

Cyan 1.9

Magenta 1.45

Yellow 0.913

Black 1.75
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To specify the calibration method:

1. In the Settings window, select Preferences > Color.

2. In the Calibration Method area, select the desired calibration method, Target 
or Auto Adjusted.

3. If you selected Auto Adjusted and you would like to change the default 
settings, click Advanced.

The Auto Adjusted window appears.

4. Change the Percent of Printer Max Setup density if desired, by moving the 
slider, or by typing a percentage value in the corresponding box.

5. Click Save.

The Calibration Window
The Calibration window enables you to create and edit calibration tables. You can 
use the Color Calibration Wizard to create a calibration table, or edit an existing 
calibration table. 

Note:  The default percentage value is 85%.

Important:  Changes to the calibration method during RIP will not take effect. 
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The Color Calibration Wizard analyzes the measurements and creates calibration 
tables. Using these tables, the CX Print Server compensates for the difference 
between the printer’s performance and the required values.

The following calibration look-up tables are provided: 

• None: Applies no calibration table to the job.

• SpireNormal: Applies the factory default calibration table. Since this is a default 
look-up table, it cannot be overwritten. 

• SpireSaturated: Applies the factory default saturated calibration table. This 
look-up table applies a darker calibration table in comparison to the 
SpireNormal look-up table. Since this look-up table is a default table, it cannot 
be overwritten. 

• Normal: Initially the Normal look-up table is identical to the SpireNormal look-
up table. This resemblance changes as soon as you calibrate your CX Print 
Server and, at the end of the calibration process, save your calibration table as 
default. Your calibration table is saved as the Normal look-up table. 

• Saturated: Initially the Saturated look-up table is identical to the SpireSaturated 
look-up table. This resemblance changes as soon as you calibrate your CX Print 
Server and, at the end of the calibration process, save your calibration table as 
default. Your calibration table is saved as the Saturated look-up table. 

To open the Calibration window:

1. From the Tools menu, select Calibration.

The Edit Calibration window appears.

Note:  Each time you save a calibration table as default, it is saved twice, 
once as Normal look-up table, and once as the Saturated look-up table.
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The following options are available:

• Click Calibrate to run the Color Calibration Wizard. This wizard guides you in 
the use of the calibration device to create calibration tables.

• Select a calibration table from the Calibration Name list and select one of the 
following options: 

Click Edit  to edit the calibration table. See Editing Calibration Tables on 
page 118.

Click Delete  to delete the calibration table.

Click Info  for the Density Graph. See Reading Color Density Data on 
page 121.

Click Close to end a test job and close the Calibration window.

Creating a Calibration Table
1. In the CX Print Server software, from the Tools menu, select Calibration.

2. In the Calibration window, click Calibrate.

The Calibration Wizard window appears.

The first step in the wizard is Print Calibration Chart. This step enables you to 
detect the point where you start to see toner on the paper. 

3. In the Tray list, select the desired input tray.

The default tray setting is Auto. When this option is selected, the wizard looks 
for a tray that contains Letter LEF or A4 LEF paper. If the wizard does not find a 
tray with either of these sizes, an alert appears.

You can print calibration charts on any size paper. Ensure that the desired paper 
is in one of the trays, and then select that tray in the wizard.

4. In the Screening Method list, select the desired screening method.

Note:  Make sure you set the screening method to the one you are going to 
use to print the job.
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5. In the Paper Weight list, select the desired paper weight.

6. In the Paper Coating list, select the desired paper coating.

7. Set the number of copies you need by typing the number or using the arrows 
next to the box to select the number.

8. Click Print.

The Image Density Calibration chart is printed.  

9. Collect the chart(s) from the printer.

Step 2 of the Color Calibration Wizard appears. In this step, you scan the Image 
Density Calibration chart so that the wizard can measure each separation and 
find the point at which the toner appears on the paper.

If you selected Automatic as the Screening Method option in step 1 of the 
wizard, you need to calibrate the CX Print Server using two charts. In such cases, 
step 2 of the Calibration Wizard appears as follows:

Note:  Since the performance of the DocuColor 8000AP is best after 
several pages have been printed, it is recommended that you print at least 
10 copies of the first calibration chart and use one of the last copies printed.

Note:  If you selected Automatic as the Screening Method option in step 
1 of the wizard, the DocuColor 8000AP prints two charts, the Image 
Density Calibration chart and the Text/Line Art Density Calibration chart.
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10. On the Eye-One spectrophotometer, press the button on the side, and align the 
head with the cyan arrow’s tip. The arrow is to the left of the cyan column on 
the Image Density Calibration chart. Its tip intersects the semi-dotted line.

11. Sweep the Eye-One spectrophotometer across the cyan column.

A check mark appears next to the cyan icon, and instructions appear for the 
next sweep, this time for the magenta column. 

12. After each color sweep, wait for the check mark to appear next to the 
appropriate icon and follow the instructions as listed.

When all of the separation columns have been successfully scanned, a check 
mark appears next to all the icons.

Step 3 of the Color Calibration Wizard appears. 

Note:  Ensure that the separation columns on the chart are scanned in the 
order in which they appear in the Calibration Wizard: Cyan > Magenta > 
Yellow > Black.

Notes:

• If at any stage the scanning has not been completed properly, click 
Reset and scan again.

• If an error occurs while you are scanning the chart, an alert message 
appears. Click OK and re-scan the charts.

• If you selected Automatic as the Screening Method in Step 1 of the 
wizard, repeat steps 10-12 for the Text/Line Art chart.
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13. Select Save as and select the desired name for the calibration table. Do one of 
the following: 

• Type your own or select one from the list.

• Select As default table (Normal) to save the calibration table as Normal. 

14. Click Finish. 

Regardless of the option you chose, two calibration tables are saved:

• Normal: A table that maintains the gray balance throughout the range of 
colors in the print job file

• Saturated: A table that is the same as the normal table for 80% of the color 
range but from that point on, each color has a greater density. You can use 
this table when you need dark colors that are more intense than in the 
normal table.

For example, if you name your Normal calibration table Tuesday23, the 
Saturated table is automatically named Tuesday23sat.

Editing Calibration Tables
You can review a calibration table to make sure that the curves are relatively smooth 
and continuous. If you are not satisfied with the results, the Edit option enables you 
to adjust the values of the image in the value table.

Note:  Each time you save a calibration table as default, it is saved twice, 
once as Normal look up table, and once as the Saturated look up table. The 
CX Print Server automatically overwrites the existing Normal and 
Saturated calibration tables.

Tip:  It is strongly recommended that you include the specific paper name and 
screen method in the calibration table file name. This helps you select the 
correct calibration table in the job setup.
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To edit a calibration table:

1. From the Tools menu, select Calibration.

2. In the Calibration Name box, select a calibration table, and then click Edit .

The Edit Calibration window appears.

The Edit Calibration window includes the following:

• Screen—If you selected Automatic as the screening method, you can view two 
calibration tables, CT or LW. In the Screen list, select the table you want to view.

• Separation—The graph displays cyan, magenta, yellow, and black separations. 
You can see information about each separation by selecting it from the list. 

• Calibration Graph—The graph shows the values from your calibration table.

The horizontal axis represents the dot percentage values of the RTP file. The 
vertical axis represents the dot percentage values of the final output data (after 
applying the calibration table) that is sent to the printer. 

During printing, the CX Print Server automatically replaces the CMYK values in 
the RTP file with new values that compensate for the printer’s current 
performance level.

The graph displays cyan, magenta, yellow, and black separations. You can view 
detailed information about each separation by clicking its button. To view the 
information for all the separations together, click the button that shows all four 

colors .

• Value Table

You can change the separation values by adjusting the File Value and Printer 
Value settings. The table displays some of the dot percentage values shown in 
the graph. You can add, edit, or delete entries in the table. Your changes will be 
displayed immediately in the calibration graph.
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To add an entry to the value table:

1. Highlight a row in the value table. The new entry row will appear below this row.

2. Click Add Entry . 

The Add Entry dialog box appears.

3. From the File Value and Printer Value lists, select the desired values.

4. Click OK. 

The value table is updated, and the calibration graph is adjusted.

To delete an entry from the value table:

1. In the value table, highlight the entry to be deleted.

2. Click Delete Entry .

The entry is removed. 

Organizing Calibration Tables
You can use the Save and Save As functions to organize your calibration tables.

To save an existing calibration table:

1. In the Edit Calibration dialog box, adjust calibration table values and parameters 
as desired.

2. Click Save.

The edited calibration table is saved with its original name.

To save a new calibration table:

1. In the Edit Calibration dialog box, adjust calibration table values and parameters 
as desired.

2. Click Save As. 

The Save As dialog box appears.

Note:  When you click Save, new calibration settings override previous 
calibration table settings.
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3. In the File Name box, type the new calibration table name.

4. Click OK. 

The calibration table is saved with the new name. 

5. Click Close to exit the Edit Calibration dialog box.

Backing Up Calibration Tables
1. Locate the ColorCalibrationDB folder, following the path 

C:\CX8000AP\General\ColorCalibration\ColorCalibrationDB.

2. Open the ColorCalibrationDB folder.

3. Copy the desired calibration table files to your backup location. 

Reading Color Density Data

To view the Density Graph:

1. In the Calibration window, from the Calibration Name list, select the table for 
which you want to receive detailed color information.

2. Click Info . 

The Density Graph appears. The Density Graph gives you detailed information 
about the saved calibration tables.

Note:  You can’t overwrite the default calibration tables, SpireNormal and 
SpireSaturated.

Note:  To edit a calibration table, select Tools > Calibration > Edit. To view 
information about a calibration table, select Tools > Calibration > Info.
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The Density Graph contains the following data:

• Calibration name

• Measured D-Max values for each separation

• Target D-Max values for each separation 

• Minimum accepted density values for each separation (Xerox values) 

• View options: filtering by color - select which colors are shown/hidden

• Calibration curves (target and measured) for each separation

Target is displayed as bold lines

Measured is displayed as thin lines

• Index - emphasizes the difference between target lines and measured lines

• Properties: paperweight, screening, paper coating 

Printing the Job with the Calibration Table
Now that you have calibrated the paper you are going to use for printing, you can 
select the calibration table to print any job on the same paper stock using the same 
screen type. You can print the reference job you printed before with the new 
calibration table to evaluate the calibration results.

Note:  When the density of the DocuColor 8000AP is lower than 80% of 
the target density, the following message appears: 
“Attention: Below standard D-Max value(s) measured for <cyan, 
magenta, yellow, black>. Standard (Minimum): <C - 1.5>, <M - 1.4>, 
<Y - 0.9>, <K - 1.5>
Measured: <C - >, <M - >, <Y - >, <K - >”.
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To print the reference job:

1. In the CX Print Server workspace, suspend the Process Queue.

2. Import the job.

3. Double-click the job to open the Job Parameters window.

4. In the Paper Stock tab, select the desired paper stock.

5. On the Color tab, select the calibration you created for the particular stock from 
which you printed.

For more information about the Color tab, see Default Color Flow on page 123.

6. In the Color tab, select the screening method you used for the selected 
calibration.

7. Set all other desired parameters, and then click Save to close the Job 
Parameters window.

8. Activate the Process Queue and Print Queue, and inspect the printed job.

If you see that the print out has any color imperfection, review the job parameter 
settings and make changes if necessary. If there are still color imperfections, 
perform machine maintenance and repeat the calibration process.

Default Color Flow
Color job parameters are located on the Color tab in the Job Parameters window. 
The Color tab provides you with tone compression tools such as brightness, 
contrast, and gradation, as well as color tools, including rendering intent, ink saving, 
and RGB and CMYK Workflow. In addition, you can select various screening 
methods for your job.

The tone compression tools and screening methods—Gradation, Brightness, 
Contrast, and Calibration—can be applied to your RTP jobs without requiring the 
CX Print Server to re-RIP the jobs. The color tools—Destination, Rendering Intent, 
Emulation, RGB Workflow, and Spot Color Editor—should be applied prior to initial 
RIPing or your job will need to be re-RIPed. 

The CX Print Server supports the following color formats:

• RGB

• CMYK

• L*a*b* color space

• Spot color

• Grayscale

• Duotone

To submit jobs for color adjustment:

1. Import the job to the CX Print Server workspace.

2. Double-click the job in the Storage window.
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3. Select the Color tab in the Job Parameters window.

The Color tab enables you to apply last-minute color corrections, or to set the 
output job to match other output devices.

4. Adjust the desired color parameters. See the relevant parameter in the Color 
tab.

5. Click Submit to send your job to print. 

The job is processed on the CX Print Server and sent to the DocuColor 8000AP 
for printing.

For more information about submitting jobs to the CX Print Server, see Importing and 
Printing Jobs on page 22.

Color Tools

Profile Manager
The Profile Manager enables you to import and delete source and destination ICC 
profiles, and map destination profiles to specific paper colors.

Source profiles are used to emulate other devices, or color spaces. You can import 
source CMYK or RGB profiles. To use a profile in a job, in the Job Parameters 
window, select Color > RGB workflow or Color > CMYK workflow > Emulation, 
depending on the profile you imported. 

For more information about selecting a source profile in a job, see RGB Workflow on 
page 193 and CMYK Workflow on page 193.

Destination profiles define the color space of your printer and are based on the 
combinations of paper and toner that you are using. For different paper stocks, you 
need different destination profiles. Each custom destination profile will be used with 
coated and uncoated paper. To use a different destination profile in a job, in the Job 
Parameters window, select Color > Destination profile.

For more information about selecting a destination profile in a job, see Destination 
Profile on page 194.

After you import a destination profile, you can use the Media Color Mapping dialog 
box to map the profile to a paper color. The profile is linked to the paper color and the 
CX Print Server will automatically select the correct profile for your job. This is 
useful—for example, in jobs that have mixed paper types. Select Linked from Color 
> Destination profile.

To import a source ICC profile:

1. On the toolbar, click Resource Center . 

The Resource Center opens.

Note:  You can also use a virtual printer to adjust job parameters.

Note:  Custom source RGB profiles are not available in the CSA emulation 
mode.
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2. In the Resource list, select Profile Manager.

The Source Profile tab appears and the predefined source ICC profiles are 
displayed.

3. Click Import .

The Import Source ICC Profile dialog box appears.

4. In the Source profile area, click browse . Locate and select the desired 
source profile, and then click Open.

The new emulation name is displayed in the Emulation name box; you can 
change the name if you want.

5. Click Import.

The new source ICC profile is added to the Emulation (Device Link) list in the 
Job Parameters window, to either the CMYK Workflow parameter or the RGB 
workflow parameter. 

To import a destination ICC profile:

For more information on destination profiles, see Destination Profile on page 194.

1. In the Resource Center > Profile Manager, select the Destination Profile tab.

The predefined ICC profiles are displayed.
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2. Click Import .

The Import Destination ICC Profile dialog box appears.

3. In the Destination profile area, click browse . Locate the desired source 
profile, and then click Open.

The new emulation name is displayed in the Emulation name box; if you would 
like to change the name you may do so.

4. Click Import.

5. If you would like to set the imported destination as your default, select it and 
click Make Default.

6. To map ICC profiles to specific paper colors:

a. Click Color Mapping.

The Media Color Mapping window appears.
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b. In the Profile column, select the desired profile for each paper color.

c. To add a new paper color, click Import .

d. In the Add New Color box, type the name of the new color and click OK.

e. To delete a paper color, select the desired paper color and click delete .

f. In the message that appears, click OK.

g. In the Media Color Mapping dialog box, click Close.

To delete an ICC Profile:

1. In the Resource Center > Profile Manager, select the profile you would like to 
delete.

2. Click delete .

The profile is deleted from the profile list.

Spot Color Editor
You can use the Spot Color Editor to edit colors in the spot color dictionary and to 
define specific RGB or CYMK colors that you want to protect.

Editing the Spot Color Dictionary
Individual job pages can contain RGB, CMYK, and spot color elements. The CX Print 
Server Spot Color Editor enables you to edit the CMYK values of every spot color in 
the Spot dictionary. You can edit these values without affecting the CT or LW page 

Note:  If you don’t map a destination profile to a paper color, the CX 
Print Server uses the default profile, which is for white paper.

Note:  You cannot delete predefined ICC profiles.
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elements. The Spot Color Editor also enables you to create custom spot colors and 
to define fixed CMYK values for those spot colors. The CX Print Server supports HKS 
and PANTONE 2000 spot colors.

To edit a PANTONE color:

1. From the Tools menu, select Spot Color Editor.

The Spot Color Editor window opens on the Spot Editor tab, with the CX Print 
Server's entire collection of colors listed.

2. To find the color that you want to edit, do one of the following:

• Under Color, search for a particular color.

• Alternatively, from the Spot dictionary list, select the color dictionary that 
contains the color that you want to edit.

3. Select the desired spot color. 

The CMYK values for that spot color and a color preview appear in the right-
hand side of the Spot Color Editor window.

4. Change the CMYK values as desired.

Note:  Spot colors—for example PANTONE—are not affected by CMYK 
emulation. A spot color has the same appearance with any selected CMYK 
emulation.

Note:  When you are searching for a color, you can type the first letter of 
the first word in the search box. For example, if you are searching for Cool 
Gray 4 and type c, the mouse pointer locates the first color in the list that 
begins with the letter c.

Note:  Use the PANTONE CV dictionary if you are working in QuarkXPress 
software.
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5. Click Apply. 

The new spot color is added to the custom color dictionary.

To create a new spot color:

1. In the Spot Color Editor window, click add .

The Spot Editor dialog box appears.

2. Type the new spot color name as it appears in the PostScript file. 

3. Adjust the CMYK values as desired.

4. Click OK. 

The new spot color is added to the custom dictionary.

To delete a spot color (from the custom dictionary only):

1. From the Spot dictionary list, select Custom Dictionary. 

2. From the list of custom colors, select the spot color that you want to delete.

3. Click Delete .

The following message appears:

4. Click Yes to delete the spot color. 

Note:  Spot color names are case-sensitive. Ensure that the new name is 
identical to the name that appears in the DTP software.
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Protecting Specific Colors
Using the Spot Color Editor, you can protect specific colors—for example, official 
logos or company colors—to help produce color fidelity and color consistency 
between devices. When you define a specific color as an RGB or CMYK spot color 
and enter a fixed CMYK target for it, the CX Print Server treats it as a spot color, 
protecting it accordingly.

To define an RGB color as a spot color:

1. In the Spot Color Editor window, click the Protect RGB tab.

2. Click add .

3. In the Color name box, type a name for your color.

4. Type the RGB source values and the CMYK target values, or select a spot color 
from the Predefined Spot list.

5. Click Save.

Note:  The RGB spot workflow applies only to LW elements.
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6. On the Protect RGB tab, select the color.

The color information appears.

7. If necessary, in the Corrected column, adjust the CMYK values.

8. Click Apply.

To define a CMYK color as a spot color:

1. In the Spot Color Editor window, click the Protect CMYK tab.

2. Click add .

3. In the Protect CMYK dialog box, in the Color name box, type a name for your 
color.

4. Enter the CMYK source values or select a spot color from the Predefined Spot 
list.

5. Click Save.

6. On the Protect CMYK tab, select the color.

7. If necessary, in the Corrected column, adjust the CMYK values.
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8. Click Apply.

Gradation Tool
Sometimes you need to perform tone corrections when printing a job. Gradation 
changes can include brightness, contrast, and color balance adjustments 
throughout the tone range of an entire image, or in specific tone ranges. 

The Gradation tables that you create using the Gradation tool are added to the 
gradations list in the Color tab, and may be applied to print jobs. The CX Print Server 
also enables you to visually check the effect of different gradation adjustments on 
RTP jobs prior to printing.

Using the CX Print Server Gradation tool, you can apply the default gradation table 
or another pre-configured gradation table to a job. You can also edit an existing table 
and save your changes. Gradation is an interactive function and changes are 
automatically applied to the displayed image.

The Gradation tool is used to create and edit gradation tables and to check the effect 
of different gradation adjustments on specific RTP jobs. These tables can then be 
applied to your jobs during job processing for tailored gradations.

To open the Gradation tool:

From the Tools menu, select Gradation.

The Gradation dialog box appears.

Preview 

To preview a job:

1. Click Browse to select a job for display in the Preview window. 

The Processed Jobs window appears. The jobs that are displayed are the RTP 
jobs listed in the Storage window.

Note:  You can edit an existing gradation table, but you cannot overwrite the 
default gradation table, DefaultGradTable.

Notes:

• Gradation is an interactive function. Gradation changes are automatically 
applied to the displayed image.

• The gradation table created is not automatically applied to the previewed 
job. You must use job parameters to assign a gradation table to a job.
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2. Select the job you wish to preview, and then click Open.

The job appears in the Gradation dialog box.

Editing Gradation Tables
When you open the Gradation Tool window, the default gradation table, 
DefaultTable, is selected in the Gradation Table list, and is displayed in the graph. 
This table serves as a baseline and consists of a 45° gradation curve, with Brightness 
and Contrast set to 0, and Contrast Center set to 50. All of the color separations are 
selected.

Gradation tables that you create also appear in the Gradation Table list. When you 
select a gradation table for a job (see Gradation on page 196), the predefined 
settings are immediately applied to the processed job that you are working with.

The separations buttons enable you to select one, all, or any combination of 
separations to edit for a specific gradation table. Selecting a specific separation 
enables you to change the color balance for a specific tonal range.

When you open the Gradations Tool window, all of the separations are selected.

1. Do one of the following:

• Click the All Colors button  to edit all the separations simultaneously.

• Click the individual separations you wish to edit—for example, select the 
cyan separation only.

2. Click the curve in the graph to add a point, and then drag the point to modify 
the separation. When you select a point, its value appears in the Input or 
Output boxes. You can add multiple points to the curve in the same way. Drag 
the point(s) to the desired location(s).

The Input axis represents the tone values of the image before gradation 
changes. The Output axis represents the tone values of the image after 
gradation changes.
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3. To view gradation changes in your job, click Refresh. Changes are automatically 
applied to the displayed image in the After view.

4. To remove a point on the curve, select the point and then click Remove.

5. To reset the gradation curve to a 45° curve, click the individual separation and 

click the Reset button .

6. To revert to the original gradation settings, click Revert.

7. To remove the last change you made to the gradation graph, click Undo.

Creating a New Gradation Table
1. In the Gradation Tool window, modify your gradation table as desired.

2. Click the Save button . 

3. In the Table name box, type the desired name for the new gradation table, and 
click OK. 

The gradation table is saved and added to the Gradation Table list and to the 
Color Modes tab in the job parameters window.

Deleting a Gradation Table
1. Select the gradation table in the Gradation Table list, and then click the Remove 

button .

2. In the confirmation message, click Yes.

Navigation Buttons

The navigation buttons enable you to select a specific booklet or page to view, and 
to browse the pages of the current job. 

Note:  You cannot delete the predefined gradation table.
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Using the Preview Tools
The preview buttons enable you to switch the display mode in the original and 
edited views.

Table 15: Preview Buttons

This button: Enables you to:

Pan

View a different area of the image

Eye Dropper

Find out the CMYK values of a specific area on 
the page. To find the values, first click the Eye 
dropper button. Then move the pointer to the 
point on the page where you want to measure 
the color values and click. The CMYK values 
appear as a tool tip.

Zoom In

Magnify the selected area of the page

Zoom Out

Reduce the size of the selected area by 50%

One to One Zoom

View the actual size of the page one to one 
(1:1)

Fit to Screen

Scale the page to fit the available screen space

View the image at different preset levels of 
magnification by selecting a percentage in the 
list

Rotate View

Rotate the page by 90°, 180° and 270°

Show/Hide 
Separation

Turn on or off one or more separations

Before/After view

Toggle between the Before and After views
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Brightness and Contrast Slider Controls
The Brightness and Contrast slider controls are active only when all of the 
separations are selected.

Brightness

Brightness increases or decreases the luminance of the image. Increasing brightness 
lightens the image and results in a concave curve. Decreasing brightness darkens 
the image and results in a convex curve. 

Move the Brightness slider to the right to increase brightness or to the left to 
decrease brightness.

Contrast

Contrast increases the image contrast by making the highlights lighter and the 
shadows darker. It can also be used to decreases the contrast.

Move the Contrast slider to the right to increase contrast (S shaped curve), or to 
the left to decrease contrast (inverted S shaped curve).

Contrast Center

Contrast increases the image contrast mainly in the midtones. Using Contrast 
Center, you can adjust where the contrast is increased. To enhance contrast in 
highlights, the Contrast Center is shifted toward the highlights. To enhance contrast 
in shadows, the Contrast Center is shifted toward the shadows.

Set the image contrast, by adjusting the Contrast slider.

Your change affects the gradation graph by moving the point where the curve 
changes from convex to concave.

Before/After view

View the Before and After views in portrait

Before/After view

View the Before and After views in landscape

This button: Enables you to:

Note:  Contrast Center only affects the image if Contrast has also been 
adjusted.
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Organizing Gradation Tables
The Gradation window provides a number of options for organizing gradation tables, 
including Reset, Save, Delete, and Save As.

If you work only with the default gradation table, the Reset and Save As options are 
activated. These options enable you to use the default gradation table as a base on 
which to build and save new gradation tables. When you work on gradation tables 
other than the default table, the Save and Delete options are also active.

To reset all Gradation window settings:

Click Reset.

The gradation curve is reset to a 45° line.

To delete the selected gradation table:

Click Delete. 

To save the specified gradation settings:

Click Save.

To create new gradation tables by saving existing gradation tables with new 
names:

Click Save As.

Note:  You can not delete the DefaultGradTable.

Note:  You can only save the default gradation table under a new name.
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VI Overview
Variable information (VI) jobs are jobs in which the printed materials are 
individualized for specific recipients or purposes. These materials can include bills, 
targeted advertising, and direct mailings.

VI jobs are composed of booklets, which are personalized copies of a document. A 
booklet can consist of one or more pages, with the entire document targeted at a 
specific individual or address. For example, a booklet can be either a single-page gas 
bill or a multi-page personalized document.

Each page in the booklet is constructed as a collection of individually RIPed 
elements that may differ from booklet to booklet, including text, graphics, pictures, 
and page backgrounds. These elements are self-contained graphical entities that 
may be line art, text, RIPed images, or a combination of these. There are two types 
of elements in VI jobs:

• Unique elements that are used only once for a specific individual or purpose. For 
example, an individual’s name.

• Reusable VI elements can be used more than once in different pages, booklets, 
or jobs. A company logo is an example of a reusable element.

On the CX Print Server, each element, text, graphic, picture, or page background is 
RIPed only once, whether the element is used once, several times, or on every page 
of the VI job. If an element is used more than once, it is cached for further use. You 
can manage these elements in the Resource Center in the Cached VI Elements area. 
Each set of elements associated with a particular job is assigned a unique name. 
Inline variable elements that are used only once, usually text, are not cached.

For more information about cached VI elements, see Managing VI Elements on 
page 146.

Pages are assembled from the pre-RIPed reusable elements and the RIPed unique 
elements just before printing. Then the job is printed in the same way as all other 
jobs in RTP format.

Whenever a VI or PS job is imported to the CX Print Server, its page size is 
automatically recognized. The page size is displayed in the CX Print Server Job 
Parameters window.
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VI Document Formats
VI jobs are created using VI authoring software that support Variable Print 
Specification and VIPP formats. Most VI authoring software can convert VI files to 
conventional PS files, which can also be processed by the CX Print Server, although 
less efficiently than Variable Print Specification and VIPP files. Each authoring 
software creates VI code that instructs the RIP where to place the VI elements and 
each authoring software does so in a slightly different manner.

The format you choose can be a stand-alone format that covers all aspects of 
document design, data management and text capture or it can be an extension of an 
existing software that enables the creation of VI documents and VI jobs.

The CX Print Server can process VI jobs that are in one of the following file formats:

• Creo Variable Print Specification

• Xerox Variable data Intelligent Postscript Printware (VIPP)

• Personal Print Markup Language (PPML)

• PostScript

Creo Variable Print Specification
Creo Variable Print Specification is the Creo developed formal language designed for 
effective production of VI documents.

Creo Variable Print Specification is comprehensive and can specify a complete range 
of VI documents. It also provides the means for efficient implementation—fast and 
efficient data processing, and storage prior to printing.

Note:  Variable Print Specification, VIPP, and PPML elements are displayed in 
the Resource Center under the Cached VI Elements area. 
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A Variable Print Specification job consists of the following components: 

• Booklet

A personalized copy of a document within a single print run where pages and/or 
elements within a page may vary from booklet to booklet.

• Sub-job

All copies of a particular document—for example, book, brochure, or flyer—
within a single print run. On the CX Print Server, sub-jobs can be deleted, 
archived, or reprinted at any time. However, you can still maintain reusable 
elements for future runs. Reusable elements are cached elsewhere, so only the 
unique data, which is embedded in the job, is deleted.

• Reusable Elements

Self-contained graphical entities that can be line art, text, raster images or a 
combination of these types. Reusable elements are represented in PostScript and 
can be stored as EPS files when appropriate. Reusable elements include clipping 
and scaling instructions as well as the image data.

Reusable elements can be used repeatedly in different pages, booklets and jobs. 
On the CX Print Server, all reusable elements are processed once and cached as 
RTP elements for further use. They can be reused either within the sub-job itself, 
or in additional runs of sub-jobs.

• Inline Elements 

Unique information is drawn from a database and is embedded in the sub-job. 
This data prints only once for individual booklets.

VIPP 
VIPP is a PostScript-based format that merges the VI pages during the processing 
stage. VIPP is mostly used with financial software, using the dynamic graph-
charting capability of VIPP for bank statements, telephone bills, electric bills, and so 
on.

Whenever a VI job is imported to the CX Print Server, the number of pages per 
booklet is automatically recognized.

Note:  Grayscale TIFF and EPS images that are created in CMYK 
applications (such as Adobe Photoshop) are counted correctly as B&W 
instead of Color in both the CX Print Server and the DocuColor 8000AP 
billing meters.

Note:  To use VIPP files on your CX Print Server, first install the VIPP software 
on your system. This installation should be done by a service engineer. Contact 
your service provider for more information.
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VIPP jobs are composed of the following four files:

VIPP software creates xgf and xgfc folders on your system. Within the xgfc folder, a 
number of sub-folders are created. Table 17 lists in which sub-folders you should 
store VIPP job files.

To print a VIPP job:

Import the *.DBF file to the CX Print Server. 

The VIPP job is processed and printed. 

VIPP 2001 and PPML
The PPML format is a new XML-based industry standard that print-technology 
manufacturers developed for the high-speed production of reusable page content.

Table 16: VIPP files

File Name File Description

File.PS The PostScript Master Form, which contains 
all of the fixed elements from the original 
document.

File.JDT The Job Descriptor Ticket, which contains 
header and setup information for the job.

File.DBM The Database Master, which contains the 
VIPP coding.

File.DBF The Database File, which contains all the 
ASCII data to be merged. It should include 
database information taken from the range 
of database records that were specified in 
the DataMerge dialog.

Table 17: VIPP sub-folders

File Name Store in VIPP Sub-folder

File.PS formlib

File.JDT jdtlib

File.DBM formlib

File.DBF mislib

Variable Image Files imglib
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The CX Print Server supports VIPP 2001 and PPML formats. Some of the features 
that are included enable you to:

• Process VIPP 2001 and PPML jobs efficiently

• Manage VIPP 2001 and PPML reusable elements

• Import jobs in various VI formats to the CX Print Server 

• Import VI elements to the CX Print Server and submit them for pre-cache

• View VI elements in their structural hierarchy

Both PPML and VIPP 2001 have a hierarchical structure. Document components are 
separated from their submission file and can be organized and stored in different 
levels of the hierarchical structure.

In PPML, you can store different jobs in one PPML file. Thus, the display in the 
navigation pane varies from the way Variable Print Specification and VIPP appears. 

You can print a booklet range within a PPML file.

PostScript Files
PostScript files are suitable for simple, very short run jobs. All page elements are re-
RIPed for each page. These jobs do not use a VI authoring tool. Instead, they use a 
mailmerge function in a Word document or an Excel spreadsheet.

Using Creo Variable Print Specification to Print a VI Job
The CX Print Server first searches for high-resolution files in the input folder that 
contains the PDL file, and then in the predefined APR path, D:\Shared\High Res. 
The CX Print Server will look for VI images in these locations when it RIPs the job.

To print a VI job:

1. Copy VI graphic elements to one of the defined APR folders on the CX Print 
Server. 

2. Submit your job to the CX Print Server.

For more information about how to print files, see Importing and Printing Jobs on 
page 22.

Reusable elements are identified, processed, and placed in the Resource Center 
under the CachedVI Elements area. They are ready for rapid assembly into pages 
and for reuse during the printing stage.

Your VI job is processed and printed on the CX Print Server. The DocuColor 8000AP 
prints RTP booklets at full engine speed working uninterrupted from the printer disk. 
Booklets are compiled concurrently while the printer prints. As pages are sent to the 
print engine, they are assembled from the various inline and reusable elements
on-the-fly.

Note:   You can also define a custom path to any connected server or disk. For 
more information about adding an APR path, see High-Resolution Workflow on 
page 80.
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After the job is completed, an RTP job is placed in the Storage window. This RTP job 
contains the complete variable job including all booklets, variable images, and 
unique elements.

Useful VI Print Options

Gallop
The Gallop parameter on the Print Settings tab enables the CX Print Server to RIP 
and print VI jobs concurrently. Large jobs do not have to be RIPed entirely to disk 
before printing. You can predefine the number of pages to be processed before the 
engine starts to print. As soon as these pages are processed, printing starts while 
the rest of the job is streamlined through the CX Print Server. The DocuColor 
8000AP continues printing at its rated speed without interruption or slowing down 
until the job is finished.

For more information about setting the Gallop option, see Gallop on page 187.

Job Deletion
When you are printing a large VI job that takes up a substantial amount of the CX 
Print Server disk space, it is recommended that you use the Job Deletion parameter.

For more information about setting the Job Deletion option, see Job Deletion on 
page 204.

Imposition
When you impose VI jobs, every booklet must have the same number of pages.

If you use the Step & Repeat method to print a single page booklet, the VI job does 
not print the same image repeatedly. Several booklets are printed on the same sheet 
and each record is printed on the sheet once.

Notes:

• If an element is to be used more than once but with different clipping or 
scaling parameters, it is treated as a new page element and processed again.

• The cache is kept intact until the job is completed. This enables you to reuse 
RIPed elements anywhere in the job. Elements may remain in the cache for 
subsequent jobs. You can also archive job elements.

• Deleting a job does not delete the cached job sub-folder. This must be done 
manually in the Resource Center.
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For a booklet with several pages, the pages are printed in order along the length of 
the sheet. The next booklet is printed beside the first. After the sheets are cut, the 
booklets are aligned with their pages in the proper order.

For more information about setting Imposition parameters, see The Imposition Tab 
on page 197.

Managing VI Elements
When the CX Print Server processes your VI job, it stores the reusable VI elements 
in a specific location. When the job is printed, the RIP engine looks for the VI 
elements in that location and reuses the elements when necessary. The VI elements 
can also be reused in future jobs.

In the Resource Center, use the Cached VI Elements area to manage the VI 
elements on your system and to perform the following tasks:

• Delete VI elements

• Archive VI elements

• Retrieve VI elements

Deleting VI Elements
VI elements that are no longer in use take up valuable disk space on the CX Print 
Server. To free up disk space, you can delete the VI elements you no longer need.

1. From the Tools menu, select Resource Center . 

2. In the Resource list, select Cached VI Elements.

Note:  The above example uses the step and repeat method. There are no 
special considerations for VI jobs using saddle stitch and perfect bound 
methods.
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Your VI jobs are listed in the left pane. In the right pane, you can see all of the VI 
elements that are associated with your job. In addition, a thumbnail viewer lets 
you check elements visually.

3. Select the element that you want to delete, and then click Delete.

Archiving VI Elements
If you have finished printing a large VI job and you know that you will need to reprint 
it in the future, it is a good idea to archive the VI elements and retrieve them when 
needed. You can archive your VI job folder in a location that you specify.

1. On the toolbar, click Resource Center . 

2. In the Resource list, select Cached VI Elements.

3. Select the VI folder in which to archive, and then click Archive.

The Archive dialog box appears.

4. Find the location in which to archive your VI elements, and then click Archive.

Note:  You can also delete the entire folder.
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Retrieving VI Elements
When you need to reprint your job, you can retrieve the VI elements from the 
archive.

1. From the Job menu, select Retrieve from Archive.

The Retrieve dialog box appears.

2. Select the folder in which your VI elements are archived.

3. Select the desired file and then click the add button 

4. Click Retrieve.

The CX Print Server retrieves the archived VI elements and displays them at the 
end of the file list in the Cached VI elements dialog box.

Note:  Use SHIFT or CTRL to select several files or CTRL+A to select all the files. 
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Setting Up and Configuring the CX Print Server
Basic system configuration and settings are defined in the CX Print Server Settings 
window. The Settings window contains items that enable you to manage your 
system.

To open the Settings window:

From the Tools menu, select Settings.

The Settings window appears. The settings are divided into two lists: 
Administration and Preferences. 

• Administration: All users can view these settings, but only an administrator can 
configure the settings. 

• Preferences: All users can view these settings, but only users of Administrator 
and Operator user levels can configure the settings. 

To save changes in the Settings window:

In the Settings window, click Save.

Server Setup

Changing the Server Name
1. In the Settings window, select Server Setup.

2. In the Server Name area, click Change.

The System Properties dialog box appears.

Note:  If you log on to the CX Print Server as a guest, the Settings window is 
unavailable.
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3. On the Computer Name tab, click Change.

The Computer Name Changes dialog box appears.

4. In the Computer name box, type a new name for the computer. 

5. If you want to change the Workgroup or the Domain in which your computer 
appears, select the desired option and type a new name in the corresponding 
box.

6. Click OK.

A message appears notifying you that you must restart your computer for the 
new settings to take effect.

Note:  Do not change the workgroup or domain unless you are instructed to 
do so.

Important:  If you want to change the domain, you are required to type the 
password for the domain account. If the password is unavailable, the 
computer is locked.
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7. Click OK.

8. Click OK in the System Properties window.

The computer automatically restarts.

Changing the Date and Time
1. In Settings window, select Server Setup.

2. In the Date & Time area, click Change.

The Date and Time Properties dialog box appears.

3. On the Date & Time tab, select your local time settings.

4. Select the Time Zone tab and set the correct time zone.

5. Click OK.
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Network Setup

IPX Printing
IPX Printing enables the CX Print Server to act as a job server for the Novell queue. 
A job server checks each assigned queue at a specified interval, taking care of jobs 
on a first-in, first-out basis. Once a job is processed, its associated file is deleted 
from the queue directory.

To set the CX Print Server IPX parameter:

1. In the Settings window, select Network Setup.

2. In the IPX Printing area, click Change Settings next to the Tree parameter.

The Local Area Connection Properties dialog box appears, followed by the 
NWLink IPX/SPX Properties dialog box.
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3. To change the frame type, select a frame type from the Frame type list and click 
OK.

4. Click OK also in the Local Area Connection Properties window.

You are prompted to restart your computer. 

5. Click No if you need to make more changes, or Yes to restart.

TCP/IP Setup
The CX Print Server is predefined with a default IP address. The TCP/IP option 
enables you to change this IP address and other TCP/IP settings.

To change the TCP/IP network settings:

1. In the Settings window, select Network Setup.

2. In the TCP/IP area, click Change Settings next to the IP Address parameter.

The Local Area Connection Properties dialog box appears, followed by the 
Internet Protocol (TCP/IP) dialog box.

3. To change the IP Address, do one of the following:

• Select Obtain an IP address automatically.

• Select Use the following IP address and type the desired address—for 
example, IP address:192.168.62.1 and Subnet mask:255.255.255.0, and 
enter the default gateway.

4. Click OK.

5. Click OK in the Local Area Connection Properties window.

Restart the CX Print Server for changes to take effect. 

Note:  Using this procedure requires further setup by the network administrator.

Note:  Before changing the network settings, consult your System 
Administrator.
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AppleTalk Setup
The AppleTalk Setup utility enables you to change the AppleTalk zone in which your 
CX Print Server is located.

To change the AppleTalk network settings:

1. In the Settings window, select Network Setup.

2. In the Apple Talk Setup area, click Change Settings next to the The System will 
appear in zone parameter.

The Local Area Connection Properties dialog box appears, followed by the 
AppleTalk Protocol Properties dialog box.

3. From the zone list, select the desired AppleTalk zone for your computer, and 
click OK.

4. In the Local Area window, click OK.

After you have exited the CX Print Server software, a message appears indicating 
the Apple Talk zone has been changed. You must restart the CX Print Server for 
changes to take effect.

Remote Tools Setup
The Remote Tools Setup parameter includes setup for the Remote Admin tool and 
enables the connection of clients to the CX Print Server over the network using the 
Spire Web Center.
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Remote Admin
The Remote Admin utility enables the system administrator to connect, view, 
operate and perform administration actions on the CX Print Server from a client 
workstation. While this remote connection and operation takes place, the regular 
operation of the CX Print Server is not affected. In fact, the only indication the Spire 
operator has that such connection takes place is in the DFE and Printer Animation 
and in DFE Monitor window.

The following graphic shows the DFE and Printer Animation as it is presented when 
the remote session is active (for administrator only).

To secure the remote connection, a password should be assigned by the system 
administrator. 

For more information about viewing and monitoring your jobs from a client 
workstation, see Spire Web Center on page 57.

The remote admin setup process includes the following stages:

1. On the CX Print Server, the remote admin service is enabled and a password is 
assigned.

2. On the System Administrator’s station, the client software is downloaded and 
launched.

Note:  This tool is designed for the exclusive usage of the system administrator. 
Clients who would like to connect to the CX Print Server from their workstations 
may do so by using the Spire Web Center, which enables you to view and 
monitor your jobs in the CX Print Server queues.
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To enable the remote admin service and set a password:

1. In the Settings window, select Remote Tools Setup.

2. In the Remote Tools Setup area, select Enable RemoteAdmin Service.

3. In the Password box, type a password.

4. Click Save.

To download and launch the Remote Admin Client software:

1. From the system administrator workstation, connect to the desired CX Print 
Server. From the Utilities folder, in PC Utilities, double-click 
SpireRemoteAdmin.exe.

When the installation is complete, the Login window appears.

 

2. From the Spire Server list, select the desired CX Print Server.

3. Click OK.

The next Login window appears.

4. In the Session password box, type the password that you created in the Remote 
Tools Setup window.

5. Click OK.

The CX Print Server workspace appears on your screen.

Web Connect Setup
The Web Connect Setup enables clients to connect to the CX Print Server over the 
network by using the Spire Web Center. This option is disabled by default.

For more information about viewing and monitoring your jobs from a client 
workstation, see Spire Web Center on page 57.

To enable web connections:

1. In the Settings window, select Remote Tools Setup.

2. In the Web connect setup area, select Enable WebViewer.

3. Click Save.

Note:  This password will be used later to connect to the Remote Admin 
software from the system administrator workstation.

Tip:  You can also download the software from the Spire Web Center. 
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Security

User Passwords
The system administrator assigns each user an access level, as follows:

• Operator (default): Enables the user to operate the CX Print Server and 
configure the Preferences area in the Settings window 

• Administrator: Enables the user to access all features and settings on the CX 
Print Server

• Guest: Enables the user to import a job through an existing virtual printer and 
view the workspace

To set Password settings:

1. In the Settings window, select Security.

2. Select Auto Log On to enable users to log on automatically. 

3. Select Disable Guest Connection to prevent Guest users from accessing the 
CX Print Server.

To change Administrator/Operator passwords:

1. In the Settings window, select Security.

2. In the Administrator/Operator area, enter the old password.

3. Enter the new password.

4. In the Verify new password box, retype the new password.

5. Click Apply and Save in the Settings window.

The password is changed and the Settings window closes.

Note:  This option is not available if you selected the Auto Log On option.
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Disk Wipe
Usually when you delete a file, the file’s dictionary entry is removed but data still 
remains on the disk. The Disk Wipe utility enables you to clear previously deleted 
files. This utility eliminates the contents of your deleted files by scanning all of the 
empty sectors on the disk and replacing them with zeros. Non-empty sectors are left 
untouched. This feature enables you to work in a more secure environment. When 
you exit the CX Print Server software, the disk wipe operation can begin 
immediately.

To operate the Spire Disk Wipe utility:

1. In the Settings window, select Security.

2. To enable the disk wipe feature, select Wipe disk on system shutdown.

3. Click Save.

4. Quit the CX Print Server software.

The Spire Disk Wipe dialog box appears.

5. Perform one of the following actions: 

• Click Start Wiping to begin the disk wipe procedure

• Click Exit to not perform the disk wipe procedure and close the Spire Disk 
Wipe dialog box.

Note:  Ensure that the Auto Log On check box is not selected.

Notes:

• The disk wipe operation permanently deletes files

• The disk wipe operation does not function well when the Norton Utilities 
software is installed. Before you activate the Disk Wipe utility, make sure 
that Norton Utilities is not installed on the CX Print Server.

• In rare cases, the process of deleting files from the Storage window is not 
completed—for example, the system shuts down before the deletion process 
is completed. In these cases, parts of the deleted files still reside in the 
D:\Output folder. Therefore, it is recommended that before you start the 
disk wipe operation, check the D:\Output folder to ensure that all the 
relevant files are deleted.

• The Disk Wipe utility affects the user disk and printer disk.

• Do not operate the Disk Wipe utility while other software is running.

• The supported language is English.
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System Disks

When the printer or user disks reach a pre-defined threshold of minimum available 
space (the default is 250 MB), RIP is suspended and a system warning message 
appears. The RIP resumes automatically only after disk space is available. 

To set the system disk’s threshold:

1. In the Settings window, select System Disks.

2. In the System Disks area, set the minimum free disk space desired for RIP.

3. Click Save.

Backing up the Configuration
The Configuration Backup item enables you to back up your CX Print Server 
configuration to a local hard disk, to a network drive or to an external media—for 
example, an external zip drive—connected to the CX Print Server.
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Configuration Backup

To back up the configuration of your CX Print Server:

1. In the Settings window, select Configuration Backup.

2. In the Configuration Backup area, click Browse.

The Save window appears.

3. Browse to the desired directory path for the backup, and type a file name.

4. Click Save.

Note:  You can also back up to an external media.
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5. In the Settings window, click Start Backup.

6. When the backup procedure has been completed, the following dialog box 
appears:

7. Click OK.

Configuration Restore

To restore the configuration on your CX Print Server:

1. In the Settings window, select Configuration Backup.

2. In the Restore Configuration area, click Browse and locate the directory path 
from which to restore the configuration.

3. Click Start Restore.

The Restore Configuration window appears.

4. Select the categories that you want to restore and click OK.

Note:  The last path will be saved and displayed to the path box. If the 
backup was made to an external media, the displayed path will be the 
default: C:/CX8000AP/General/Configuration.

Note:  Two files are created during the backup procedure, SpireConf.Cab 
and SpireConf.CNF.

Notes:

• The configuration file name will always be SpireConf (CNF file).

• You may also restore the configuration from an external media.

Note:  When restoring the configuration all the custom tables/sets are 
added to the system (for example—imported user-defined imposition 
templates, new virtual printers, downloaded fonts, and so on.
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The following message appears:

5. Click Yes if you would like the restored files to replace the current ones. Click 
No if you do not want the restored files to replace the existing files.

If you selected Yes, the following message appears:

6. Click OK.

Your changes will take effect once you have restarted the CX Print Server.

Localization

Setting the Local Units of Measure
1. In the Settings window, select Localization.

2. In the Units area, select Millimeters or Inches, as desired.

Note:  The Restore Configuration date is updated in the Configuration 
Backup window.
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Setting the Language
1. In the Settings window, select Localization.

2. In the Language area, select the language, as desired.

When configuring the CX Print Server interface for Russian localization, several 
steps must be performed manually to define Russian as the default language.

1. Close the CX Print Server and turn off the DocuColor 8000AP.

2. On the desktop, go to Start > Settings > Control Panel. 

3. Double-click Regional and Language Options and select the Advanced tab.

4. In the Language for non-Unicode programs area, select Russian from the list.

5. In the Default user account settings area, select the Apply all settings to the 
current user account and to the default user profile check box.

6. To confirm the new language setting, click OK in the popup window.

7. Click OK to close the Regional and Language Options window.

8. If the following window appears, click Yes to confirm using the required 
resources from the local hard disk.

9. Restart the CX Print Server.

10. Wait until the CX Print Server workspace appears, and then turn on the 
DocuColor 8000AP.

Note:  If you switch to another language, you need to restart the CX Print Server 
software.
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Pre-RIP Preview

1. In the Settings window, select Pre-RIP Preview.

2. In the PS Preview area, select one of the following: 

• Save as PDF saves the file as a PDF file

• Return to original PS file returns to the original PS file

3. In the VI Job Preview area, select the desired number of booklets for pre-RIP 
preview.

4. Click Save.
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General Defaults

1. In the Settings window, select General Defaults.

2. In the Default Trim Size area, select the Size.

3. In the OPI area, select the desired OPI setting.

For more information about setting the OPI, see OPI on page 81.

4. In the Default archive path area, set the archiving path.

For more information on the default archive path, see Archiving and Retrieving 
Jobs on page 30.

5. In the Custom Paper Function area, select the check box to enable custom 
profiles for paper sets.

For more information, see Managing Paper Sets on page 44.

6. In the OCT Offset between jobs area, the OCT Offset between jobs check box 
is selected by default, meaning offset is always done between jobs. Clear the 
check box if you do not require this option.

7. In the Job Title Recognition area, select one of the following options:

• Use PostScript Internal name: select this option to use the internal file 
name as written inside the PostScript file by the print driver.

• Use files name (Use when Printing via LPR): select this option to use the 
job’s given file name. Selecting this option ensures that the job appears in 
the CX Print Server with the name last given by the user.

8. In the Cache global VI elements area, select the check box to cache global VI 
elements for VPS format. When selected, VI elements are cached for further 
use.

9. Click Save.
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Print Queue Manager

Job Batching
The Job Batching utility enables you to print several jobs with the same settings in a 
single batch, one after the other without cycling down, and subsequently save 
production time.

To set the desired job batching option:

1. In the Settings window, select Print Queue Manager.

2. In the Job Batching Policy area, select one of the following options:

• Enable Job Batching to print jobs with the same page parameters, one after 
the other without the cycle down.

• Disable Job Batching to disable the printing of jobs with the same page 
orientation one after the other, and enable cycle down.

3. Click Save.

For more information about job batching, see Batching Jobs on page 24.

To set the desired held jobs option:

1. In the Held Jobs Policy area, select one of the following options:

• Bypass held jobs to bypass frozen jobs in the In Print queue

• Don’t Bypass held jobs to stop the printing from the queue when a job is 
assigned a frozen status

2. Click Save.
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Color

Calibration
For more information on setting the calibration method, see Setting the Color 
Calibration Method on page 112.

Emulations
Using this utility, you can select the desired emulation method: 

• Device Link (default)

• CSA

To specify the emulation method:

1. In the Settings window, select Color.

2. In the Emulation area, select the desired emulation method from the list.

Automatic Screening
The CX Print Server supports Dot and Stochastic screening. When you print a job 
from the CX Print Server, on the Color tab, under the Screening parameter, select 
the desired screening method or choose Automatic. By default, Automatic applies 
two types of screening:

• Text / line-art elements - LW (Line Work)—the system uses Line type screen of 
Line 200.

• CT (Continuous Tone):—the system uses Dot type screen of Dot 200.

Note:  The emulation profiles that are displayed in the Job Parameters window 
are related to the selected emulation method. For more information on 
emulation, see CMYK Workflow on page 193.
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To change the values of the automatic screening method:

1. In the Settings window, select Color.

2. In the Automatic Screening area, select the desired auto screen settings for LW 
from the LW list.

3. Select the desired auto screen settings for CT from the CT list.

You are prompted to restart the software for the new settings to take effect.

For more information, see Screening on page 195.

Color Conversion Tables
The Color Conversion Tables utility enables you to select the set of color conversion 
tables used for your jobs. 

To select the color conversion tables:

1. In the Settings window, select Color.

2. In the Color conversion tables area, select the conversion table to be used.

By default the current version color tables are selected. To apply the previous 
version color tables, select Previous version color tables.

The following message appears.

3. Click OK.

Calibration Reminder
Set the Calibration Reminder to remind you when to perform a calibration.

1. In the Settings window, select Color.

2. In the Calibration Reminder area, select the Set calibration reminder every 
(Hours) check box and select the number of hours in the list.

 The calibration reminder indicator  appears when it is time to calibrate.

Important:  The Process queue must be suspended while changing the color 
tables set.



170 Chapter 8 —System Administration

 

Messages

Accounting Log Setup
By default, all the jobs that were handled during the past 90 days are listed in the CX 
Print Server Accounting window. This utility enables you to specify different values 
for how long information remains before being overwritten.

To setup the accounting log:

1. In the Settings window, select Messages.

2. In the Accounting Log Setup area, select the desired value to Overwrite 
messages after. 

3. To remove all the existing information from the windows, whenever desired, 
click Clear Log Now.

For more information about the Accounting window, see Job Accounting on page 177.

Message Viewer Log Setup
By default, all the jobs that were handled during the past 56 days are listed in the CX 
Print Server Message Viewer. This utility enables you to specify different values for 
how long information remains before being overwritten.

To setup the message viewer log:

1. In the Settings window, select Messages.

2. In the Message Viewer Log Setup area, select the desired value to Overwrite 
messages after. 

3. To remove all the existing information from the windows, whenever desired, 
click Clear Log Now.

For more information about the Message Viewer, see Job Accounting on page 177.
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JDF Outputs

The CX Print Server receives the JDF job ticket via hot folders, returns JDF output 
with job accounting information, and submits JMF (Job Messaging Format) signals 
with the job's status.

If the JDF job has a target path specified in the job, JDF output is always created. For 
JDF jobs that don’t have a specified target path, the JDF output is only created if this 
option is selected in the Settings window. 

1. In the Settings window, select JDF Outputs.

2. Select Create JDF Outputs to create JDF output.

3. In the Target Path box, enter the target path, or click Browse to browse to the 
desired directory path for the JDF output.



172 Chapter 8 —System Administration

 

View Configuration

The View Configuration utility enables you to view the configuration of your CX 
Print Server and to print it to any printer on the network connected to your CX Print 
Server. In addition, you can save the configuration in the network or export it to an 
external media as a text file.

To print your configuration:

1. In the Settings window, select View Configuration.

2. Click Print.

The Page Setup dialog box appears.

3. Set the printing options as desired and click OK.

The Print dialog box appears.

4. From the Printer list, select a printer and click OK.

To export your configuration:

1. Click Export.

The Save window appears.
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2. Locate the desired folder, and click Save.

Storage Management

The Storage Management utility enables you to set a deletion policy for the Storage 
folder.

1. Select the Automatically delete jobs from storage folder check box.

2. Select the After...days or After...hours option, and enter the number of days or 
hours after which the CX Print Server should delete jobs from the Storage 
folder.

3. Click Save.
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System Messages
While jobs are being handled by the CX Print Server, various messages are emitted. 
You can view the messages of each job in the Job History window, of the entire 
session in the Message Viewer window, or just the error messages within the Job 
Alert window.

The Job Alert Window
By default, the Job Alert window is open in the CX Print Server workspace. Any time 
the system emits an error message, the message appears in the Job Alert window. 
The Job Alert window lists all error messages as they appear during the workflow. 

From the View menu, select Job Alert.

System Disks Threshold Message
When the printer or user disks reach a pre-defined threshold of minimum available 
space (the default is 250 MB), RIP is suspended and a system warning message 
appears. The RIP resumes automatically only after disk space is available. If 
necessary, you can increase the System Disk threshold.

For more information about setting the system disk’s threshold, see System Disks on 
page 160.

Job History

To view the job history:

Do one of the following actions:

Right-click a job in the Queues window or Storage window, and from the 
menu, select Job History.

Select a job and from the Job menu, select Job History.

The Job History window appears, listing all the messages that were generated 
during the workflow of the selected job.

The Job History window indicates the job title and the sender name (the user 
name of the system from which the job originated).
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Message Information
For each message, the following information is indicated by default:

• An icon denoting the type of message (Error, Warning, or Information)

• The date and time on which the message was emitted (the time stamp)

• The stage in the workflow (for example, Print, Process, or System)

• The message text

You may filter the messages by type, and/or sort the list by one of the column 
headers. 

The Message Viewer

To open the Message Viewer:

At any stage of work, from the Tools menu, select Message Viewer.

The Message Viewer window appears, listing all the messages that were 
generated during the workflow.

For more information about viewing messages related to a specific job, see Job 
History on page 174.



176 Chapter 8 —System Administration

 

By default, all the jobs that were handled during the last 56 days are listed.

The default may be changed in the Settings window under Messages. For more 
information about changing the default setting, see Messages on page 170.

Managing Messages
You can filter the messages by type, and/or sort the list by one of the column 
headers. In addition, you may print the list of messages.

If desired, you may reorder and resize columns, filter the list, or sort the list by one 
of its column headers.

Filtering the Messages by Type

Each message in the Message Viewer and Job History windows is assigned an icon 
to denote the message type:

You can filter the list in order to view only messages of certain types. 

Click any message type icon—for example, Error— in order not to list such 
messages.

By default, all message types are listed in the Message Viewer. 

The list updates accordingly.

Notes:

• This section is relevant for the Message Viewer and Job History windows (but 
not for the Job Alert window).

• These settings are retained after closing a window.

Information

Warning

Error

Note:  If the message type is not selected, messages of this type do not 
appear in the list.
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Printing the Message List

You can print the information as it appears in the Message Viewer (as it is currently 
filtered and sorted).

To print the message list:

1. Filter and sort the list as desired (the data is printed according to the current 
filtering and sorting).

2. Click Print List.

The Page Setup window is displayed.

3. Set the printing options as desired, and then click OK.

Job Accounting
The Accounting feature provides information about all the jobs that were printed 
successfully via the CX Print Server. The report is in the form of a tab-delimited file. 
You can filter, sort, and print the jobs in the report and also export the report to a 
spreadsheet software—for example, Excel—where you can manipulate the data.

Viewing the Accounting Information
At any stage of work, from the Tools menu select Accounting.

The Accounting Viewer window appears, listing information related to all the 
jobs that printed successfully via the CX Print Server. 
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Each row in the Accounting report contains information related to a specific job.

The columns indicate the following information.

Notes:

• To see additional columns, use the horizontal scroll bar.

• By default, all the jobs that were handled during the past three months are 
listed. From the Tools menu, select Settings. In the Settings window, under 
Preferences > Messages, you can specify how long information remains 
before being overwritten. In addition, you can remove all the information 
from the window whenever desired.

Table 18: Description of columns in the Accounting Viewer

Column name Indicates the

Title Original name of the file related to this job (that is, 
without the extension)

Job Size Job size in MB

Sender User name of the person who submitted the job 
when the CX Print Server is logged on to a domain 
controller. If the CX Print Server is not logged on to a 
domain controller, “guest” will be displayed in the 
Sender column.

Started Process Date and time on which the job started processing

Processing Time Total time during which the job was processed

Started Printing Date and time on which the job first started printing

Printing Time Total time during which the job was printed

Paper Size Size of the media set for the job—for example, 
Letter, A3, A4

Paper Weight Paper weight in gs/m
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Setting the Accounting/Message Viewer
By default, all the jobs that were handled during the past 90 days are listed in the CX 
Print Server Accounting window. Also, all jobs that were handled during the past 56 
days are listed in the CX Print Server Message Viewer. You can specify how long 
information remains before being overwritten.

To change the Accounting/Message Viewer log setup, see Messages on page 170.

Coating Paper stock coating status (Coated or Uncoated)

B/W Pages Number of black-and-white pages in the original 
PDL file 

Color Pages Number of color pages in the original PDL file

Purged B/W 
Pages

 Number of B/W pages that were already in the 
paper path, and were cleared due to job abort, or 
paper jam

Purged Color 
Pages

Number of color pages that were already in the 
paper path, and were cleared due to job abort, or 
paper jam

Total Pages Number of pages that were printed

Sets Actual number of printed copies

Account [Optional] string of text, if such was entered in Job 
Parameters

Recipient [Optional] string of text, if such was entered in Job 
Parameters

Job Comments [Optional] string of text, if such was entered in Job 
Parameters

Table 18: Description of columns in the Accounting Viewer

Column name Indicates the
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Printing and Exporting the Accounting Log
You can save the Accounting information to an ASCII Tab delimited file.

To export the accounting information:

1. Filter the information as desired.

2. Click Export.

The Export window appears.

3. Locate the folder in which to save the report.

4. In the File name box, type a name for the file.

5. Click Export.

The log is saved as a Tab delimited text file in the specified location. 

6. If desired, open the *.txt file in a text editor or in a spreadsheet software—for 
example, Excel—and manipulate the data.

You can print the Accounting information (filtered and sorted) to any connected 
printer.

To print the accounting log:

1. Filter and sort the report as desired.

Notes:

• The log includes all the columns (even those that were hidden), listed in 
the original order and sorting.

• To export specific rows, use SHIFT or CTRL to select them before clicking 
Export. The exported log will include only these rows.

• The exported data is not deleted from the Accounting report on the CX 
Print Server (that is, it will still be displayed in the Job Accounting 
window).

Note:  To print specific rows, use SHIFT or CTRL to select the desired rows. 
The printed report will include only these rows.
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2. Click Print List.

The Page Setup window appears.

3. Set the printing options as desired and click OK.

The data is printed according to the current filtering and sorting.

Notes:

• To fit the maximum amount of columns on the page, print using 
Landscape orientation (if your printer supports it).

• The report includes all the columns (including those that were hidden), 
listed in the original order.
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Setting Parameters in the Job Parameters Window
This section describes each area in the Job Parameters window, and explains how to 
set the job parameters.

For more information about opening the Job Parameters window, see The Job Parameters 
Window on page 17.

The Print Settings Tab

Print Mode
In the Print Mode area, select the desired print mode:

Composite (default setting)—prints the job without separations. Each page 
of the job is printed once.

Separations—prints the job with color or grayscale separations. If you select 
color separations, each page in the job is printed separately in four colors: 
cyan, magenta, yellow, and black. If you select grayscale, each page in the job 
is printed separately four times in different shades of grayscale (K).
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Progressive—prints each page of the job four times in progressive color 
separations:

Sheet 1 is printed only in C.

Sheet 2 is printed in C and M.

Sheet 3 is printed in C, M, and Y.

Sheet 4 is printed in C, M, Y, and K.

Custom—enables you to select the separations that you want to print for 
each sheet for each page of the job.

Number of Copies
Type the number of copies to be printed.
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Print Range
Select the desired print range.

To select specific pages/booklets or page ranges, select Pages/Booklets and 
specify the pages or booklets to be printed as follows:

Type one or several numbers separated by commas and no spaces—for 
example, 1,3,5.

Type a range of pages or booklets with a hyphen between the starting and 
ending numbers in the range—for example, 1-5.

Print Method
Select one of the following options:

Simplex for single-sided printing

Duplex head to toe for calendar-style hard copies (usually used with 
landscape jobs)

Duplex head to head for printing book-style hard copies (usually used with 
portrait jobs)

Print Order
Set the print order to From 1 to N (front to back) or From N to 1 (back to front).

Delivery
Select Face up or Face down as the delivery option.

Collation
Select the Collation option:

Yes prints a complete copy of the job before the first page of the next copy 
prints

No prints all copies of each page before going on to the next page

Image Position
This option enables you to adjust the image positioning on the sheet’s printed page 
(simplex or duplex). The following terminology is used: 

• Rear is the sheet's edge near the printer rear, where printing stops

• Lead is the edge of a sheet at which printing begins

Note:  For imposed jobs, instead of typing the desired pages, you should 
type the desired imposed sheets.

Note:  To collate a document and print the set in the correct order, select Face 
down and From N to 1 or Face up and From 1 to N.
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The page’s lead and rear edges are determined just after the page is printed out, 
before making any change in the page orientation. 

Select one of the following:

To print your job in the center of the page, click Center

To set page offsets, click the directional arrows or type Rear and Lead values

To apply page offsets values to both odd and even pages, select the Same on 
both sides check box.

Image Scale
Perform one of the following:

To print the original image size, select 100% (default).

To fit the image to the selected paper size, select Fit to Paper.

To custom size the image, select Custom and type the percent by which you 
would like to proportionally increase or decrease the image size.

Rotate 180°
To rotate your job by 180°, select Yes.

Gallop
Gallop enables you to begin printing a defined number of pages before the entire job 
has been RIPed.

To enable this option, select Yes and enter the number of pages to RIP before 
printing starts.

Tip:  Use this option to move duplex page data away from the spine.

Note:  If you also select Finisher Module > HCSS Staple Tray, the staple 
position is modified. For example, instead of stapling on the upper left-hand 
corner, you can staple on the lower right-hand corner.
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The Paper Stock Tab

Paper Set Name
Select the desired paper set from the Name list. If desired, a paper set can be 
added.

The selected paper set values (Paper Size, Type, Weight, and Coating) appear in 
the corresponding parameters in the Paper Stock tab.

For more information on managing paper sets, see Managing Paper Sets on 
page 44.

Paper Size
From the Size list, select the desired stock size. If you select Custom, perform 
the following actions:

a. Type the desired Height and Width. 

b. Select the desired Feed Direction:

• LEF (Long Edge Feed)

• SEF (Short Edge Feed)

Type 
1. Select one of the following options:

Paper

Transparency
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2. If you want to insert a blank page between transparencies, select the Add 
Interleave check box and customize the interleave by performing one of the 
following actions:

• Select the desired paper set from the list

• Select Same as job to use the default paper size

• Click the browse button  and add a new paper set

For more information about adding a paper set, see Managing Paper Sets on 
page 44.

3. In the Tray list, select the desired tray and load the specific stock in this tray. If 
you select Auto, any tray with the specific paper stock is used. 

Weight
From the Weight list, select the desired stock weight. 

Coating
Select Coated to print on coated paper.

Tray
In the Tray list, select the desired tray and load the specific stock in this tray. If 
you select Auto, any tray with the specific paper stock is used.

Mixed Paper Size
Select the Mixed paper size document check box if the job contains different 
paper sizes.

Notes:

• Slip-sheets and/or blank pages (interleave) in a transparency job are 
counted by the number of sheets, not by the number of pages, 
(rastered pages) reported on the Admin page.

• If the job is imposed, the interleave is the size of the imposition sheet 
and is inserted between each sheet.

Note:  For the DocuColor 8000AP, the paperweight ranges are: 60-80 gsm, 81-
105 gsm (default), 106-135 gsm, 136-186 gsm, 187-220 gsm, and 221-300 gsm.

Notes:

• The Auto tray option uses the paper in the selected tray only if it 
complies with all the other paper stock parameters. If the paper stock in 
the assigned tray mismatches with any Job Stock parameter, the job is 
frozen.

• If you selected the Custom Paper Function option in the Settings 
window (see General Defaults on page 166), in the Custom Profile list, 
select the custom profile.
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The Print Quality Tab

Text /Line Quality
The Text/Line Quality parameter improves text quality. Text/line quality and text 
and line-art elements are processed separately to produce optimal rendering of all 
the elements on a page. This option improves the text quality of diagonal lines, 
borders, and blends; causes blends to appear smooth with no banding; and displays 
crisp diagonal lines without (or with minimal) jaggies (rough edges) which are the 
result of the limited resolution of the print engine.

1. In the Text/Line quality options area, perform one of the following actions:

• Select Text Line Resolution, and select one of the following options:

• Normal (default) provides regular text quality.

• High smooths LW elements and renders contours to 1200 dpi.

• Max smooths LW elements and renders contours to 2400 dpi.

• Select Edge Enhancement to enhance edges (LW only)

2. In the Enhance area, select the elements you want to enhance:

• Overlapping elements improves the edge quality of overlapping vector and 
image elements—for example, text on top of a transparent image

• Text/Line in images improves the resolution of text and line-art in images—
for example, scanned images or screen captures

Note:  You cannot merge jobs with different gray font rendering.

Note:  If you select Overlapping elements, the corresponding 
enhancement is automatically selected in the Image Quality 
parameter.
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Image Quality
The Image quality parameter refers to the ability to maintain the same detail and 
smoothness with different degrees of enlargement. This feature is especially useful 
when your PostScript file includes several images of different qualities—for 
example, images that were scanned at different resolutions, were rotated, or were 
downloaded from the internet.

1. In the Image quality options area, select one of the following options:

High to provide superior image quality. This setting applies the Creo 
proprietary smooth scale algorithm, which improves the quality of images 
containing several resolutions (such as images taken from the Internet).

Normal (default) to provide normal image quality (for jobs that do not 
require improved picture quality)

2. In the Enhance area, select the Overlapping elements check box to improve the 
quality of overlapping vector and image elements.

Trapping
Trapping is a solution that solves misregistration between color separations in both 
offset and digital printing. Misregistration occurs regardless of the accuracy of the 
printing device and results in white lines around objects on top of a background (in 
a knock-out procedure) and also between adjacent colors. Trapping extracts the 
element or the background and creates an overlap between them. 

1. To set trapping, select Yes.

2. In the Frame Thickness box, select the default thickness (0.08mm/0.003 
inch), or type the desired value. The thicker the frame, the less chance that 
white areas appear between images.

Note:  If you select the High option, the processing speed is decreased.

Note:  If you select Overlapping elements, the corresponding 
enhancement is automatically selected in the Text/Line Quality 
parameter.

Note:  Do not use this option with VI jobs.

Notes:

• If you select Yes, the Frame Thickness and Protect Small Text 
options are activated. These options cannot be selected through the 
PPD.

• If you select No, trapping incorporated by DTP software (for example, 
Photoshop) is not affected. Creo Full Auto Frame trapping software 
(FAF) should not be used with software-based trapping. In a PostScript 
file that already contains trapping from the originating software, it is not 
necessary to use CX Print Server trapping.
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3. Do one of the following actions:

• Select the Protect Small Text check box to prevent the trapping of text that 
is 12 points or less.

• Clear the Protect Small Text check box to trap all text elements.

Black Overprint
Select Yes to ensure that black prints cleanly within a tint or picture area.

The text appears in a richer, deeper black, with the underlying CMY values equal 
to those of the printed background.

PS Overprint
Select Yes to use the overprint information that exists in the input file.

This parameter also determines whether the DTP software overprint settings are 
honored in the RIP.

Image Noise
The Image Noise parameter enables you to smooth and blend vignettes of 
continuous tone (CT) images.

Select Yes to set the image noise level and move the slider to change the noise 
level as desired.

The Color Tab

Tip:  Apply the Protect Small Text option to small or complex images to 
ensure their quality is not decreased.
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Color Mode
Select one of the following options:

Color to print the job in color using CMYK

Grayscale to print the job as black and white using black (K) toner only

RGB Workflow
The RGB workflow parameter enables you to select an RGB profile and apply it to 
RGB elements in your job. You can use predefined profiles or, to achieve better color 
results, import your own custom profile via the Profile Manager.

To select RGB workflow options:

1. In the RGB workflow list, select the desired RGB source profile: 

• To use the embedded color space array (CSA) or source CSA, select Use 
SourceCSA.

• To use a Spire or Adobe CSA, select a CSA from the list. The default option 
is SpireRGB_2.1.

• To use a custom RGB profile, select the profile name from the list.

2. In the Rendering intent list, select the desired option.

For a definition of “rendering intent”, see page 222.

3. To print RGB gray text and graphics with black toner only, select the Print grays 
using black toner check box.

CMYK Workflow
The CMYK workflow option is used to emulate various standards used in 
lithographic printing. These standards represent specific combinations of paper and 
ink, as well as popular proofing systems. This option is also used to emulate other 
digital printers or other printing devices, such as offset presses. An example of a 
CMYK workflow job would be printing a test sample for a survey before moving to 
an offset press to print millions of survey forms. In such a case, it is best to emulate 
the offset press before the job actually goes to offset printing.

Under CMYK workflow, you can also specify the desired rendering intent for CMYK 
elements.

Note:  If the job contains grayscale images that were created in RGB 
software, such as Microsoft PowerPoint, specify as monochrome. This 
selection ensures that the CX Print Server and DocuColor 8000AP billing 
meters count the grayscale images as black and white instead of color.

Note:  The Print grays using black toner check box not only affects 
R=G=B values but may also result in slightly different values 
(R+/-4=G+/-4=B+/-4) to produce gray.

Note:  The CMYK workflow optios does affect RGB colors.
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To select CMYK workflow options:

1. In the Original list, select one of the following options:

• Direct to print the CMYK elements without any color transformation

• Use Source CSA to use the embedded CSA from the PostScript file

2. In the Emulation list, select the desired emulation.

• To emulate the original paper tint, select the Emulate source paper tint 
check box.

• To convert RGB elements according to the selected CMYK emulation 
method, select Emulate RGB elements . The RGB elements receive the 
same look as the CMYK elements, creating a consistent appearance.

• To preserve pure cyan, magenta, yellow, and black during transformation, 
select the Preserve pure colors check box .

3. In the Rendering intent list, select the desired option.

For a definition of “rendering intent”, see page 222.

Spot Workflow
By default, the CX Print Server searches the spot color dictionary for the correct 
value for each recognized spot color. 

For more information about the Spire spot color dictionary, see Spot Color Editor on 
page 128.

Select the relevant options:

Select Use Spire spot color dictionary to have the CX Print Server use spot 
colors in the dictionary

Select Protect RGB colors to retain RGB colors as defined

Select Protect CMYK colors to retain CMYK colors as defined  

Destination Profile
Select the desired profile, or select Linked to use the destination profile that was 
mapped to a paper color in the Profile Manager.

Note:  The system emulates the selected option during the RIP process. 
GCR and CMYK emulation do not affect the processed job.

Notes:

• The Emulate source paper tint check box is available only if you 
select Device Link as the emulation method.

• When you select the Emulate source paper tint check box, the CX 
Print Server applies the absolute colorimetric rendering method.

Note:  If you protect RGB or CMYK colors, all colors in the job with that specific 
combination will be protected. For example, a specific color combination used 
in a logo may align with a color used in an image in the job. The spot 
transformation affects the image’s color as well as that of the logo, sometimes 
producing undesired results.
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There are four predefined CX Print Server profiles:

• DC7000_DC8000_GA—professional-look graphic arts profile

• DC7000_DC8000_GA2—professional-look graphic arts profile with 
enhanced, cleaner RGB reds

• DC7000_DC8000_COM—gives pure appearance for blues and reds in CMYK 
emulation (for commercial use)

• DC7000_DC8000_COM2—COM profile with a modified RGB gamut (for 
commercial use)

For more information on managing destination profiles, see Profile Manager on 
page 125.

Screening
Screening converts Continuous-Tone (CT) and Line-Work (LW) images into 
information (halftone dots) that can be printed. The human eye smooths out this 
information, which seems visually consistent with the original picture. Thus, the 
more lines per inch, the more natural the image appears.

Screening is achieved by printing dots in numerous shapes or lines in an evenly 
spaced pattern. The distance between the screen dots or lines is fixed and 
determines the quality of the image.

Using screening, printers can work with even amounts of toner and still produce a 
wide range of colors when you use screening. The darker the color, the larger the dot, 
or the thicker the line. In this manner, screens give the appearance of different toner 
quantities printed in a certain area.

To select a screening method:

In the Screening list, select the desired option. For CT images, use a dot option; 
for LW images, use a line option.

If you select Automatic, Dot 200 is used for CT images, and Line 200 is used for 
LW images.

Calibration 
The purpose of color calibration is to achieve a consistent level of color quality. 
Calibration corrects printer colors by measuring a color density chart. 

The CX Print Server calibration tool enables you to create and edit calibration tables, 
either through an automatic process or by editing an existing calibration table. The 
available calibration options are Normal, Saturated, and None.

For more information about calibration tables, see Creating a Calibration Table on 
page 115 and Editing Calibration Tables on page 119.

The Calibration parameter enables you to select the desired calibration table for the 
job.

To select a calibration table for a job:

In the Calibration list, select a calibration table. The default calibration table is 
Normal.

Tip:  For optimal printing performance, use the Normal calibration setting 
with Ink Saving (GCR) set to Medium.
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Ink Saving (GCR)
Gray component replacement (GCR) prevents the consequences of excessive toner 
buildup, such as flaking and cracking, and the curling effect that may occur when 
you print transparencies.

To set ink saving, select one of the following options:

None: no GCR is performed on the file, and the printer applies maximum dry 
ink coverage

Low, Medium, or High: the selected amount of CMY dry inks replaces the 
black dry ink.

Color Adjustments

Gradation

The Gradation list contains gradation tables that were created by the CX Print 
Server’s gradation tool. Each gradation table contains specific settings for 
brightness, contrast, and color balance.

When you select your predefined gradation table, your job is adjusted according to 
the specific table’s settings.

For more information about creating gradation tables, see Gradation Tool on 
page 133.

In the Gradation list, select one of the defined gradation tables. 

Brightness

Use this option to make last-minute adjustments to the print job after proofing. 

To select a brightness level for a job, move the Brightness slider to the desired 
brightness level (the range starts from Light, which applies -15%, to Dark, which 
applies +15%). 

Contrast

Adjust the Contrast option to control the difference between light and dark tones in 
your image.

To select a contrast level for the print job, move the Contrast slider to the 
desired contrast level (the range starts from Less, - which applies -10%, to 
More, - which applies +10%).

Note:  There is no change to the color quality of the printed image even though 
the gray component of each color is replaced by black.

No GCR Low GCR Medium GCR High GCR

Note:  Select High for minimum ink coverage and to save on toner. High 
also prevents curling effects.

Note:  The default setting is None—no gradation table is applied to your job.
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The Imposition Tab
The Imposition tab enables you to set job options related to the positioning, folding, 
trimming, and binding of pages.

Imposition Method
The Imposition Method parameter specifies the method with which printed sheets 
are imposed.

Select one of the following options:

None for no imposition (this is the default option). 

The imposition parameters become unavailable and the thumbnail viewer 
does not display an image.

Step & Repeat to print multiple copies of the same image on one sheet so 
that the sheet is filled to capacity. This method is used mainly for printing 
business cards.

Note:  If you use a dynamic page exceptions virtual printer to print a job, the 
Imposition tab is unavailable. For more information, see Dynamic Page 
Exceptions on page 99.

Note:  You can use specific step-and-repeat templates to print several 
different images on one sheet.
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Step & Continue to print different pages of a job on one sheet so that the 
sheet is filled to capacity.

Cut & Stack to print, cut, and stack jobs in the most efficient manner while 
preserving the original page order. A job’s pages, booklets, or books are 
sorted in a Z-shape. In other words, each stack of pages is sorted in 
consecutive order. When stacks are piled one on top of another, the entire 
job is already sorted up or down.

Saddle Stitch to print pages that are ready for the saddle-stitching book-
finishing technique. With this technique, the pages of a book are attached 
through stitching or stapling in the spine fold. The technique is usually used 
for printing brochures.

When using the saddle-stitch imposition method, you can select the sets per 
sheet. This option enables you to select how many sets of the job will print 
on one press sheet.

Perfect Bound to print pages that are ready for the saddle-stitching book-
finishing technique. With this technique, the pages of a book are attached by 
trimming the spine fold, roughening the edges of the gathered pages, and 
gluing them together. The technique is usually used for hardcover books.

Sizes
1. In the For sheet size use paper set list, select the desired paper set. If you need 

to add a new paper set, click the browse button .

Paper set defines the paper stock attributes (paper size, type, weight and 
coating) on which the imposed job will be printed. The CX Print Server enables 
you to define all the paper stock settings of an imposed job on the Imposition 
tab with no need to switch to the Paper Stock tab and define the paper stock 
settings there.

For more information about adding paper sets, see Managing Paper Sets on 
page 44.

Note:  If you select Cut & Stack, you cannot change settings on the 
Exceptions tab or define any exceptions.
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2. In the Trim Size list, select the desired trim size. Trim size is the size of the 
finished, trimmed document. You can adjust your page size by adjusting the 
trim size.

If you select Custom, define a custom trim size and type the desired height in 
the H box, and the desired width in the W box.

3. Select the desired Orientation (Portrait or Landscape) for the trim size. If you 
specify the wrong orientation, an unsuitable template might be selected and 
the job might be cropped.

Template
The Imposition method option that you select determines which layouts appear in 
the Layout list. There are two types of layouts:

• System layouts

The Custom option enables you to set up custom imposition parameters for 
this job. This layout is available for all imposition methods.

When the Best Fit option is selected, the server determines how many 
columns and rows will best fit the sheet and whether the pages need to be 
rotated 90 degrees according to the imposition method and paper size that 
you have chosen. The Best Fit layout is available for the Step & Repeat, Step 
& Continue, and Cut & Stack imposition methods.

• User-defined templates (created in the Imposition Template Builder)

For more information about user-defined templates, see Creating, Viewing and 
Modifiying Imposition Templates on page 72.

Note:  If you set the trim size to be smaller than the page size set in the DTP 
software, some of the data is cropped. Setting a larger trim size results in a 
larger border on the printed page.

Note:  If you select Best Fit or a user-defined layout, some or all of the other 
parameters are unavailable.
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To select Template options:

1. From the Layout list, select the desired layout.

2. Set the number of columns and rows. The columns and rows indicate how the 
pages will be placed on the sheet.

a. From the Columns list, select the number of pages to place horizontally. 

The template preview area displays your settings.

b. From the Rows list, select the number of pages to place vertically. 

The template preview area displays your settings.

3. From the Print Method list, select an option.

4. From the Binding method list, select an option.

5. Select the North South check box to place pages 180 degrees from each other, 
on the same side of the imposed sheet.

6. Select the Rotate 90 deg. check box to rotate all pages 90 degrees to the right. 
This rotation can help correct imposition conflicts.

Margins
Enter the desired margin sizes to adjust the spaces between the outside edges 
of pages and the edges of the sheet on which they are printed.

Margin settings must accommodate finishing equipment and requirements. 
Confirm binding parameters with your binder when planning your sheet.

Marks & Bleed
The Marks & bleed parameter enables you to mark where trimming and folding 
should occur. 

When you set bleed options, you extend part or all of the printed image beyond the 
trimming boundary. The bleed options ensure that an inaccurate trim setting will not 
leave undesired white space at the edge of the page. The bleed options produce 
sharp page boundaries with color that extends all the way to the edge of the page.

To select Marks and bleed options:

1. In the Marks area, select one of the following options:

a. To print lines that indicate where the sheet should be cropped, select the 
Crop Marks check box.

• To print the crop marks on both sides of the page, select the Both sides 
of sheet check box.

Note:  The Binding option is available only when Saddle Stitch or Perfect 
Bound is selected as the Imposition method.

Note:  This option is available only when the Step & Repeat method is 
selected and the number of columns and rows is 2×1 or 1×2.
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b. To print lines that indicate where the sheet should be folded, select the Fold 
Marks check box.

2. In the Bleed area, select one of the following options:

a. Maximum bleed to extend the bleed to the sheet fold lines.

b. Custom bleed size type the desired bleed size in millimeters.

Creep

The Creep parameter uses the following terminology: 

• Creep in specifies the amount of movement towards the spine applied to the 
center two pages and their backs (in other words, the pages that require the 
most amount of compensation). 

An ever-decreasing amount of movement is automatically applied from the 
center quartet of pages back to the outside four pages of the job (in other words, 
every quartet of pages is moved by an amount less than the previous quartet). 

• Creep out is used when you find that the page images are too close to the spine. 
This problem can be resolved by selecting a value for Creep out. This will move 
all the pages of the job further out towards the outside margin (away from the 
spine) by the specified amount. This movement takes place before the Creep in 
value is applied. 

To set the creep options:

1. In the Creep in area, select Auto to automatically set the creep based on paper 
stock weight, or type the desired amount for Creep in.

2. In the Creep out area, type the desired amount.

Notes:

• Crop marks are placed according to the Trim Size option. A minimum 
of 6 mm is required for crop marks, and 10 mm for fold marks.

• If your job already includes crop marks incorporated in the DTP software, 
you do not need to add crop marks here. If you do add crop marks, both 
sets of crop marks can be printed.

• If you want to use crop marks incorporated in the DTP software, make 
sure that enough space is left around your page in the PostScript file so 
that the page prints with crop marks.

Notes:

• You cannot extend the bleed size beyond the sheet fold lines. Bleed 
does not affect the position of crop.

• Bleeding must be defined in your DTP software in order for the CX Print 
Server to apply the bleed options.

Tip:  It is recommended that you use a border around all documents when you 
use creep.

Note:  The outside two pages and their backs are not moved (the value 0.0 
is used). 

Note:  Units of measurement (mm or inches) are set in the Settings 
window, see Localization on page 163.
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Scale
Under Scale, select one of the following options:

Scale by, to change the scale of all imposed sheets. This is the default option, 
set to 100%. In the % box, type a value from 25% to 400% for how you want 
to change the scaling of the imposed sheets.

Fit layout to sheet size, to fit the page layout to the sheet size.

The Preview Window
The Preview window enables you to view your imposition layout and settings. 

You can open the Preview window at any time and keep it open to check your 
imposition settings as you select them. The Preview window dynamically reflects 
any changes that you make.

To open the Preview window:

Click preview .

In the Preview window, you can perform the following functions:

• Click Front  to view the front pages.

• Click Back  to view the back pages.

• Move between sheets by clicking the navigation arrows  

• Jump to a specific sheet by typing a number in the navigation box.

Gray arrows indicate the direction of the pages on the sheet. The sequence of pages 
is indicated by the page numbers.

If any parameters conflict, Imposition Conflict appears in red in the Preview 
window and also on the Imposition tab.

Note:  Changing the scaling percentage affects the margins of the job. The 
margins are updated in proportion to the percentage that you choose.

Note:  The Preview window is not available if the Imposition method is set to 
None.
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A red border along the edge of the page indicates where the conflict exists. 

• If the red border appears along the upper and lower edges of the page, a conflict 
exists in the Height value.

• If the red border appears along the left and right edges of the page, a conflict 
exists in the Width value.

Problematic values appear in red.

The Services Tab

Note:  To preview the imposed job in the Job Editor window, Imposed 
sheets tab, see Viewing and Editing Job Parameters on page 28.
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Job Deletion
Select this parameter to delete each page on the fly after it has been successfully 
printed. In this way, the CX Print Server maintains enough free disk space for the 
duration of the print run. Reusable elements are not deleted.

To set a deletion policy:

1. Suspend the Process Queue and import your job.

2. Double-click your job to open the Job Parameters window.

3. On the Services tab, in the Automatic deletion options area, select one of the 
following options:

• To remove pages or jobs after printing is completed, select Delete after 
complete.

• To remove failed jobs while processing or printing, select Delete on job 
failure.

4. Click Save. 

5. Select the resume button to resume the Process Queue and start the 
processing of your job.

Substituting Fonts
Select one of the following options:

Yes to substitute a missing font with the default font that is set in the 
Settings window.

No to stop the job processing if the desired font is missing.

For more information on managing fonts, see Fonts on page 101.

APR
For more information on APR, see Creo APR on page 81.

1. In the APR options area, select one of the following options:

• Print with high res to replace low-resolution images in your job with high-
resolution images that are located in a specified APR path.

• Print with low res to print the job with the existing low-resolution images—
for example, for proofing purposes.

Notes:

• This option sustains enough free disk space for the duration of the print run 
and only affects the sub-job. 

• The Variable Print Specification file is also deleted.
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2. In the Use APR mask from area, select one of the following options:

• PostScript image to use the masking data contained in the 
low-resolution image file.

• High res to use the masking data contained in the high-resolution image file.

• Both to use the masking data that is common in both 
high-resolution and low-resolution image files—for example, if the images 
defined by the two sets of masking data overlap, the overlapping area is 
RIPed.

Setting a High-Resolution Path

There are two default paths in which the CX Print Server searches for high-
resolution images:

• Search in the input folder: The CX Print Server first searches for high-resolution 
images in the same folder as the PDL file. 

• D:\Shared\High Res: If you want to save your high-resolution files in this folder, 
copy the files to D:\Shared\High Res. 

You can also add a new high-resolution path, and then edit, or delete the path.

Paths other than the default paths are defined on a per-job basis, or set in the virtual 
printer. You can specify paths on local hard drives, CD-ROM drives, and the floppy 
drive connected to the CX Print Server. You can also specify paths on remote clients 
or file servers.

To add a high-resolution path:

1. Under the APR path box, click Add.

The HiResPath dialog box appears.

2. Click the Add button .

The Open dialog box appears.

3. Locate your high-resolution images, and then click Select.

The new path is displayed in the HiResPath dialog box.

4. To promote or demote a selected APR path, use the arrow buttons.

To modify a high-resolution path:

1. In the HiResPath dialog box, select the path you want to modify.

2. Click the Edit button .

The Open dialog box appears.

3. Locate your high-resolution images, and then click Select.

The new path is displayed in the HiResPath dialog box.

Note:  If the masking data in the low-resolution image file defines a 
completely different part of an image than the masking data in the 
high-resolution file, no masking data is used.

Note:  The order in which the APR paths are listed is the order in which the 
CX Print Server searches for the high-resolution images.
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To delete a high-resolution path:

1. In the HiResPath dialog box, select the path you want to delete.

2. Click the Remove button .

The selected path is deleted.

Job Flow 

This parameter enables you to specify a job flow for a job that is imported to the CX 
Print Server from the network or from the CX Print Server folders.

Select the desired job flow option:

Process & Print to set the CX Print Server to RIP, print, and store the PDL files 
in the Storage window (unless the Job Deletion parameter is set to Delete 
after Complete).

Process & Store to RIP and move the PDL files to the Storage window as RTP 
jobs.

Spool & Store to place the PDL files directly into the Storage window without 
processing them.

Compression
Some jobs can fail to print because they contain images that cannot be compressed. 
Increasing compression can resolve this problem.

Select one of the following options:

Normal for normal compression

High for higher compression

Preflight
Select Run Preflight check to check the status of key job components before the 
job is sent for printing.

Your job is RIPed and the missing components are identified.

You can set the preflight check to detect the status of the following key job 
components:

High-resolution images

Incorrect links to the high-resolution images folder

Missing fonts

Spot colors that are not defined in the CX Print Server spot color dictionary

Note:   This option can be defined only through the PPD parameters of the 
virtual printer.

Note:  Choosing a higher compression can result in lower quality.

Note:   If a job component is missing, the job fails before it is RIPed and an alert 
message appears. The job is transferred to the Storage window. Information 
about missing components appears in the Job History window.
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The results of the preflight check are displayed in a Preflight Report. To issue this 
report, right-click the RTP job in the Storage window and select Preflight Report.

For information on the Preflight Report, see Preflight Report on page 106.

Job Slug
1. To print a slug in the margins of your job, select the desired options:

• Color bar to print a measurable color bar. Looking at this bar, you can tell the 
state of the printer and whether the quality is consistent. You might need to 
calibrate the printer or perform color proofing.

• Job name

• Sheet number and side (front/back)

• Date and Time

2. In the Comment box, type comments up to 30 characters.

Job Info
This parameter provides the following information:

• Job title—the original name of the file related to this job

• Sender—the user name of the system from which this job originated

• Account—the account number of a specific customer or group

• Recipient—the name of the customer

• Job comments— any special instructions that you want to include with your job

Job Link
This parameter displays the relevant URL for the linked elements of JDF jobs.

Click the link to open the linked element.

Split to Booklets
The Split to booklets parameter enables you to split a PostScript, PDF, or large VI job 
that does not have a booklet structure into booklets. 

1. In the Split to booklets options area, select Yes.

2. In the Number of pages per booklet box, type the desired number.

Note:  Unexpected results might occur when you use this option for VI jobs that 
already have a booklet structure.

Note:  If the specified number of pages per booklet is not sufficient to 
produce complete booklets and there is a remainder of pages, the last 
pages will form a booklet that contains less pages than specified.
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PDF/PS Optimization
Use this option if you have a PDF or PostScript job with repeated elements and want 
to significantly decrease processing time by applying the PDF/PS workflow.

Select the relevant option.

The repeated elements are cached once, and then reused without repeated 
processing.

The Finishing Tab

Administration Page
The administration page contains job-related information, such as the job title, the 
name of the sender, the date and time that the job was submitted, account 
information, and comments.

The Administration page is printed in the same order as the job. For face-down 
printing, the page is printed before each set; for face-up printing, the page is printed 
after each set.

To print an administration page:

Select the Print Admin page check box and set the specifications as desired.

Important:  Verify that in your Distiller software settings, Optimize for Fast 
Web View is selected (in Acrobat 4.0 the corresponding option is Optimize 
PDF).

Note:  If you change the options in the Admin page parameter, you must re-RIP 
the job.



Setting Parameters in the Job Parameters Window 209

Slip Sheet
You can print slip sheets with your job and select a different paper set in which to 
print the slip sheet. If the job is collated, the slip sheets will be printed between sets. 
If the job is not collated, the slip sheets will be printed between groups.

To set slip sheet options:

1. Select the Print slip sheet check box.

2. In the Paper set list, select the desired paper set. If you need to add a new 
paper set, click the browse button.

For more information about adding paper sets, see Managing Paper Sets on 
page 44.

3. In the Tray list, select the desired tray.

4. In the Frequency list, type the number of slip sheets you want to print. The 
default is 1; a slip sheet is printed between each set.

Front Cover
By default, your job is printed without a front cover. You can choose to print a front 
cover using the same or a different paper set, as desired. 

To print a front cover:

1. Select the Print front cover check box.

2. In the Paper set list, select the desired paper set. If you need to add a new 
paper set, click the browse button.

For more information about adding paper sets, see Managing Paper Sets on 
page 44.

3. In the Tray list, select the desired tray.

4. In the Cover printing area, select one of the following options:

• None to print a blank front cover.

• Print on front side to print the first page of the job as the cover page.

• Print on both sides to print the first two pages of the job as the cover page.

Back Cover
By default, your job is printed without a back cover. You can choose to print a back 
cover using the same or a different paper set, as desired. 

Note:  A blank page is automatically inserted between the cover page 
and the first page of the job so that both sides of the cover page are 
defined, and the job starts on the next odd page.
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To print a back cover:

1. Select the Print back cover check box.

2. In the Paper set list, select the desired paper set. If you need to add a new 
paper set, click the browse button.

For more information about adding paper sets, see Managing Paper Sets on 
page 44.

3. In the Tray list, select the desired tray.

4. In the Cover printing area, select one of the following options:

• None to print a blank back cover.

• Print on back side to print the last page of the job as the back cover.

• Print on both sides to print the last two pages of the job as the back cover.

Finisher
The Finisher parameter enables you to select the destination of the printed output.

In the Module list, select one of the finisher options:

OCT (offset catch tray—default)

• The Offset checkbox is selected by default. If you don’t want to use an 
offset between sets, clear this check box.

EHCS (enhanced high capacity stacker)

a. Select the relevant tray type (Top Tray or Stack Tray).

b. If you have a chained EHCS, select the desired tray from the drop-down list.

c. If you selected Stack Tray, select the Offset check box for the following 
types of jobs:

• Collated to offset each copy from the next copy.

• Uncollated to insert an offset sheet when a new page number is 
delivered (when you are printing more than one copy of each page).

Note:  A blank page will automatically be inserted between the back 
cover and the last page of the job so that both sides of the back cover 
are defined.

Note:  The available stapling methods for PostScript files depend on the page 
orientation and size. The stapling methods for PDF files depend on the page 
size.

Note:  If the page size is larger than A3 (standard or custom), the 
Offset check box is unavailable.
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HCSS (high capacity stacker stapler)

a. Select the relevant tray type (Top Tray or Stack Tray).

b. If you selected Stack Tray, select one of the following options:

• Offset to use an offset.

• Stapler to select stapling.

c. If you selected Stapler, select the desired staple location (Front, Rear, or 
Dual).

DFA (document finishing architecture)

a. Select the desired Profile from the list, according to the profile set in the 
printer you are using.

b. Select the desired Function, according to the profile set in the printer you 
are using. 

The Exceptions Tab

The Exceptions tab enables you to add and delete page exceptions and inserts. 

For more information about the dynamic page exceptions workflow, see Dynamic 
Page Exceptions on page 99.

Managing Exceptions
You can add and delete exceptions.

Note:  You also use the Exceptions tab to map paper sets for dynamic page 
exceptions.



212 Chapter 9 —Setting Parameters

 

To add exceptions to a job:

1. In the Exception area, click the Add button .

2. In the From and To boxes, type the desired page range for the exception. 

3. In the Paper set list, select the desired paper set. If you need to add a new 
paper set, click the browse button.

For more information about adding paper sets, see Managing Paper Sets on 
page 44.

4. In the Tray list, select the desired tray.

5. To set image position options:

a. Click Advanced.

b. Clear the Same as job check box. 

c. To shift an image, follow one of these steps:

• Click the arrows to shift the image on both sides.

• Type a value in the Rear and Lead boxes.

d. To set the values back to 0.0, click Center Image.

e. Click Save.

6. Click Apply.

The exception is added to the Exception area.

To delete an exception:

1. In the Exception area, select the desired exception and click the Remove button 

.

2. In the confirmation message, click Yes.

Managing Inserts

To add an insert:

1. In the Insert area, click the Add button .

2. In the After page box, type the number that will precede the insert. 

3. In the Quantity box, type the number of inserts that you want.

4. In the Paper set list, select the desired paper set. If you need to add a new 
paper set, click the browse button.

For more information about adding paper sets, see Managing Paper Sets on 
page 44.

5. In the Tray list, select the desired tray: 

Note:  The default paper stock properties are those specified for the job.

Note:  The default paper stock properties are those specified for the job.
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6. Click Apply.

The insert is added to the Insert area.

To remove an insert:

1. In the Insert area, select the desired insert and click the Remove button .

2. In the confirmation message, click Yes.

Setting PPD File Parameters
You can set job parameters from a client workstation in three ways:

• Through a virtual printer with predefined PPD file settings

• Through the CX Print Server PPD file

• Through the CX Print Server Print Driver software (for more information, see CX 
Print Server Print Driver Software on page 62

Viewing the PPD File
To print a file from Windows, first set up a CX Print Server virtual printer with the 
appropriate PPD file. The PPD file contains all the parameters and paper stock 
definitions for the printer and enables you to print your file properly.

The following table lists the available PPD file parameters. 

Notes:

• In the PPD file, the Printer’s Default option is selected for all PPD file 
parameters. The Printer’s Default option corresponds to the settings of the 
currently selected virtual printer.

• Print settings defined in the job file override the settings of the virtual printer.

Table 19: PPD parameters

PPD Parameter Printing Options

Print Method See Print Method on page 186.

Image orientation for imposition See Sizes on page 198.

Reverse Print Order See Print Order on page 186.

Face Up See Delivery on page 186.

Collation See Collation on page 186.

Image Scale See Image Scale on page 187.

Rotate 180 See Rotate 180° on page 187.

Paper Set See The Paper Stock Tab on page 188.

Type See Type on page 188.
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Weight See Weight on page 189.

Coating See Coating on page 189.

Text/Line Quality See Text /Line Quality on page 190.

Image Quality See Image Quality on page 191.

Trapping See Trapping on page 191.

Black Overprint See Black Overprint on page 192.

PS Overprint See PS Overprint on page 192.

Image Noise See Image Noise on page 192.

Color Mode See Color Mode on page 193.

RGB Workflow See RGB Workflow on page 193.

Gray RGB See RGB Workflow on page 193.

Rendering Intent for RGB For setting this parameter, see RGB Workflow on page 193. 

For more information on rendering intent, see rendering intent 
on page 222.

CMYK Workflow See CMYK Workflow on page 193.

Emulate Source Paper Tint See CMYK Workflow on page 193.

Emulate RGB Elements See CMYK Workflow on page 193.

Preserve Pure Colors See CMYK Workflow on page 193.

Rendering Intent for CMYK See CMYK Workflow on page 193.

Use Spire Spot color dictionary See Spot Workflow on page 194.

Destination profile See Destination Profile on page 194.

Calibration See Calibration on page 195.

Screening Method See Screening on page 195.

Ink Saving (GCR) See Ink Saving (GCR) on page 196.

Brightness See Color Adjustments on page 196.

Contrast See Color Adjustments on page 196.

Automatic Deletion See Job Deletion on page 204.

APR See APR on page 204.

Job Flow See Job Flow on page 206.

Table 19: PPD parameters

PPD Parameter Printing Options
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Split to booklets See Split to Booklets on page 207.

Admin Page See Administration Page on page 208.

Slip Sheet See Slip Sheet on page 209.

Finisher Module See Finisher on page 210.

Finisher Offset See Finisher on page 210.

Staple Options See Finisher on page 210.

Mixed paper size document See Mixed Paper Size on page 189

Account See Job Info on page 207.

Recipient See Job Info on page 207.

Job Comments See Job Info on page 207.

Table 19: PPD parameters

PPD Parameter Printing Options
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24-bit/3-byte image An image that is either CMY or RGB and uses 8 bits for each CMY or 
RGB pixel. Since 3 bytes equal 24 bits, these images are also known as 
24-bit images. This system is used for high-quality video imaging and 
scanning. For process color printing, a fourth color (black) is added for 
optimum effect. 

32-bit/4-byte image An image that uses 8 bits each for CMYK pixel, or 8 bits for each RGB 
pixel and 8 pixels for a mask layer or other future use. Since 4 bytes 
equal 32 bits, these images are also known as 32-bit images. An 8-bit 
CMYK image is the minimum required for high-quality print 
reproduction.

4-color printing A color reproduction method used to create full color output by 
overlaying cyan, magenta, yellow, and black inks.

8-bit/1-byte image An image limited to either 256 tones of one color or 256 different 
colors. Since 1 byte equals 8 bits and each bit has two choices, 1 byte 
equals 256 possibilities. 

absolute colorimetric A method of color matching during the translation of files from one 
device to another. The absolute colorimetric method refers to the use 
of device-independent color space.

additive color model A color system in which the picture is composed of a combination of 
red (R), green (G), and blue (B) light transmitted by the original 
subject. This system is effective for monitors and televisions but not 
for print. Scanners normally scan in RGB, which is then converted to 
CMYK for printing. See also CMYK, process colors, and RGB.

aliasing A steplike effect in which angled lines or curved edges of elements in 
an electronic image look broken or jagged. Aliasing occurs when an 
image is produced in a grid format. You can reduce the effect by 
increasing the resolution or using a technique called antialiasing, 
which softens the edges.

amplitude-modulated (AM) 
screening

A type of halftone screening in which the size of the dots varies but the 
spacing between dot centers is constant. For darker areas, the dots are 
bigger, and for lighter areas, they are smaller. Compare to frequency 
modulated (FM) screening.

anti-aliasing A technique to soften the jagged appearance of the edges of an aliased 
image. See aliasing.

Automatic Picture Replacement 
(APR)

Creo technology in which two versions of a file are created-a high-
resolution file and a low-resolution file called PSImage. You use the 
latter file for positioning and manipulating images in DTP software. 
The high-resolution file automatically replaces the low-resolution 
version during the RIP process. See also PSImage.

Glossary
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binding The process by which pages of a book or other publication are 
attached to one another.

bit Contraction of binary digit, the smallest unit of information in a 
computer. The information consists of one of two values-1 
(representing true, or on) or 0 (representing false, or off). See also 
byte.

bitmap One-bit images composed of individual pixels. Bitmaps can be used 
on-screen or printed on paper. 

bleed An extra amount of a printed image that extends beyond the trim edge 
of the sheet or page. 

booklet In a variable information (VI) job, a personalized copy of a document. 
A booklet can consist of several pages, but the entire document is 
targeted at a specific individual or address. VI jobs contain elements 
that differ from booklet to booklet, including text, graphics, pictures, 
and page backgrounds. See also variable information (VI) job.

byte A grouping of 8 bits of stored information, giving 256 levels of data. 
Each byte represents a value or character such as a letter or a number. 
In a color system, a byte can describe one of 256 distinct shades. 

CMYK Cyan, magenta, yellow, and black, the printing colors for process color 
production.

color gamut The range of possible colors in any color system. 

color separation The process of splitting a file into single-color components. For 
example, a CMYK file is separated into four files, each containing only 
one color-cyan, magenta, yellow, or black. Color separation also refers 
to the data for a single-color channel used to create an image. See 
CMYK.

color space array (CSA) A three-dimensional or four-dimensional lookup table that contains 
data for translating a device-dependent color space into a device-
independent L*a*b* color space.

Commission Internationale de 
l'Eclairage (CIE)

In English, International Commission on Illumination. This commission 
established a color specification based on the perception of an 
"average standard observer" in different types of lighting (illuminants). 
CIE color coordinates specify proportions of the three additive colors 
required to produce any hue and are used for comparative color 
measurement.

composite mode A mode of operation in which all the color information associated with 
a particular page is described on one page of a PostScript file. During 
RIP, the file is separated into process colors and spot colors, one file for 
each color. This mode of operation is the fastest and most efficient in 
most cases.

continuous-tone image An image that is represented by a series of evenly graduated tones 
rather than by pure black and white. In some Creo systems, gradient 
tones and continuous-tone data are converted to CT format.
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creep The extension of middle pages of a folded signature slightly beyond 
outside pages. Shingling compensates for creep. 

crop To eliminate portions of an illustration or photograph so the remainder 
is clearer, more interesting, or able to fit in the layout. 

degradé A gradual blend or transition between colors. Also known as vignette 
or graduated blend.

desktop color separation (DCS) An EPS format containing five files: four of the files contain the 
separated color information for each of the CMYK colors and the fifth 
is a low-resolution composite file for use in electronic page layout. 
DCS1 format has five separate files. One file acts as the preview and 
the other four contain the information for printing the different 
channels of CMYK color.

desktop publishing (DTP) The process of page production using personal computers, off-the-
shelf software and an output device such as a printer or imagesetter. 
Usually, these components form a system that is driven by a device-
independent page description language such as PostScript.

digital front end (DFE) In electronic publishing, the workstation or group of workstations 
containing the software for preparing pages of type and graphics; in 
prepress, the workstation that gives access to the user for the 
operation of hardware-for example, proofer, platesetter, imagesetter. 

digital proof A black-and-white or color image reproduction made from digital 
information without producing intermediate films. It can be output as 
a digital hard proof using a peripheral output device or displayed as a 
digital soft proof on a video monitor.

dot The individual element of a halftone.

dot area The percentage of an area covered by halftone dots ranging from no 
dots at 0 percent to a solid ink density at 100 percent. The size of a 
single dot is stated in a percentage of the area it occupies. 

encapsulated PostScript (EPS) A subset of the PostScript language. EPS describes images in a format 
that can be imported into other documents.

finishing stage Stage following the press process, which may include procedures such 
as laminating, perforating, and varnishing.

font A set of type characters used in a textual printing job. Fonts typically 
contain alphabetical and numerical type, as well as common special 
symbols, such as marks of punctuation. 

frame A thin line surrounding an image. Also known as keyline. Also a color 
overlap created intentionally at a color border so as to minimise the 
effects of misregistration. Also known as trap or grip. See also trapping.

frequency modulated (FM) 
screening

A method of creating halftones where the spots are all the same size, 
but the frequency or number of dots changes in a given area. There are 
more dots in a dark area and fewer in a light area.
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frozen job A job for which the appropriate paper stock is not available: for 
example, the correct paper type, size, or weight.

graduated blend See degradé.

gray component replacement 
(GCR)

A method for reducing the CMY amounts that produce the gray 
component in a color, without changing the color hue. 

grayscale Describing  a progression of gray tones from white to black. Digital 
grayscale images have up to 256 levels of gray. See also 8-bit/1-byte 
image.

halftone A negative or positive image whereby detail of the image is 
reproduced with dots varying area but of uniform density. Creates the 
illusion of continuous tone when viewed with the naked eye. The 
density of the dot pattern depends on the fineness of the screen 
(measured in lines per inch). The process of removing the screen (and 
reverting to a continuous tone image) is descreening.

highlights The whitest portions of the original or reproduction that have no color 
cast. The highlight dot is ranged in the reproduction from the smallest 
printable dot to approximately 25 percent. See also midtones and 
shadows. 

imposition The arrangement of pages on the front and back of a press sheet that 
will ensure the correct order of pages after the printed sheet is folded, 
bound, and trimmed.

job flow The job parameter settings of selected virtual printers, which are 
automatically applied to all jobs printed using those virtual printers. 
These settings determine how a sent or imported file is processed. For 
example, a file sent to a virtual printer with a Process & Print job flow 
will be RIPed, printed, and stored in the Storage Folder. A file sent to a 
Process & Store job flow virtual printer will be RIPed and stored, 
without printing.

LaserWriter driver A part of the Mac OS software that generates PostScript instructions 
from a file when the Print command is selected. A LaserWriter is an 
Apple laser printer.

line work Data characterized by sharply defined lines and very clear transitions 
from one color to another-for example, text. Line work is stored in the 
computer as a series of geometric (vector) drawing instructions.

long edge first (LEF) A printer page orientation where pages are delivered to the printer 
with the long edge of the paper going in first.

look-up table (LUT) A two or three-dimensional array of values stored for specified input-
output relationships. When one input value is known, the system can 
automatically determine the correct output value. For example, the 
system can find the needed dot size for a given set of printing 
conditions based on the stored gray level; color setups can be saved in 
color tables (color transformation tables) which are one of the many 
kinds of LUTs.
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metamerism Metamerism occurs when two colors match under one light source, 
but appear different under another light source. Those two colors are 
called a metameric match. A metameric match might cause problems 
when trying to match proofs to press-sheets under different lighting 
conditions.

midtones Density values of an image (original or reproduction) between the 
highlights and shadows. In a reproduction, midtones are printed with 
dot areas between approximately 40 percent and 60 percent 
coverage. See also highlights and shadows.

misregistration A situation common during printing, where one or more color 
separations is slightly misaligned with regard to the others on press. 
Misregistration shows up as white gaps or tinted overlaps at the 
borders of color pairs. Trapping is intended to ensure that white gaps 
do not appear when misregistration occurs. On contone images, 
misregistration can lead to blurring. See also overprint and trap (verb).

moiré An interference pattern caused by differences in halftone screen 
angles or rulings. In process color printing, screen angles are selected 
to minimize this pattern. 

OPI Abbreviation for Open Prepress Interface. A term relating to the use of 
low-resolution placeholder versions of high-resolution images. Low-
resolution images are automatically replaced with high-resolution 
images when a page layout is output. It minimizes high-resolution file 
travel across networks and offers faster page layout.

output resolution The number of separate image points (spots) that a device is 
physically able to write, expressed in lines per millimeter or lines per 
inch. Also called exposure resolution and plotter resolution. 

output tone curve A graph showing the relationship of original input densities and the 
corresponding dot percentages on film.

overprint To print over an area that has already been printed. 

perceptual rendering intent A compression of the total gamut from a source device's color space 
into the gamut of a target device's color space, when one or more 
colors in the original image are out of the gamut of the target color 
space. This preserves the visual relationship between colors by 
shrinking the entire color space and shifting all colors-including colors 
that are in-gamut. It is primarily used for photographic images.

PICT A file format used with Macintosh graphics and page-layout software 
as an intermediary for transferring files between software.

pixel A contraction of the words picture element. The smallest unit of a 
bitmapped image that appears on-screen.

PostScript A page description language developed by Adobe Systems, Inc. that 
describes the appearance (graphics and text) of a printed page. Also 
called PostScript Level 1. See also encapsulated PostScript (EPS).
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prepress The steps necessary to prepare a design for final printing on a printing 
press. May include preflight, color correction, color trapping, 
imposition, color separation, proofing, and imagesetting. Also called 
digital prepress.

printer description file A PPD file or PDF file that is used to prepare pages and documents for 
specific output devices.

Printer Description Language 
(PDL)

A computer language, such as PostScript, that describes an entire 
page as a series of codes, allowing for viewing or output on any device 
that can decode the language. Also called page description language.

process colors The four ink colors that are used to reproduce full-color images: cyan, 
magenta, yellow, and black (CMYK). Combinations of CMYK are used 
to reproduce many colors of the spectrum.

PSImage A low-resolution EPS file (also known as a Scitex.e file) that is part of 
the Automatic Picture Replacement (APR) workflow. You use PSImage 
files to position images in page layout. You can create and edit a 
PSImage file in various applications, such as PSImage Exporter in 
Photoshop, Copydot Toolkit, and oXYgen software. If you edit a 
PSImage file (for example, you add a mask or a clipping path), the  
Creo workflow software applies your changes to the high-resolution 
file and automatically replaces the PSImage file during the RIP process. 
See also Automatic Picture Replacement (APR).

quartertone Tonal values seen around the 25 percent range in tonal gradation 
between highlights and shadows. A quartertone is midway between a 
highlight and a midtone. See also highlights, midtones, and shadows.

raster Images or type that has been input, processed, and output line-by-line. 
Also called a bitmap. 

rasterization The process of converting a vector-based image to a bitmap. See also 
RIP (verb).

register (verb) To position two or more colors, images, or plates in exact alignment 
with each other.

register mark A small pattern (for example, a circle with a cross through it) 
positioned in non-imaged areas of negatives, positives, color 
separations, and plates to ensure correct alignment (register) of colors 
and/or images that will be printed in succession. Also called an angle 
mark. See register (verb). 

relative colorimetric A method of color matching. When translating colors from one device 
to another, it retains the colors that fall within the range of both 
devices.

rendering intent The compression method-a mathematical algorithm-used when 
mapping and translating colors from one color gamut to another. It 
allows for compression of out-of-gamut colors into the color capability 
of the press used.
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resolution The number of pixels, points, or dots per unit of linear measurement-
for example, pixels per millimeter on a video display or dots per inch or 
millimeter on film or paper. Resolution usually describes the same 
number of pixels on the vertical and horizontal axes-for example, a 
square millimeter with a resolution of 12 contains 144 pixels. The 
higher the resolution, the more image detail is recorded and the larger 
the digital file is.

RGB Abbreviation for the additive primaries-red, green, and blue. These 
colors are the predominant colors in the visible light spectrum that the 
human eye can detect. The RGB colors are used, for example, in video 
monitors, scanners, and other devices in which the light is direct and 
not reflected.

RIP (noun) A hardware and software configuration that is used with output 
devices to convert a vector-based image to a raster (bitmap) image. 
See also raster and vector drawing.

RIP (verb) To convert PostScript data to raster data.

saturated color A color in which the high and medium values approach 100 percent. In 
a clean, saturated color, the values of the wanted colors are near 100 
percent and the value of the unwanted color is near 0 percent. For 
example, for red, a combination of 5 percent cyan, 90 percent 
magenta, and 80 percent yellow is more saturated than 30 percent 
cyan, 90 percent magenta, and 80 percent yellow.

saturation The strength (chroma or purity) of a color. 

screen angle The angle of rows of halftone dots, expressed in degrees. During the 
printing process, the dot arrangement of each separation is placed at a 
different angle to the other separations. See also moiré.

screen ruling The density of dots on a halftone screen, commonly measured in lines 
per inch (lpi); also called line frequency, raster, or mesh.

shadows The darkest part of an image (original and reproduction). A shadow 
has densities near the maximum. In a reproduction, shadows are 
printed with dot areas between 80 percent and 100 percent. Compare 
to highlights and midtones.

short edge first (SEF) A printer page orientation where pages are delivered to the printer 
with the narrow edge of the paper going in first.

signature A printed sheet folded into 4, 8, 16, or 32 pages to form a section of a 
book or pamphlet. Also called a form. Signature also refers to the flat 
printed sheet that will later be folded.

solid An area of an image that is printed with a dot area of 100 percent. See 
also highlights, midtones, and shadows.

spectrophotometer An instrument that takes spectral readings of color wavelengths from 
a color sample. 
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spot color An additional separation (fifth or more) that is used with special inks 
to achieve difficult color combinations, such as gold or chocolate 
brown. Graphic artists sometimes use spot colors to define corporate 
colors or company logos. In the CX Print Server, spot colors are 
translated into CMYK values by means of a dictionary in which 
userscan edit the CMYK values.

step and repeat The procedure of copying the same image by stepping it in position 
both horizontally and vertically according to a predetermined layout.

three-quartertone Tone area of an image that has density values between the midtone 
and the dark point. Three-quartertone is typically printed with a dot 
area near 75 percent.

tone compression The reduction of the density range of an original to the density range 
achievable in the reproduction.

tone reproduction curve A graph showing the density of each point of the original and its 
corresponding density on the reproduction. Tone reproduction curves 
are used to correct for press-related effects such as dot gain and to 
control image tonality.

trap (verb) To slightly overlap adjacent printed colors to ensure that white space 
does not appear between them due to misregistration.

unsaturated color A color whose highest value is less than approximately 80 percent.

variable information (VI) job A job in which printed materials such as bills, targeted advertising, and 
direct mailings are individualized for specific recipients or purposes.

variable print specification (VPS)Formal language designed for effective production of variable 
information documents.

vector drawing The geometric system used to define lines and curves in computer 
graphics. It is most often used for line drawings.

vignette See degradé.

virtual printer A printer that contains preset workflows that are automatically 
applied to all print jobs processed with that virtual printer. 

white point The whitest neutral area of an original or reproduction that contains 
detail and is reproduced with the smallest printable dot (typically 
three to five percent).
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